Whether you're a newcomer or longtime user, eBay Hacks will teach you to become efficient as both a buyer and seller. You'll find a wide range of topics, from monitoring the bidding process, getting refunds, and fixing photos so that sale items look their best, to in-depth tips for running a business on eBay and writing scripts that automate some of the most tedious tasks. The book also gives you an inside look into the unique eBay community, where millions of people gather online to buy and sell. Author David Karp—an eBay user from the very beginning—teaches you how to work within this community to maximize your success.
Acknowledgments

Foreword: This Magic Marketplace

Preface

Origins
What This Book Is . . . and Isn't
Hacking a Dynamic System
Practical Matters
How This Book Is Organized
How to Use This Book
Conventions Used in This Book
How to Contact Us
Got a Hack?

Chapter 1. Diplomacy and Feedback
Section 1.1. Hacks #1-8
Hack 1. Searching Feedback
Hack 2. Using Prefabricated Feedback
Hack 3. How to Avoid Negative Feedback
Hack 4. Replies and Followups to Feedback
Hack 5. Withholding Feedback
Hack 6. Remove Unwanted Feedback
Hack 7. Improve Your Trustworthiness Quickly
Hack 8. What to Do When Your Email Doesn't Get Through

Chapter 2. Searching
Section 2.1. Hacks #9-19
Hack 9. Focus Your Searches with eBay's Advanced Search Syntax
Hack 10. Controlling Fuzzy Searches
Hack 11. Jumping In and Out of Categories While Searching
Hack 12. Tweaking Search URLs
Hack 13. Find Similar Items
Hack 14. Search by Seller
Hack 15. Search Internationally
Hack 16. Save Your Searches
Hack 17. Create a Search Robot
Hack 18. Find Items by Shadowing
Hack 19. The eBay Toolbar

Chapter 3. Bidding
Section 3.1. Hacks #20-32
Hack 20. Sniffing Out Dishonest Sellers
Hack 21. Snipe It Manually
Hack 22. Automatic Sniping
Hack 23. Conditional Sniping with Bid Groups
Hack 24. Keep Track of Auctions Outside of eBay
Hack 25. Take Advantage of Bid Increments
Hack 26. Manipulating Buy-It-Now Auctions
Hack 27. Retract Your Bid Without Retracting Your Bid
Hack 28. Tools for Dealing with Fraud
Chapter 4. Selling
  Section 4.1. Hacks #33-54
  Hack 33. What's It Worth?
  Hack 34. To Bundle or Not to Bundle
  Hack 35. Reserve Judgment
  Hack 36. The Strategy of Listing Upgrades
  Hack 37. Putting Keywords in Your Auction
  Hack 38. Track Your Exposure
  Hack 39. Expectation Management
  Hack 40. Formatting the Description with HTML
  Hack 41. Customize Auction Page Backgrounds
  Hack 42. Framing Your Auctions
  Hack 43. Overriding eBay's Fonts and Styles
  Hack 44. Annoy Them with Sound
  Hack 45. Put a Shipping Cost Calculator in Your Auction
  Hack 46. Allow Visitors to Search Through Your Auctions
  Hack 47. List Your Other Auctions in the Description
  Hack 48. Make Good Use of the About Me Page
  Hack 49. Opting Out of Checkout
  Hack 50. Make Changes to Running Auctions
  Hack 51. Dynamic Text in Auction Descriptions
  Hack 52. Let's Make a Deal
  Hack 53. Diplomacy 101: Answering Dumb Questions
  Hack 54. Keeping Out Deadbeat Bidders

Chapter 5. Working with Photos
  Section 5.1. Hacks #55-64
  Hack 55. How to Keep Your Item from Looking Pathetic
  Hack 56. Mastering Close-Up Photography
  Hack 57. Doctoring Photos
  Hack 58. Protect Your Copyright
  Hack 59. Host Your Own Photos
  Hack 60. Make Clickable Thumbnails
  Hack 61. Construct an Interactive Photo Album
  Hack 62. Show a 360-Degree View of Your Item
  Hack 63. Create a Photo Collage
  Hack 64. Create a Good Gallery Photo

Chapter 6. Completing Transactions
  Section 6.1. Hacks #65-71
  Hack 65. Keep Track of Items You've Sold
  Hack 66. Sending Payment Instructions
  Hack 67. Protect Yourself While Accepting Payments
  Hack 68. Cheap, Fast Shipping Without Waiting in Line
  Hack 69. Selling and Shipping Internationally
Chapter 7. Running a Business on eBay

Section 7.1. Hacks #72-81
Hack 72. eBay Stores
Hack 73. Streamlining Listings
Hack 74. Streamlining Communications
Hack 75. Streamlining Checkout and Payment
Hack 76. Obtaining Sales Records
Hack 77. Make Money by Linking to eBay
Hack 78. List Your Auctions on Another Site
Hack 79. Accept PayPal Payments from Your Own Site
Hack 80. Process PayPal Payments Automatically
Hack 81. Keep Tabs on the eBay Community

Chapter 8. The eBay API

Section 8.1. Hacks #82-100
Hack 82. Climbing Out of the Sandbox
Hack 83. API Searches
Hack 84. Retrieve Details About an Auction
Hack 85. Automatically Keep Track of Auctions You've Won
Hack 86. Track Items in Your Watching List
Hack 87. Automatically Keep Track of Auctions You've Sold
Hack 88. Submit an Auction Listing
Hack 89. Automate Auction Revisions
Hack 90. Spellcheck All Your Auctions
Hack 91. Negative Feedback Bidder Alert
Hack 92. Automatically Relist Unsuccessful Auctions
Hack 93. Send Automatic Emails to High Bidders
Hack 94. Generate a Custom Gallery
Hack 95. Leaving Feedback
Hack 96. Negative Feedback Notification
Hack 97. Automatic Reciprocal Feedback
Hack 98. Queue API Calls
Hack 99. Cache Auction Data to Improve API Efficiency
Hack 100. Working Without the eBay API
About the Author

David A. Karp is that dangerous combination of compulsive writer and eBay fanatic.

He discovered eBay in the late 1990s while looking for a deal on an electric cat-litter box. As an avid collector of toys of all kinds, he immediately saw eBay's potential to quench his thirst for second-hand consumer electronics, handmade brass trains, and obscure parts for discontinued products of all kinds. Soon thereafter he began selling on eBay, and now trades religiously, taking breaks occasionally to write books. He still has the litter box.

Educated in Mechanical Engineering at U.C. Berkeley, David consults on Internet technology, user-interface design, and software engineering. Author of six power-user books on Microsoft Windows, including the bestselling Windows Annoyances series, he has also written for a number of magazines, including Windows Sources Magazine, Windows Pro Magazine, and New Media Magazine, and is a contributing editor for ZTrack Magazine. Noted recognition includes PC Computing Magazine, Windows Magazine, the San Francisco Examiner, and the New York Times.

David spends some of his spare time outside with his camera, but often finds it difficult to tear himself away from a good movie. David likes hiking and skiing, almost as much as he enjoys talking about them. He scored 30.96647% on the Geek Test (www.innergeek.us/geek.html), earning a rating of "Total Geek." Animals and children trust him. He can make 15-minute brownies in less than 10 minutes, and never gets tired of the Simpsons.
Contributors

The following people contributed code and inspiration for some of the hacks in this book:

• Todd Larason is a C and Perl programmer currently residing in Portland, OR; he's always interested in new technologies, challenges and obsessions. You can read more about his various obsessions at www.molehill.org.

• Samuel L. Clemens (1835-1910) worked as a typesetter between the ages of 11 and 21, during which time he wrote humorous travel letters for regional newspapers. He assumed the pen name Mark Twain (the term used on steamboats as a warning that a river's depth is only two fathoms deep) in 1861 while writing for the Virginia City Territorial Enterprise, and was first made famous in 1864 by the story "The Celebrated Jumping Frog of Calaveras County," which he wrote as a reporter in San Francisco. He is best known for having written The Innocents Abroad, The Adventures of Tom Sawyer, The Adventures of Huckleberry Finn, and literally thousands of memorable quotes, several of which adorn the pages of this book. Despite having died 93 years before this book was written, Clemens provided immeasurable inspiration to this, and many other, authors.
Best eBay Pop-Culture References

• This is Spinal Tap. The members of the heavy-metal band Spinal Tap (David St. Hubbins, Nigel Tufnel, and Derek Smalls) wax nostalgic on the DVD commentary track of the 1984 Rob Reiner film about the guitars seen in the movie, stating that many of them can now be found on eBay.

• The Simpsons (episode BABF22). Homer loses his life savings in the stock market, except for a few remaining dollars he spends on a cowbell. He rings the cowbell gently, only to have it break apart in his hands, and yells "Damn you, eBay!"
Acknowledgments

I'd like to start by thanking Dale Dougherty and Rael Dornfest for coming up with this terrific series of books, and Tim O'Reilly for talking me into writing this particular volume.

Thanks to Dale Dougherty (again) for his guidance and the steadfast idea of exactly what a "hack" should be. Additional thanks to Ruth Kampmann, Nancy Kotary, and Jim Sumser for their roles in the bizarre series of events that led to the inception of this book.

Thanks to Jeffrey P. McManus and Jeff Huber of eBay for their help with the eBay API, the new "Voyager" search engine, and some other aspects of the marvelous, sometimes mysterious, and always changing computer system behind the curtains at eBay.

I'd also like to thank Todd Larason, who provided code that served as the basis for many of the scripts in Chapter 8.

Thanks to Tim Miller, Katie Woodruff, Michael Eisenberg, Cat Haglund, Dennis Butzlaff, Sara Raymond, and that nice lady who kept bringing us drinks.

Special thanks to Michael Moore, and an extra-special hello to Addie.

Finally, my gratitude and love to Torey Bookstein, whose love and support help warm my soul.
As you will read in this book, eBay is a community, a platform, a social experiment, a successful business, and a microcosm of important Information Age precepts like "network effects," "positive returns to scale," "frictionless economics," even "the changing nature of intellectual property." eBay has a couple of dozen knockout doctoral dissertations lurking in its depths, as well as any number of statutory reforms, sermons, and life-lessons. If you haven't played with eBay yet, you should. If you have played with eBay, this book will enrich your play further.

eBay is becoming the most important way for people to exchange goods. Exchanging goods, exchanging information, and exchanging culture are the three most important activities undertaken by human beings, with the exception of exchanging fluids (without this last exchange, the human race would die off in a generation).

eBay is a uniquely Information Age technology, and as such, it is properly ranked with other technologies that have democratized participation in the fundamental activities of our existence, like the Web itself and Napster.

When the Web was beginning, a lot of Solemn Information Clergy muttered darkly about the inevitable failure of the Internet as a "library" or an "encyclopedia." Libraries are grown-up affairs, filled with serious books written by serious people and carefully cataloged by guardians of human knowledge into hierarchies that express the depth and breadth of all endeavors. The Web has no quality-control mechanism. Any nutbar can pen a few thousand words of lavishly illustrated tinfoil-beanie woo-woo conspiracy theory and post it online, without permission or proofreading. No one seriously attempts to catalog or organize the whole Web into hierarchies anymore—Yahoo! was the last company to make a go at it, and they've quietly deemphasized their effort ever since they realized that keeping pace with the explosive growth of woo-woo tinfoil-beanie conspiracy theories would necessitate hiring every single human being alive and setting them to work cataloging for 14 hours per day.

The best lesson of the Internet is that Napster is better than record labels. Record labels are huge, lumbering, pre-Information Age dinosaurs, thrashing around in the tar as they sink beneath the weight of history while meteors detonate spectacularly overhead. They're incredibly inefficient. They require extraordinary—even unconstitutional!—legal protection to coexist with the Internet. What's more, they've spent a lot of time and money trying to figure out what their customers want from online music distribution, and have utterly missed the fact that hundreds of millions of music-buyers around the world have taken up avid use of file-sharing networks that give them all the music they care to listen to, at a cost that's bundled in with their communications services, day or night, with no "copy-protection" or "rights-management." They've missed the fact that no customer of theirs ever woke up in the morning and said, "Dammit, I wish there was a way I could have less music, and do less with the music I have."

And yet, the Web *is* displacing a lot of the traditional roles played by libraries, despite its typos and madmen. Napster and its progeny *are* becoming the world's preferred means of locating and sharing information, shouting defiance at extraordinarily wicked lawsuits and extraordinarily stupid Acts of Congress. The Priesthood of Information and the Guardians of Music have been displaced by dirty-faced kids whose technology is allowing them to take control of their own information and cultural transactions, and the world is a better place for it.

eBay is a marketplace, and marketplaces are the cradle of civilization. The congress of the market is where all economic theory begins. The Bazaar of the Market is noisome and varied and sticky. Goods

Foreword: This Magic Marketplace
Preface

eBay is more than just a web site. It's a community of millions: people in all parts of the world, all of whom are buying and selling with varying degrees of experience, ingenuity, and, of course, intelligence. eBay refers to the universe it has created as the "eBay Marketplace," which is indeed an apt description.

What makes eBay great is access. As a buyer, you have access to things you can't get anywhere else: antique toys, used computer equipment, rare movie posters, handmade clothing, cheap cell-phone accessories, furniture, music, and everything in between. And as a seller, you have access to buyers all over the world, willing to shell out money for just about anything you can take a picture of.

eBay has become a vital tool for collectors of all sorts. In my first few weeks of exploring eBay, I found a rare toy train that hasn't been made since I was a kid drooling over pictures in a catalog. In fact, thanks to eBay, I rediscovered a hobby I had loved in my childhood, and met others who have done the same.

Origins

eBay is big. Very big. At any given time, there are over 18 million items for sale, with an average of $680 worth of transactions taking place every second. And these numbers will undoubtedly be even higher by the time you get around to reading this.

But like most big things, eBay started out small. As the story goes, eBay was born of a dinner conversation between Pierre Omidyar and his wife, Pam, about PEZ dispensers. As it turns out, this, like many origin stories, is a myth (this one was cooked up by eBay PR whiz Mary Lou Song); but the fact remains that eBay still has that PEZ-dispenser feel, and that's what keeps customers coming.
What This Book Is . . . and Isn't

"Hacks" are generally considered to be "quick-and-dirty" solutions to programming problems or interesting techniques for getting a task done. As any experienced eBay will tell you, there are plenty of tasks involved in buying and selling on eBay, and anything that can be done to make those tasks easier, faster, or more effective will improve your eBay experience significantly.

This book is not a "hand holding" guide. It will not walk you through the process of bidding on your first auction or creating your first auction listing. The fact is that just about anybody can figure those things out for themselves in a few minutes. (If that weren't true, eBay wouldn't have tens of millions of active buyers and sellers.)

But despite the title, this book is also not about "hacking into a system" or anything so nefarious. Quite the contrary: in fact, you'll find in this book a very real emphasis on trading responsibly and ethically, as well as extensive tools and tips for protecting yourself as both a buyer and a seller.

The hacks in this book address the technological and diplomatic challenges faced by all eBay members, written from the perspective of an experienced eBay who loves challenges as much as solutions.

Essentially, you'll find in this book the tools to help you trade smarter and safer, make more money, and have fun doing it.
Hacking a Dynamic System

"Change is the handmaiden Nature requires to do her miracles with."

—Mark Twain

eBay is constantly evolving and changing to meet the needs of its ever-growing community (as well as its business partners). Every two weeks, in fact, eBay introduces new features and changes to its site. Some changes are subtle, like moving the location of a button or link, or updating an obscure policy. Other changes are much more dramatic.

While this book was being written, for instance, eBay added the Calculated Shipping feature (see Hack #45), substantially changed the licensing and pricing for its Developers Program (see Chapter 8), and introduced an entirely new auction page design. And all of these changes occurred within a period of about 30 days.

There is no such thing as eBay 2.0 or eBay 2.1, a fact that can create quite a challenge for tinkerers. But, by their very nature, hacks are experimental, and not necessarily impervious to breakage or obsolescence. As eBay evolves, some of the hacks in this book may need to be adjusted, fixed, or otherwise massaged to work within the confines of the system. If you encounter a problem, just visit www.ebayhacks.com to see if there's a solution (or to suggest one of your own).

Fortunately, whenever eBay closes a door, they try to open a window (or at least a vent), which means that hacking will always be a part of using eBay, and the hacker will always have a home.
Practical Matters

eBay requires only a web browser, an email account, and a sense of adventure. But to use the hacks in this book, you'll want to make sure you have all of the following:

- Recent web browser. Your web browser is your portal to the entire eBay universe, so make sure you're not using a browser released before the fall of the Berlin wall. The hacks in this book were designed for and tested on Netscape 7.0 or later, Mozilla 1.4 or later, and Internet Explorer 6.0 or later. These are all free downloads from their respective makers (www.netscape.com, www.mozilla.org, and www.microsoft.com), so no excuses! Earlier web browsers will cause all sorts of problems, such as pages not displaying correctly and forms not working properly. And newer browsers can also prefill forms and remember passwords, which can be very handy on eBay.

- Email account. A reliable email account — and an email address that is not likely to change in the short term — are vital requirements for using eBay.

- Email application. Email is how buyers and sellers communicate with one another, but many eBay members underestimate the need for a reliable program to read and send email. A good email program will do the following:
  - Store all sent and received messages indefinitely.
  - Allow you to search and sort stored messages.
  - Include the original message when you send a reply.
  - Automatically separate eBay-related email from all other correspondence using filters.

- Web-based services such as Hotmail or Yahoo! are not suitable, because they don't store email permanently, and they don't give you sufficient control over spam filters and other features. Instead, try Eudora (www.eudora.com) or Outlook (www.microsoft.com).

- Control over your spam filter. If your ISP filters out your spam, it may be deleting email messages intended for you, such as questions from customers and payment instructions from sellers. See [Hack #8] for solutions, including an example of a suitable spam filter.

- The ability to tilt your head to the left. If you are able to correctly interpret smileys :) and other "emoticons," you can properly discern when someone is kidding. This can mean the difference between being happy with a transaction and filing a dispute with eBay's fraud department.
How This Book Is Organized

This book goes beyond the instruction page to the idea of "hacks"—tips, tricks, and techniques you can use to make your experience with eBay more profitable, more fun, less exasperating, and (if you enjoy such things) more challenging.

On a daily basis, eBay users assume many different roles: consumer, seller, technical support specialist, diplomat, teacher, nuisance, application developer, nuclear safety inspector, web designer, and, of course, hacker. With that in mind, the hacks (and chapters) in this book are divided into four main sections.

Hacks for All

Chapter 1, Diplomacy and Feedback

Feedback in the eBay world is like credit in the real world: you use it to buy and sell things, you build it up over a long time, and you protect it like a first-born child. This chapter introduces eBay's feedback system and describes the many different ways to maintain a good feedback profile and use it to inspire trust in others.

Hacks for Buyers

Chapter 2, Searching

The only way to find anything on eBay is by searching, either by typing keywords into search boxes or by browsing through category listings. The hacks in this chapter describe how to find auctions before anyone else does, focus your searches with a variety of tools, and even create an automated search robot.

Chapter 3, Bidding

This chapter explains both how bidding is supposed to work, and how it actually works in the real world. It also discusses how you can use eBay's proxy bidding system to improve your win rate while spending less money.

Hacks for Sellers

Chapter 4, Selling

The beauty of eBay is that anything you buy can be sold, sometimes for more than you paid for it. This chapter shows the strategies involved with selling, such as which listing upgrades work best, how to promote your items without spending extra money, how to format your listings with HTML and JavaScript, and how to protect yourself from deadbeat bidders.

Chapter 5, Working with Photos

Photos can make or break an auction. This chapter shows you not only how to take good pictures and put them in your auctions, but also includes specific code you can use for cool presentations.

Chapter 6, Completing Transactions

The hacks in this chapter will give you the selling tools to help receive payments, ship your packages, and protect yourself while doing it.

Chapter 7, Running a Business on eBay

Hacks for Developers

Chapter 8, The eBay API

To the delight of anyone interested in hacking, eBay's API lets developers write applications to communicate directly with the eBay servers. But it's not just for developers—anyone with a computer or web server and a little time to learn Perl can write (and use) quick-and-dirty scripts to search, retrieve auction information, leave feedback, and much more.
How to Use This Book

You can read this book from cover to cover if you like, but for the most part each hack stands on its own. So feel free to browse, flipping around to whatever sections interest you most.

If you're a Perl "newbie," you might want to try some of the easier hacks (earlier in the book) and then tackle the more extensive ones as you get more confident. If you want more information on Perl, such as the background and documentation not found in this book, see perl.oreilly.com. Likewise, go to scripting.oreilly.com for more information on JavaScript, and check out web.oreilly.com for help with HTML.
Conventions Used in This Book

The following is a list of the typographical conventions used in this book:

Italic

Used to indicate new terms, URLs, filenames, file extensions, directories, program names, and, of course, for emphasis. For example, a path in the filesystem will appear as /Developer/Applications.

Constant width

Used to show code examples, anything that might be typed from the keyboard, the contents of files, and the output from commands.

*Constant width italic*

Used in examples and tables to show text that should be replaced with your own user-supplied values.

You should pay special attention to notes set apart from the text with the following icons:

- **Tip, suggestion, or general note.** It contains useful supplementary information about the topic at hand.

- **Warning or note of caution.** When you see one of these, your safety, privacy, or money might be in jeopardy.

The thermometer icons, found next to each hack, indicate the relative complexity of the hack:
How to Contact Us

We have tested and verified the information in this book to the best of our ability, but you may find that features have changed (or even that we have made mistakes!). As a reader of this book, you can help us to improve future editions by sending us your feedback. Please let us know about any errors, inaccuracies, bugs, misleading or confusing statements, and typos that you find anywhere in this book.

Please also let us know what we can do to make this book more useful to you. We take your comments seriously and will try to incorporate reasonable suggestions into future editions. You can write to us at: O'Reilly & Associates, Inc. 1005 Gravenstein Hwy N, Sebastopol, CA 95472 (800) 998-9938 (in the U.S. or Canada)(707) 829-0515 (international/local)(707) 829-0104 (fax)

To ask technical questions or to comment on the book, send email to:
bookquestions@oreilly.com

For more information about this book and others, see the O'Reilly web site:
http://www.oreilly.com

For details about eBay Hacks, including examples, errata, reviews, and plans for future editions, go to:
http://www.oreilly.com/catalog/ebayhks/

Code examples, additions and corrections, and other related miscellany can be found at:
http://www.ebayhacks.com/

Got a Hack?

To explore Hacks books online or to contribute a hack for future titles, visit:
http://hacks.oreilly.com
Chapter 1. Diplomacy and Feedback

- Section 1.1. Hacks #1-8
- Hack 1. Searching Feedback
- Hack 2. Using Prefabricated Feedback
- Hack 3. How to Avoid Negative Feedback
- Hack 4. Replies and Followups to Feedback
- Hack 5. Withholding Feedback
- Hack 6. Remove Unwanted Feedback
- Hack 7. Improve Your Trustworthiness Quickly
- Hack 8. What to Do When Your Email Doesn't Get Through
1.1 Hacks #1-8

eBay is a community of buyers and sellers, not just a mere web site or piece of software. It's a complex social system of which you are an active member. Success on eBay depends not only on your ability to master the technical tasks of bidding and selling, but on your ability to communicate with other eBay members and your willingness to contribute to the community in a positive way.

Feedback is the basis of trust on eBay. Each eBay member has his or her own feedback profile, a public collection of comments left by other eBay members. Each individual feedback comment is tied to a transaction in which the particular member took part. Feedback comments are marked either positive, negative, or neutral, and are added accordingly in the summary that appears at the top of the page.

A member's feedback rating is the number representing the sum of all positive comments, minus the sum of all negative comments. (Note, however, that multiple comments left by a single user will never count more than one point.) This number, shown in parentheses after a member's user ID, is a useful tool in determining the trustworthiness and experience level of any given eBay member.

It's important to note that the feedback rating alone does not give you a sufficient picture of any member's personal history. Before you do business with any other member, make sure to click on the feedback rating to view the member's feedback profile as a whole.

Feedback is taken very seriously on eBay, and with good reason. For example, a seller who deals honestly and fairly with his or her customers will earn lots of positive feedback over the years. Conversely, dishonest or unreliable sellers and deadbeat bidders are likely to earn a higher percentage of negative feedback.

1.1.1 Leaving Feedback

You can leave feedback for another member only if you are both involved in a transaction, namely a completed auction. The actual task of leaving feedback is quite simple; simply go to the completed auction page and click Leave Feedback. Choose a rating (positive, neutral, or negative) and type a "review" in the space provided. You'll then have 80 characters in which to explain what the other eBay member did right (or wrong).

Here are some guidelines for writing appropriate feedback:

- Positive. As long as a transaction goes reasonably well, you should always leave positive feedback for the other party.
Hack 1 Searching Feedback

Use your browser's Find tool to quickly find complaints or other specific feedback comments in a member's feedback profile.

Feedback is shown in chronological order, with the most recent feedback comments at the top. When scrutinizing a member's feedback profile, it's sometimes helpful to locate specific complaints that other members have left. Unfortunately, feedback profiles can get extremely long, and eBay provides no way of sorting or searching through a member's comments. The simple workaround is to use your browser's built-in search feature.

Start by scrolling down to the bottom of the user's feedback profile page. At the end of the list, you'll see page numbers, allowing you to see older comments. Further down, where it asks "How many feedback comments do you want on each page?" you can specify a larger number, thereby reducing the total number of pages. Choose 200, the maximum, and click View Feedback to show the new, longer page.

Next, press Ctrl-F (or go to Edit → Find in this page) to activate your browser's search tool. To find negative feedback comments, type the word "complaint" in the search field and then click Find.

If the current page has a negative comment, your browser will locate it almost immediately. Click Find repeatedly to cycle through all the negative comments on the page.

In most browsers, you can leave the Find window open while you flip between pages in the feedback profile. Unfortunately, there's no way to show more than 200 feedback comments on a single page, which would obviously make the search even easier.

You can also search for neutral comments by looking for the word "neutral," and positive comments by looking for the word "praise."

You may also wish to search a person's feedback profile for your own user ID to see if you've left feedback for that person. Likewise, you can use the same technique to search your own feedback profile for another member's user ID to see if that member has left feedback for you.

See Chapter 8 for details on the eBay API, and ways to retrieve and search through feedback with only a few lines of code.
Hack 2 Using Prefabricated Feedback

Save time by storing prewritten feedback for future use.

It won’t take you long to get tired of writing feedback comments for the various buyers and sellers with whom you trade. You always end up saying the same thing, so why bother typing it every time?

The solution is simple. Write two generic, all-purpose positive feedback comments, one for buyers and one for sellers, and place them in a plain-text file saved on your hard disk. Remember that each comment can be no longer than 80 characters, including any spaces and punctuation.

Then, when it comes time to leave feedback for someone, open the text file, highlight the appropriate comment, and press Ctrl-C to copy. Then, click the Feedback Review field, and press Ctrl-V to paste.

Naturally, you can store as many prefabricated feedback comments as you like (variety is the spice of life, after all). Just be careful not to place negative comments too close to positive ones, lest you select the wrong line in haste.

1.3.1 Feedback for Multiple Auctions

Go to My eBay → Feedback → Leave Feedback, and you’ll see a list of all closed auctions for which you have not yet left feedback, as shown in Figure 1-2. Simply go down the list, pasting your prefabricated comments for any deserving transactions.

Figure 1-2. Leave feedback for dozens of auctions at a time without typing a single word

1.3.2 Right-Click-O-Rama

Users of Windows XP, Me, and 2000 can use their context menus for even quicker access to prefabricated feedback. Start by installing Creative Element Power Tools (www.creativelement.com/powertools) and enabling the “Copy file contents to the Clipboard” option.

Next, create at least two plain-text files (one for buyers and one for sellers), each with only a single feedback comment on the first line, and save them to your hard disk. Give each file a name that describes its contents, such as Standard Seller Feedback.txt or Positive Buyer Feedback.txt.

When you’re ready to leave feedback, just right-click one of the files and select Copy File Contents. Then, click the Feedback Review field and press Ctrl-V to paste in the feedback text.

1.3.3 Feedback for International Users

Saving feedback is also handy when you want to have several different prefabricated comments at your fingertips.

For instance, when leaving feedback for an eBay member in another country, you’ll probably want to write in the user’s native language. And every time you go to the trouble of constructing a comment in a foreign language, you might as well save it for future use. Eventually, you’ll have a folder filled with filenames like Positive feedback for Swedish buyers.txt or French feedback comments.txt.

If you’re not familiar with the member’s native language, use a free online translator to help you out, as described in [Hack #30].

1.3.4 See Also

• Some of the auction management tools discussed in Chapter 7 also have features to leave feedback automatically for buyers who have paid.
• See [Hack #95] for details on using the eBay API to leave feedback for other members.
Hack 3 How to Avoid Negative Feedback

Protect your feedback profile — and your reputation — from the proverbial slings and arrows of disgruntled eBayers.

In most cases, negative feedback is unnecessary. And I'm sure that if you just received negative feedback, you'll agree in a heartbeat.

But the reason that negative feedback is unnecessary is that it's usually avoidable. Complaints are usually lodged for one of the following reasons:

- A buyer's expectations weren't met. A buyer will leave negative feedback for a seller if the item doesn't arrive quickly, if the item isn't in as good condition as promised, or if the seller isn't responsive to emails.

- All of these are avoidable: see [Hack #39] and [Hack #70] for tips to effectively prevent customers from being disappointed, both before and after the sale.

- But it's important to note that sometimes there's only so much a seller can do to please a customer. For this reason, sellers must also do everything possible to convince their customers — especially inexperienced ones — to communicate any problems or concerns to the seller before they go ahead and leave feedback.

- If you're the seller, probably the easiest way to do this is to include a note inside all your packages with your email address (and phone number, if applicable) and the assurance that, if the customer has a problem, you'll do everything you can to make the situation right. Sometimes the note alone is enough to make the customer happy.

- Deadbeat bidder. A seller will leave negative feedback for a bidder who doesn't pay. If you're a bidder, you can avoid this by quite simply not bidding when you don't intend to follow through and purchase the item. Sellers can usually prevent deadbeat bidders from bidding on their auctions — or rather, prevent bidders from becoming deadbeats — by following the tips in [Hack #54].

- Communication breakdown. One of the most common causes of failed transactions — and the resulting negative feedback — is one party's inability to email the other. See [Hack #8] for a variety of solutions.

- Retaliation. A single negative feedback comment will often result in a reciprocal retaliatory feedback. Unfortunately, this is human nature, and there's not much you can do about it. What's worse, though, is that many eBay members don't leave negative feedback where appropriate out
Hack 4 Replies and Followups to Feedback

A little damage control will help save a bruised reputation.

The game isn't over when another eBay member leaves feedback for you; you have the opportunity to respond to any feedback comment in your profile. Although this feature is handy for thanking users for leaving you positive feedback, its real value is for damage control when someone leaves neutral or negative feedback for you.

Most people's instinct is to use this tool as a means of retaliation—to "get back" at the other user for leaving a nasty comment. But given the importance of feedback in the eBay community, your main goal should be to use it to lessen the impact of such comments on your own reputation.

For example, consider the following complaint lodged against you, a seller, by an unhappy bidder: "Item arrived damaged; very expensive to repair. Lousy seller."

Obviously, this is the wrong response: "Stupid buyer! What a jerk for complaining! Now you get nothing."

Think of the message this sends to other people, prospective future customers, who might scrutinize your feedback profile. It doesn't address the problem, and since your response shows up only in your own feedback profile, it only serves to hurt you. Instead, consider this reply: "Please contact me with all problems, and I'll do my best to make it right."

This sends a subtle message to the buyer, should he ever choose to return and view your feedback, but more importantly, it makes it appear to other bidders that you are the reasonable one, and this particular customer is nothing more than a crackpot. It also reassures potential customers that you will address problems, and won't just leave your bidders twisting in the wind.

If you feel the bidder will be understanding and cooperative once you follow up with an email, you may wish to request to have the feedback removed, as described in [Hack #6]. Naturally, no bad feedback is the most desirable outcome.

The same approach applies if you're a bidder, and a seller leaves the following feedback for you: "Deadbeat! Buyer bid high and never paid. Avoid this guy!"

The common response among inexperienced bidders is often to do nothing, either for fear that something bad will happen to them, or simply because of a lack of familiarity with the system. A response that explains why the aforementioned non-payment might have been reasonable is usually the best choice: "Seller never responded to emails, so I gave up and purchased another one."
Hack 5 Withholding Feedback

Know when to hold 'em, and know when to leave 'em.

"The trouble with the global village is all the global village idiots."
—Paul Ginsparg

The biggest flaw (and in some ways, the biggest strength) of eBay's feedback system is the risk of retaliation. You leave negative or neutral feedback for someone, and they will — without considering the circumstances or who's at fault — do the same for you. That is the fear, and that is the reason why many people simply let problems slide.

But the risk of retaliation also reminds people that they are responsible for their own words; if there were no consequences, people would leave negative feedback with abandon, and we'd have even more problems on our hands.

I won't deny that the risks sometimes outweigh the gains. Sometimes a bidder has a seemingly legitimate reason for not paying. Perhaps a seller is inexperienced, and while a particular transaction might not have gone very smoothly, it wasn't due to any malice by the seller. Do these people necessarily deserve blemishes on their records? Perhaps not, but they don't necessarily deserve praise, either. In other words, sometimes the best move is no move at all.

1.6.1 Who Goes First

Often the fear of retaliation can work to your advantage. Say you're a seller, and someone has just purchased an item from you. The bidder pays in full, and you go ahead and reward the bidder with positive feedback. But when the bidder receives the item, he's not happy. Since you've already played your hand, the bidder then feels free to file negative feedback, or simply threatens to do so.

On the other hand, if you withhold feedback, the bidder will be much more likely to pursue a diplomatic solution to any problems that come up. Instead of leaving negative feedback, the bidder might politely request a refund, or, better yet, might even go away and not bother you at all.

For this reason, a wise seller will usually wait until the customer has left positive feedback, or at least wait for confirmation that the item has been received and the buyer is happy.

But does the bidder have anything to worry about? If an otherwise happy bidder leaves positive feedback for the seller, isn't there still risk of negative feedback from the seller?
Hack 6 Remove Unwanted Feedback

Use SquareTrade's mediation services to retract feedback.

eBay doesn't kid around when it comes to feedback, and neither do most users. Although eBay is quite clear about stating that every member who leaves feedback is responsible for his or her own words and that, once posted, feedback cannot be retracted, there is indeed a way out.

In fact, there are several circumstances under which a feedback comment can be removed:

- The feedback does not appear to be connected with eBay, the particular member for which it was left, or the particular transaction with which it is associated.
- The feedback contains offensive language, personal identifying information, links to pictures or web sites, or false claims with regard to eBay policies or law-enforcement organizations.
- The feedback was mistakenly left for the wrong user, and the person who left feedback corrects the error and then contacts eBay.
- The feedback was left by someone with false contact information.
- The feedback was used as a means of coercion or blackmail.
- eBay receives a court order finding that the feedback is slanderous, libelous, defamatory, or otherwise illegal, or as a result of a settlement agreement.
- eBay is notified by SquareTrade to remove the feedback, as explained in the next section. If the feedback comment doesn't meet any of the other criteria listed here, then going through SquareTrade is your best choice.

Go to http://pages.ebay.com/help/policies/feedback-removal.html for all the legalese associated with eBay's feedback removal policy.

1.7.1 SquareTrade

Any eBay member who wishes to have a feedback comment removed must do so with the cooperation of the person who originally left the feedback.

Here's how it works:

1. The recipient of the unwanted feedback files a case at www.squaretrade.com and pays the service fee. There is no time limit.
2. Emails are sent to both parties.
3. Each party independently agrees to have the feedback removed.
4. A mediator at SquareTrade investigates the case.
5. If all conditions are met, SquareTrade sends a removal request to eBay.

The only time things proceed differently is if the other party doesn't respond to any of the SquareTrade emails within 14 days. In this case, a SquareTrade mediator reviews the case, and hopefully dismisses the feedback. The restriction here, however, is that the case must be filed within 90 days of the date of the feedback; this prevents eBay members from attempting to remove old feedback from posters who have long since left eBay and changed email addresses.

What's so terrific about this concept is that it gives buyers and sellers incentive to work things out, even after feedback has been left.
Hack 7 Improve Your Trustworthiness Quickly

Don't let an apparent lack of experience hurt your success on eBay.

"Bad credit? No credit? No problem!"
—Ernie's Used Cars

A low feedback rating can hurt a buyer or seller nearly as much as a feedback profile with an excessive amount of negative comments. Luckily, there are a few things new users can do to gain trust within the eBay community.

1.8.1 Newbie Buyers

Many sellers, primarily those who have had a bad experience with a non-paying bidder, are understandably apprehensive about bidders with low or zero feedback. So, if you see an auction in which the seller has written a warning about such bidders, drop him a quick note by clicking "Ask seller a question," just to let him know you're serious.

If you're a seller, see [Hack #54] for effective ways of dealing with newbie buyers as well as bidders who don't pay.

1.8.2 Newbie Sellers

It's harder to be a new seller on eBay than a new buyer; a seller with low or zero feedback will have a hard time selling anything. Trust, after all, takes on a bigger role when someone else's money is at stake.

The best thing to do (and, coincidentally, the most fun) is to buy a few things before you start selling. Not only is this an easy way to build up feedback, but it will give you some experience in what it's like to be a buyer, which will ultimately make you a better seller.

Note that eBay will also lift some restrictions when you've beefed up your feedback. For instance, once you reach a feedback rating of 10, you'll be able to use the Buy-It-Now feature in your auctions. For those who can't wait, eBay provides the ID Verify service, described in the next section.
Hack 8 What to Do When Your Email Doesn't Get Through

Use other means to contact buyers and sellers, and avoid the most common cause of negative feedback.

Email is the life's blood of the eBay community. Sellers use it to send payment instructions to buyers, buyers use it to send questions to sellers, and eBay uses it for just about everything.

Unfortunately, there are times when your email never makes it to the other party, either bouncing back or disappearing into the ether. There are two common reasons why your email may never make it to its intended recipient:

- The other member's registered email address is out of date. In this case, any emails sent to that address should be bounced back to you. (Note that any user can update their registered email address by going to My eBay → Preferences → Change my Email Address.)

- The other member has an overly aggressive spam filter, which might simply delete all email from unknown addresses (including yours). This means you'll never know if your email made it to the recipient.

Any spam filter that deletes email without your approval is ultimately going to lead to a lot of trouble, and possibly some expense and negative feedback. Instead, use a spam filter like SpamPal (www.spampal.org) that simply marks suspicious email as spam, so that your email software (discussed in the Preface) can filter it accordingly. Refer to the documentation that comes with your spam filter and email program for details. Also, contact your ISP and make sure they aren't deleting any of your email.

Fortunately, there are a bunch of different tools you can use to send a message to another eBay member, useful for when standard email fails:

- Contact an eBay Member form. Click any eBay member's user ID to send an email via eBay's mail server. This is useful if you suspect that another member's spam filter is deleting your mail, since it's likely to approve all email originating from eBay.com. However, since it relies on the member's registered email address, it won't help if that address is wrong.

- Use a different ISP. If you have an email account with another ISP, try sending your email from there. This will also help get around spam filters. If you don't have another account, you can try getting a free backup address at Yahoo.com or Hotmail.com.

- Look in the auction description. If you're a bidder trying to contact a seller, look in the auction description and payment instructions block to see if the seller has specified an alternate email address. Even if you're not bidding on one of their auctions, the seller may have one or more auctions currently running or recently completed that might contain this information.

- About Me. If the member's user ID is accompanied by a "me" icon, click the icon to view her About Me page, which might also have alternate contact information. See [Hack #48] for details.

- Use your photos. If you're having trouble contacting one of your bidders and you're hosting the auction pictures on your own server, as described in [Hack #59], you can use your photos as another means of communication. Simply add large, extremely clear text to one of your photos instructing the bidder to email you immediately. For best results, increase the canvas size and place red text in the whitespace above the image, which will be more obvious than text placed in the photo.

- Dynamic text. Also for sellers: see [Hack #51] for ways to put text in your auctions that can be changed at any time, even after the auction ends. This can be very useful in sending messages to bidders who otherwise cannot be contacted via email.

- Send a token payment. If the other user has a PayPal account, try sending a token payment of, say, a single penny, and include your message in the Optional Instructions field. Even if the user doesn't receive payment notification email, the payment will appear the next time she logs into PayPal.

- Contact Info. Provided that you and the other member are both involved in a transaction, go to Search → Find Members → Contact Info, and enter the member's user ID and item number in the spaces provided. eBay will then email both parties with each other's street address and phone number, which you can use as a last resort.

In nearly all cases, one of these methods will get your message across. Make sure that you inform the other person that you have had trouble sending email, and don't be afraid to request that they take steps to rectify the problem. Strangely enough, people are often indifferent to the situation, but suggesting that yours is probably not the only email that isn't getting through is usually enough to convince the recipient to snap into action.

If you're a seller, and your high bidder isn't replying to your emails, you may have a deadbeat bidder on your hands. See [Hack #54] and [Hack #71] for ways to deal with this problem.
Chapter 2. Searching

- **Section 2.1. Hacks #9-19**
- Hack 9. Focus Your Searches with eBay's Advanced Search Syntax
- Hack 10. Controlling Fuzzy Searches
- Hack 11. Jumping In and Out of Categories While Searching
- Hack 12. Tweaking Search URLs
- Hack 13. Find Similar Items
- Hack 14. Search by Seller
- Hack 15. Search Internationally
- Hack 16. Save Your Searches
- Hack 17. Create a Search Robot
- Hack 18. Find Items by Shadowing
- Hack 19. The eBay Toolbar
2.1 Hacks #9-19

Without the ability to search, eBay would be close to worthless. Think about it: at any given time, there are close to 20 million items for sale on eBay, and that number keeps growing. If you were only able to flip through them like pages in a magazine (a magazine a quarter of a mile thick, mind you), you'd never find anything.

Searching on eBay is an art, often requiring you to think a little creatively. Sometimes you have to get into the minds of other users to predict how they might describe the item you're looking for; other times you just have to be devious.

Now, basic searching on eBay is a piece of cake. Just type a word into eBay's search box and press Enter, or type more than one word to narrow your search. By default, all searches simply cover auction titles, but you can include auction descriptions as well by clicking the "Search titles and descriptions" checkbox.

The hacks in this chapter take it several steps further, covering the advanced search syntax, showing you how to carefully control the scope of your searches, and including several ways to find things that would otherwise elude you. After all, the best deals (and the best finds) are usually the items that most people don't see.
Hack 9 Focus Your Searches with eBay's Advanced Search Syntax

Simplify your searches by making them a little more complicated.

Why should exhaustive searches be so . . . exhausting? Whether you're performing a quick one-time search or repeating the same search every other day, you can dramatically improve the efficiency of your searches and the relevance of your search results with some simple modifications to your queries.

You could fine-tune your searches by going to Search➡️Advanced Search, but this can be cumbersome and is mostly unnecessary due to the advanced search syntax.

2.2.1 Excluding Unwanted Results

Simply precede a search term with a minus sign (−) to eliminate any search results containing that term. For example, the query:

```
sunglasses −men's
```

will show all auctions containing "sunglasses" but not "men's", which should, at least in theory, show you a list of women's sunglasses. (Note that there's no space between the minus sign and the term "men's".) This approach is typically more effective than something like "women's sunglasses" because it will also include any auctions for gender-neutral sunglasses.

Naturally, you can exclude multiple terms, like this:

```
sunglasses −men's −children's −ugly
```

The scope of the excluded terms is the same as the scope of the search; that is, if you're searching only titles, the exclusions will apply only to titles. For example, the above example may bring up some auctions with "ugly" in the description, even though it doesn't appear in the title. Only if you're searching both titles and descriptions will eBay look in both places for excluded terms.

Exclusions open up a little paradox in eBay's search tool. In most cases, expanding a title-only search to include titles and descriptions will increase the number of search results. But when you exclude a word, a title-and-description search may return fewer results than the same search performed only on titles. Although this is caused by nothing more than the increased likelihood of finding one of the excluded terms when you search descriptions, I'm still sometimes surprised by it.
Hack 10 Controlling Fuzzy Searches

Choose when and how plurals and variations of your search terms are used in searches.

For the most part, eBay searches return only listings that match your search terms exactly. That is, if you search for "possum," you won't necessarily retrieve the same results that you would in a search for "opossum."

Historically, to perform a fuzzy search, you'd have to include all the variations of a word in the search box manually, like this:

(oopossum, possum, apossum)

or, to accommodate singular and plural variants, you'd have to type something like this:

(antenna, antennas, antenae)

The OR search commanded by the use of parentheses, as described in [Hack #9], takes care of this nicely. But it's not always necessary.

As part of eBay's new search engine (code-named "Voyager" and introduced in 2003), all eBay searches automatically include common plurals and known alternate misspellings of words. For instance, a search for "tire" will also yield results matching "tyre" as well as "tires" and "tyres," rendering the messy OR search unnecessary in this case.

Of course, the inclusion of these variations isn't always desirable. For instance, if you're looking for rooftop antennas for a Pennsylvania Railroad PA-1 locomotive, you wouldn't so much be interested in a book discussing the antennae of Pennsylvania cockroaches. To force eBay to search only for exact matches of words, enclose such terms in quotation marks, like this:

pennsylvania "antennas"

which is practically equivalent to:

pennsylvania antennas -antenae

Whether or not the quotes will be necessary, or whether you'll still need to manually include variations (using parentheses), will depend on the particular search you're trying to perform. eBay's fuzzy searches are based on a hand-selected dictionary of common variations and plurals, meaning that "tire" will match "tyre," but it's unlikely that eBay will go as far as to equate "potato" with "tater."

2.3.1 Punctuation

To simplify searches that would otherwise require very cumbersome search phrases, nearly all forms of punctuation are considered equivalent to spaces in eBay searches. For instance, say you're looking for a 1:43-scale model car; you might expect to have to type the following:

(car (1/43, 1\43, 1:43))

Instead, all you would need to type is:

car 1/43

wherein the 1/43 keyword will match "1 43", 1:43, 1;43, 1\43, 1-43, 1.43, 1!43, 1@43, 1#43, 1$43, 1%43, 1^43, 1&43, 1_43, 1=43, 1+43, and 1~43.

While gt-40 is equivalent to "gt 40", it won't match gt40 (without any space or punctuation), so the OR search is still needed.

Unfortunately, punctuation doesn't fall under the same rules as variations and plurals, meaning that the quotation marks discussed above won't have any effect on unwanted variations. Furthermore, the equivalence of punctuation also means that the following will not work as expected:

"gt 40" -gt/40

See [Hack #9] for more information on search exclusions.
Hack 11 Jumping In and Out of Categories While Searching

Narrow your searches by confining them to certain categories, and filter categories while you browse.

eBay uses an extensive hierarchy of categories to group similar items together. This not only enables sellers to improve the exposure of their auctions, but it helps bidders find what they're looking for and even discover new items.

When you perform a standard search, no thought is given to the categories in which the items are sorted; toaster ovens are listed right alongside antique car parts. By the same token, when you browse a category, you're simply looking at a list of every item placed in that category by sellers, whether it's relevant or not.

Category listings and search results are essentially the same thing: subsets of the massive auction database that is eBay. This means that when you search or when you browse a category, you're really just changing your filtering criteria. Fortunately, you can combine the two quite easily. Think of it as either narrowing a search by confining it to a single category, or filtering a category listing with search terms.

See [Hack #12] for a more in-depth look at categories and how they relate to searches and auctions.

2.4.1 Search Within a Category

Click Browse at the top of any eBay page to view the top-level categories. Choose a category here, and then a subcategory from the assortment displayed on the next page. At three levels deep and beyond you'll see standard category views, including auction listings and a Basic Search field, as shown in Figure 2-1. (Note that you can also jump to a category listing from any auction by clicking the category link at the top of the page.)
Hack 12 Tweaking Search URLs

Tap into eBay's massive database right from your own address bar.

eBay is essentially a massive database. Every time you view an auction page, you're just looking at a single database record. Every time you search, you're performing a query. But even if you're not familiar with DB lingo, you can play with eBay's URLs to tweak what you see.

2.5.1 Auction Pages

Many pages on eBay use a standard CGI (Common Gateway Interface) format, which is nothing more than a program name followed by a command and one or more parameters:

http://cgi.ebay.com/ws/eBayISAPI.dll?ViewItem&item=3128013703

Here, cgi.ebay.com is the name of the server, eBayISAPI.dll is the filename of the program, ViewItem is the command to execute, and item=3128013703 is a parameter. Any additional parameters are separated by ampersands (&).

In this case, 3128013703 is the auction number. Simply replace this with another valid auction number, press Enter, and you'll see the corresponding auction page. This is typically quicker and more convenient than using the Search page to open an auction by its number.

Some sellers reference other auctions by simply including the auction number in their descriptions, usually because they don't know how to make links (see Hack #40). To view the auction by its number, simply copy and paste the number into the URL, replacing the one that's there.

2.5.2 Search Pages

A typical search page URL looks something like this:

http://search.ebay.com/ws/search/SaleSearch?satitle=avocado+green

Here, I searched for "avocado green", which you can see in the parameter satitle=avocado+green. Most searches will probably have more parameters, some more self-descriptive than others.
Hack 13 Find Similar Items

A simple JavaScript tool to quickly list auctions similar to the one you're looking at.

I'm always excited to discover something new while searching on eBay, but I've been around long enough to know that there's virtually no such thing as "one of a kind."

When you've found an item you're interested in, it's often helpful to look for other auctions for similar items, either to compare prices or perhaps to find something better. Typically, this requires opening a search box and typing the name of the item for which to search. Here's a quick hack that will eliminate these steps and list similar items with a single click.

Create a new button on your browser's Links bar (see Customizing the Links Bar for details) and type the following JavaScript code, all on one line, into the new link:

```javascript
document.title.substring(document.title.indexOf(' - ')+3)))
```

Make sure to note the capitalization of the JavaScript code, such as the uppercase "O" in the `indexOf` keyword. Note also the spaces around the hyphen (' - '). You can name the new link anything you like, such as "Find Similar."

Then, open any auction page and click the new link, as shown in Figure 2-2. (Naturally, the hack won't work on a non-auction page.) A new window will appear with search results matching the title of the auction you were just looking at, which, in theory, should contain at least one auction. At this point, you can modify and repeat the search as needed.

![Figure 2-2. View a list of similar auctions by clicking this custom button on your Links bar](image)

Customizing the Links Bar

Modern web browsers such as Netscape, Internet Explorer, and Mozilla all have a customizable toolbar called the Links bar. The Links bar, shown in Figure 2-2, is nothing more than a small collection of easily accessible bookmarks (a.k.a. favorites, shortcuts, links) that you can click to open the corresponding pages.

The easiest way to add a custom button to the Links bar is to simply drag-and-drop the URL shortcut icon (to the immediate left of the URL) onto the bar to add the current page. Or drag any link from any open web page, bookmark, favorite, or Internet shortcut onto the Links bar.

Some of the hacks in this book use JavaScript code embedded in links placed on the Links bar. Although there's no way to create a blank button on the Links bar into which you can type the code, there are other easy ways to create such a link:

- Start by dragging-and-dropping any arbitrary link onto the Links bar. Then, right-click the new link, select Properties, and replace the URL with the appropriate JavaScript code.

- In Windows, right-click on an empty area of your desktop and go to New Shortcut. Type the JavaScript code into the location field, choose a name, and click Finish when you're done. Then, drag-and-drop the new shortcut onto the Links bar.

- Create a new web page (.html file) and place the JavaScript code into an `<a>` hyperlink tag (described in [Hack #40]). Then, open the page and drag-and-drop the hyperlink onto the Links bar. This is typically more trouble than the other two methods, but it can be an easy way to send the link to others, especially since you can include instructions right on the same page.

2.6.1 How It Works

The first part of the code, `win=window.open`, instructs your browser to open a new window and navigate to the URL that follows. The reason we need JavaScript at all is that part of the URL needs to use information from the auction shown in the current window, something a static link wouldn't be able to do.

Next comes the URL to open. The first part of the URL is taken from a standard eBay search URL, as seen in [Hack #12]:

```
http://search.ebay.com/ws/search/SaleSearch?satitle=
```

The query parameter is then completed by including the title of the currently displayed auction:

```
document.title.substring(document.title.indexOf(' - ') + 3)))
```

This last bit of code extracts the auction title from the page title by taking only the text that appears after the hyphen (with spaces on either side) that separates the end date from the auction title.

2.6.2 Hacking the Hack

By default, this hack searches only auction titles. To search both titles and descriptions, add the following parameter to the URL, making sure to place it before the `&query` parameter, like this:

```
&sotextsearched=2
```

A variation of this hack might be used to search completed auctions instead of current auctions, which may be useful for finding how similar items have previously sold or possibly seeing if the specific item on which you're bidding is being resold. Just change the URL to that of a completed item search, like this:

```
http://search-completed.ebay.com/search/search.dll?GetResult&query=
```

Note that eBay will complain if you try to show complete auctions and search titles and descriptions at the same time, since completed items can be searched only by their titles.
Hack 14 Search by Seller

Easy ways to find items sold by a particular seller.

If for no other reason than to save money on shipping costs, you may find yourself wanting to purchase multiple items from a single seller. Although you can't specify a particular seller when typing into a basic search box, there are three other ways to do it.

2.7.1 View Seller's Other Items

Probably the first thing that occurred to you is to just use the "View seller's other items" link on the auction page. If so, give yourself a gold star. This is typically the easiest way to search by seller because you can see an up-to-date listing of all the seller's current auctions.

Although this is good for perusing, there's no easy way to search here. The only thing you can do is use your browser's "Find on this page" feature (Ctrl-F), but this isn't exactly a breeze when the seller has over 1,100 open auctions divided into 47 pages of auction listings.

See [Hack #12] for a way to increase the number of items shown per page, thereby reducing the number of pages.

2.7.2 A Real Search by Seller

The most effective and flexible way to search by seller is to go to Search By Seller and then use the second, somewhat hidden box at the bottom of the page. If you use the first box at the top of the page, you'll get the same thing as "View seller's other items."

The Multiple Sellers search, shown in Figure 2-3, allows you to do an actual text search on the auctions from one or more specific sellers. Simply type your search in the Search Title box and include the seller's exact user ID in the Multiple Sellers box to conduct your search. You can specify up to 10 sellers by separating their user IDs with commas.

Figure 2-3. The Multiple Sellers search, hidden at the bottom of the Search By Seller page, allows you to specify the seller in a standard keyword search.
Hack 15 Search Internationally

Use different eBay localizations to look for things outside your home town.

When you search, you're not searching all of eBay; you're searching a subset of auctions made available to your localized version of eBay. Depending on where in the world you live, you may be using any one of the following sites:

<table>
<thead>
<tr>
<th>Localization</th>
<th>eBay address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td><a href="http://www.ebay.com.au">www.ebay.com.au</a></td>
</tr>
<tr>
<td>Austria</td>
<td><a href="http://www.ebay.at">www.ebay.at</a></td>
</tr>
<tr>
<td>Belgium</td>
<td>pages.ebay.be</td>
</tr>
<tr>
<td>Canada</td>
<td><a href="http://www.ca.ebay.com">www.ca.ebay.com</a></td>
</tr>
<tr>
<td>France</td>
<td><a href="http://www.ebay.fr">www.ebay.fr</a></td>
</tr>
<tr>
<td>Germany</td>
<td><a href="http://www.ebay.de">www.ebay.de</a></td>
</tr>
<tr>
<td>Ireland</td>
<td><a href="http://www.ebay.com/ie/">www.ebay.com/ie/</a></td>
</tr>
<tr>
<td>Italy</td>
<td><a href="http://www.ebay.it">www.ebay.it</a></td>
</tr>
<tr>
<td>Netherlands</td>
<td><a href="http://www.ebay.nl">www.ebay.nl</a></td>
</tr>
<tr>
<td>New Zealand</td>
<td><a href="http://www.ebay.com/nz/">www.ebay.com/nz/</a></td>
</tr>
</tbody>
</table>
Hack 16 Save Your Searches

Different ways to save your complex searches for repeated use.

Ruby’s Law states that anything you search for on eBay you will likely search for again. Okay, there is no Ruby, and I just made up the part about the law, but it's still a valid point.

2.9.1 Favorite Searches

The Favorites tab of My eBay is designed to save lists of your favorite searches, favorite categories, and favorite sellers. These lists are on-site and can be accessed even if you're not at home, which can be quite convenient.

To add a new category, click the "Add/change categories" link on the right side of the box. You can save only four individual categories, which can be chosen on the next page. Categories can be removed from the list by marking the corresponding checkboxes and clicking Delete.

The My Favorite Sellers page works similarly to the My Favorite Categories page, except that you type or paste the seller names instead of clicking. Also, there is a delay in adding new sellers to this list; be prepared to wait about a minute before reloading the page to see a newly added seller. You can save up to 30 seller names or eBay Stores (see [Hack #72]) on this list.

Figure 2-5. The My Favorite Searches list allows you to save up to 15 searches

Probably the most useful of the lists is My Favorite Searches, shown in Figure 2-5, not only because you can save extremely specific and targeted search queries, but because you can save your search directly from the search page. Simply perform a search — any search, including advanced searches or searches on international eBay sites — and click "Add to My Favorite Searches" in the top-right of the search page. Only your search query is saved, not your search results. Each time you click a favorite search, you'll see the most up-to-date search results. To save specific auctions, see [Hack #24].

Click the search caption to perform the search. Up to 100 different searches can be saved here, 30 of which can be configured to email you daily when new matches are found. Click Preferences to "subscribe" to a daily email notification, as well as rename a search without changing its search criteria. (See [Hack #17] for a more flexible tool to notify you of new listings.) Although you can click Refine to change the parameters of an existing favorite search, it's actually easier to simply perform the search normally and make your revisions right on the search page. When you're done, click "Add to My Favorite Searches" again, click "Replace one of these with my new search," and then select the old search caption in the list to replace the old version with the revised search.

2.9.2 Quick and Dirty

Another way to save your searches involves no special features at all. Since all the parameters of a search are stored in the URL (see [Hack #12]), all you need to do is bookmark a search to save it. Probably the most convenient method is to create shortcuts to your favorite searches by dragging and dropping the Address Bar shortcut icon onto your desktop, as shown in Figure 2-6.

Unlike items in the My Favorite Searches list, you can sort your searches alphabetically or by date, or even organize them in multiple folders.

2.9.3 A Little Spit and Polish

Instead of saving your searches as shortcut files, you can just as easily create a custom My Favorite Searches page. Start by opening a blank document in your favorite WYSIWYG web page editor (such as Netscape Composer, which comes free with the Netscape and Mozilla browsers) and placing it side-by-side next to an eBay search window. Then, drag the Address Bar shortcut icon onto your blank web page to create a link to the search; repeat for as many searches as you like.

Your custom search links can then be renamed and organized to your heart's content. When you're done, save the page and then open it in a browser. Or, upload it to a web server so that you (and others) can access it anywhere.

2.9.4 See Also

• [Hack #19] allows you to save recent searches right in your browser's toolbar.

• See [Hack #17] for a way to not only save your search, but to be automatically notified when new matches are found.
Hack 17 Create a Search Robot

Use the WWW::Search::eBay Perl module to perform your searches for you.

A collector in search of a particular item or type of item may repeat the same search, often several times a week. A serious collector, knowing that items sometimes sell within hours of being listed (see [Hack #26]), may repeat a search several times a day for an item. But who has the time?

The Favorites tab of the My eBay page, which allows you to keep track of up to 100 favorite searches (see [Hack #16]), also has a feature to email you when new items matching your search criteria appear on the site. Just check the Preferences link next to the search caption, and then turn on the "Email me daily whenever there are new items" option.

Unfortunately, eBay's new-item notification feature will send you notifications no more than once a day, and in that time, any number of juicy auctions could've started and ended. So I created this hack to do my searches for me, and do them as often as I see fit.

2.10.1 Constructing the Robot

By "scraping" eBay search results with the WWW::Search::eBay Perl module (developed by Martin Thurn), any Perl program can retrieve search results from eBay and manipulate them any way you want. You can download the module for free from search.cpan.org/perl?WWW::Search::eBay and install it on any computer that has Perl. See Installing Perl Modules for installation details.

Installing Perl Modules

(Adapted from Google Hacks by Tara Calishain and Rael Dornfest)

A few hacks in this book make use of add-on Perl modules, useful for turning dozens of lines of messy code into a couple of concise commands. If your Perl script resides on a server maintained by someone else (typically an ISP administrator), you'll have to request that they install the module before you can reference it in your scripts. But if you're the administrator, you'll have to install it yourself.

Installing on Unix and Mac OS X:
Hack 18 Find Items by Shadowing

Become an auction stalker and leech off someone else's searching skills.

Often the best deals on eBay are the auctions that most bidders don't find, usually as a result of sellers not knowing what they're selling or not taking the time to promote them properly. The better you become at searching, the more likely you are to find the auctions that are off most bidders' radar. Sometimes, it takes nothing more than dumb luck to stumble upon a great find; occasionally, it helps to rely on other users' dumb luck (and skill) as well.

As much as eBay is a single community of millions of users, it can also sometimes feel like a bunch of micro-communities, each centered around certain genres and auction categories. As you use eBay and become more familiar with the categories in which you're interested, you'll start to recognize individual buyers who, like you, frequently return to eBay in search of more antique pottery, model trains, Ford Model A restoration parts, first-edition Hemingways, or whatever else you might collect.

As soon as someone bids on an item, that bid becomes public record, even though the bid amount is kept private until the auction ends. All you have to do when you see that someone has bid on something in which you're interested is search for other auctions on which he has bid. Not only will you discover auctions for similar items, you'll discover new items that you may not have even known to look for.

[1] The exceptions are private auctions and auctions held in localizations with strict privacy laws, such as eBay Germany (www.ebay.de).

To do this, just highlight the bidder's user ID, copy it to the clipboard (Ctrl-C), go to Search By Bidder, and paste (Ctrl-V) into the Bidder's User ID field. Select No to exclude completed auctions, and click Search. You'll then be shown a list of all public auctions on which that user has bid, whether or not he is the high bidder.

2.11.1 Prevent Bidders from Shadowing You

It's typically in your best interest as a bidder to have as few people as possible see an auction on which you're bidding. Fewer interested bidders means fewer bids, which, in turn, means a lower price and a higher likelihood that you'll win the auction.

Bid shadowing is not common on eBay, but is practiced by some of the more determined users from time to time. The best way to prevent others from shadowing your bids is to bid later in the auction, thereby shrinking the window of time during which other bidders can see where you've bid. See [Hack #21] for a way to take this to the extreme and effectively eliminate shadowing altogether.
Hack 19 The eBay Toolbar

Expand your browser with eBay's custom toolbar application.

The eBay Toolbar, shown in Figure 2-7, is a free add-on program that provides a handy search box, links to several key eBay pages, and two desktop "alert" features.

Figure 2-7. The eBay Toolbar provides several handy tools, primarily useful for bidders, such as two "alert" features not otherwise available to non-toolbar-equipped browsers

Provided you're running a recent version of Windows and using a new version of Internet Explorer or an old version of Netscape Navigator, you can download the eBay Toolbar at pages.ebay.com/ebay_toolbar. (Users of Mozilla, Netscape 6.x/7.x, Unix, or a Mac of any kind are out of luck.)

In addition to providing handy links to My eBay, the Search pages, the PayPal home page, and other hot spots, the eBay Toolbar also has some features you won't find elsewhere:

- The Search textbox keeps a history of the last few searches you've typed (up to 25), which can be a quick and easy way to save past searches (see [Hack #16]). But you have to use it exclusively, as it doesn't link up with the My Favorite Searches list and it will not save any search typed in the site itself.

- Bid Alerts notify you 10, 15, 30, 60, or 75 minutes before the end of an auction on which you've bid, which is useful if you wish to return to the auction to bid again and ensure a win. Included in the Bid Alerts menu is a handy list of all the open auctions on which you've placed at least one bid; click Refresh Bid List if it appears to be out of date. Click the little arrow next to the eBay logo and click eBay Toolbar Preferences to customize this feature.

- Watch Alerts work just like Bid Alerts, but apply to items in the Items I'm Watching list (see [Hack #24]), which can be especially useful for sniping (see [Hack #21]).

- The Bookmarks feature works just like Netscape's Bookmarks button and Internet Explorer's Favorites menu. Probably its greatest strength is that you'll be tempted to fill it with links to eBay-related pages, reducing clutter in your browser's own Bookmarks list.
Chapter 3. Bidding

- Section 3.1. Hacks #20-32
- Hack 20. Sniffing Out Dishonest Sellers
- Hack 21. Snipe It Manually
- Hack 22. Automatic Sniping
- Hack 23. Conditional Sniping with Bid Groups
- Hack 24. Keep Track of Auctions Outside of eBay
- Hack 25. Take Advantage of Bid Increments
- Hack 26. Manipulating Buy-It-Now Auctions
- Hack 27. Retract Your Bid Without Retracting Your Bid
- Hack 29. Send Payment Quickly and Safely
- Hack 30. International Transactions Made Easier
- Hack 31. Save Money on Shipping
- Hack 32. Dealing with Disappointment: Getting Refunds
3.1 Hacks #20-32

The term "auction" evokes a vivid image in most people's minds: a fast-talking auctioneer at a podium, dozens of seated participants, and an assistant parading numbered collectibles across the stage, one by one, as the participants place their bids. The auctioneer quotes an opening price, and participants signal their interest by raising their hands, at which point the bid price is raised by some arbitrary amount. Bidding for each item continues until the current bid price exceeds the amount all but one of the participants is willing to pay.

Ebay's bidding system works a little differently. For one, auctions are timed, and close at a predetermined date and time, regardless of the bid price or whether or not everyone has finished bidding.

Secondly, Ebay uses something called "Proxy Bidding," a system that somewhat compensates for the fact that the auctions are timed. Instead of placing individual bids on an item, you simply specify a single "maximum bid," and Ebay does the rest. Imagine sending someone else to an auction for you, giving them a certain amount of money to bid on a single item. That person, the proxy, would place traditional bids until he wins the auction or runs out of money.

Finally, Ebay offers "fixed-price" listings, allowing buyers and sellers to skip the bidding process and complete the deal with a single purchase, as though Ebay were just another online store. Furthermore, the "Buy-It-Now" feature allows sellers to turn their auctions into a hybrid of sorts, permitting either ordinary bidding or a single purchase. (See [Hack #26] for more information.) Factoid: About 24% of all listings on Ebay end with a Buy-It-Now or fixed-price purchase.

3.1.1 Proxy Bidding

The best way to understand proxy bidding is to see it in action.

A seller starts an auction for an antique pocket watch, and sets an opening bid of $25.00. The duration of the auction is five days; since the auction started at 3:52 P.M. on a Thursday, it is scheduled to end at 3:52 P.M. the following Tuesday. Here's how bidding might proceed:

<table>
<thead>
<tr>
<th>Time</th>
<th>Bid placed...</th>
<th>Price becomes...</th>
<th>What happened?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Friday</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10:00 A.M.</td>
<td>Bidder 1 bids $45</td>
<td>$25.00</td>
<td>First bid; price is set at opening bid price.</td>
</tr>
</tbody>
</table>
Hack 20 Sniffing Out Dishonest Sellers

A little research can save you a big headache.

Just because you're paranoid doesn't mean they're not really after you. And just because you take steps to protect yourself doesn't mean that there aren't sellers ready to sell you a lot of hot air. Fortunately, eBay provides a lot of tools to help you discern the good sellers from the bad.

Naturally, feedback (see Chapter 1) should be your first recourse, not only when you suspect a seller of being dishonest, but any time you bid on an item sold by an unknown eBay member. But there are limitations to the feedback system. For one, it relies on the intelligence of past buyers, something you can never count on. It also takes a few weeks for feedback (negative or otherwise) to make its way back to a seller, so a new user — or an old user new to selling — may be able to sell under the guise of a trustworthy seller for up to a month before his reputation catches up to him.

3.2.1 If It Sounds Too Good to Be True . . .

You've heard it before, and it undoubtedly runs through your head when you're looking at certain auctions: if something sounds too good to be true, it probably is. Now, there are certainly more exceptions to this rule on eBay than at most other places, mostly due to sellers who don't know what they're selling or don't do a good job of constructing the auction. (In fact, I've gotten some great deals — even to the point of effectively getting stuff for free — simply by being more knowledgeable than the seller.) Nonetheless, don't let your desire for a deal cloud your better judgment.

The photo can be a dead giveaway, both to a dishonest seller and to an inexperienced seller who simply doesn't know any better. If the photo appears to be intentionally blurry, doctored, or simply doesn't match the item described in the auction (or other photos of the same item), it should be your first clue that something's fishy. Check out some of the seller's other auctions (both past and present) and look for patterns (or lack thereof); for example, do all the photos have the same background? If they don't, the seller may have snatched them from other auctions or web sites (see [Hack #58]). This can either mean that they're selling something they don't have, or merely that they're lazy.

So how do you tell the difference between someone who is trying to rip you off and someone who simply hasn't taken the time to construct a proper auction? Assuming there's still some time left before the auction closes, ask the seller a question. Specific questions, such as those that inquire about an item's dimensions or whether or not it comes with a particular accessory, are good ways to determine whether or not the item described is actually the item you'll receive.

3.2.2 The Shipping-Cost Scam

One of the most common scams is to sell something for pennies, and then make up the difference in shipping costs. Typically, this involves the seller listing the price at a very low amount and then adding a huge shipping charge to make up for the difference. This is often done to avoid eBay fees. However, it is still a violation of eBay's policies and can result in the seller being suspended or even banned.

For example, if you see an item listed for $5.00 but then see an additional shipping charge of $20.00, it's likely that the seller is trying to make up for the difference in price. It's important to be aware of this and to ask for clarification before bidding or purchasing the item. If the seller is unwilling to provide a reasonable shipping charge, it's likely that they are trying to scam you and you should avoid them.

To avoid falling for this scam, always check the seller's feedback and ratings. If they have a history of similar issues or complaints, it's likely that they are trying to scam you. It's also a good idea to use the eBay feedback system to report the seller if you feel that they are trying to scam you.

In summary, when you're shopping on eBay, always do your research and be aware of potential scams. By being aware of the most common types of scams and how to avoid them, you can protect yourself and ensure that you get a fair deal.
Hack 21 Snipe It Manually

Bid at the last minute to simultaneously ensure that you win the auction and that you pay the lowest possible amount.

It shouldn't take long to figure out that it's usually better to bid later in the auction—the later the better. Many eBay users wait until the last few minutes of the auction to bid, leaving no time for lower bidders to be notified and respond with higher bids. This is called sniping, and all it takes is a little nerve and the ability to tell time.

Sniping leaves no time to read the auction description carefully or to ask the seller any questions you may have. Make sure you take care of these things long before the end of the auction.

When you've found an auction you want to snipe, the first step is to track the auction and make note of its closing date and time; see [Hack #24] for details. Then, all you need to do is return to eBay a few minutes before the auction ends and place your bid.

The problem is that many eBay users make a habit of doing this, so you'll likely have competition. With multiple snipers, the prize often goes to the bidder who can enter a bid closest to the end of the auction.

3.3.1 With Seconds to Spare . . .

The most effective snipes occur within 10 seconds of the end of the auction, leaving no time for other bidders to even see your bid — not to mention outbid you — before it's too late.

Give yourself about two minutes to set up. Start by opening two browser windows (press Ctrl-N to open a second window), and open the auction page in both windows. Move and resize the two browser windows so they're side by side on your screen.

Type your maximum bid in one of the windows and click Place Bid (but do not confirm your bid on the next page). If necessary, scroll the page so that the Confirm Bid button is visible and not obscured.

Then, switch to the other window and reload (refresh) the page by pressing Ctrl-R. Reload it again a few seconds later to see any changes to the current price and the time left. Repeat this until there's only 10-15 seconds left in the auction.
Hack 22 Automatic Sniping

Use eSnipe to snipe without actually having to be there when the auction ends.

Sniping is an effective way to increase your odds of winning an auction while simultaneously lowering the final price you pay (see [Hack #21]). But there are significant drawbacks to sniping that limit its practical usefulness:

- You have to be in front of your computer, ready to bid, at the exact time the auction ends.
- It's nearly impossible to snipe two or more auctions ending at the same time.
- If your computer crashes or your Internet connection goes down moments before you snipe, you lose.
- You can easily forget to bid, or even become distracted moments before bidding time. (I can't tell you how many times I've been distracted by a doorbell ring or a good song on the radio, only to turn around and find that I've missed my two-minute sniping window.)

The solution, of course, is to simply bid early, and then return to the auction after it's over to find that you've been outbid by 4 cents. Fortunately, there is a better way.

A number of sniping services are available that will automatically place a bid for you at a specified time, typically a few minutes or seconds before the end of an auction. Some sniping services are simply standalone programs that run on your computer, but these suffer some of the same limitations as sniping manually—namely, that your home computer be turned on and connected to the Internet at the right time. The better services are web-based, like eBay itself, and operate whether or not your computer is powered up.

When you use a sniping service, you must share your eBay ID and password so the software can log in and bid for you. While some sniping services are legitimate, there will undoubtedly be some services that use this information unscrupulously. So use caution and do your homework before trusting an unknown service with your eBay login.

The best sniping service available by far is eSnipe (www.esnipe.com). It's extremely easy to use, very reliable, and best of all, it works. Just log into eSnipe with your eBay user ID and password, and you're ready to go. To set up a snipe, specify the auction number, the amount to bid, and the buffer time (number of seconds before the end of the auction), as shown in...
Hack 23 Conditional Sniping with Bid Groups

Automatically discard future snipes once you win an auction.

One of the best features of eSnipe is its ability to cancel one or more future snipes once you win an auction (see [Hack #22] for more information on eSnipe).

Say you want to buy a PDA. Since PDAs are a common commodity on eBay, you'd likely be happy winning any one of a dozen different auctions for the same model. But if you were to snipe them all with eSnipe, you run the risk of winning more than one auction. The solution is to use eSnipe's Bid Group feature.

Start by clicking the Bid Groups tab on the eSnipe site, and then clicking Create New Bid Group, as shown in Figure 3-2. Type a name for the new group under Brief Name and click Create New Folder (the Long Name and Description fields are optional).

Figure 3-2. eSnipe's Bid Groups feature allows you to snipe multiple auctions until you win one

Next, pick one of the auctions on which you want to bid and begin placing an eSnipe bid as you normally would. The only difference is that you must choose the name of the Bid Group you just created from the "Part of Bid Group?" field. Repeat the process for the other auctions in the group.

eSnipe will bid on each of the auctions in the Bid Group, one after another, until it wins one. As soon as an auction has been won, the pending bids from all remaining auctions will be canceled.
Hack 24 Keep Track of Auctions Outside of eBay

Use eBay's auction-tracking tools, or create a flexible auction-watching tool better than anything eBay has to offer.

If I bought everything on eBay I wanted, I would've gone broke long ago. But I'm also a collector, and as such, I routinely track many auctions in my various fields of interest, whether or not I actually intend to bid on them.

I would argue that keeping track of auctions is among your most important tasks as a bidder — especially for items you've won — if for no other reason than to ensure that you eventually receive everything you've paid for. Tracking auctions is also an essential part of sniping (see [Hack #21]) as well as selling (see [Hack #33]). If you're really after something specific, you may want to track completed auctions that didn't sell so you can find them easily when they're relisted. And sometimes you may want to keep track of an auction's progress purely for the sake of curiosity.

3.6.1 Using eBay's Tracking Tools

The Bidding/Watching tab of My eBay is where most people turn to track their auctions. The Items I'm Bidding On list and the Items I've Won and Items I Didn't Win lists are all updated automatically whenever you place a bid or an auction on which you've bid closes, respectively. These lists include all the vitals, such as the auction titles, amounts of your bids, end dates, and closing prices.

By default, the Items I've Won and Items I Didn't Win lists show only auctions that have ended in the past few days, but you can increase their range to up to 30 days by typing the desired number of days in the box at the top of each list. And like search results, all the lists on this page can be sorted by clicking the hyperlinked column headers.

You can clean out these lists by ticking the checkboxes next to one or more auction titles and clicking Delete. However, when you delete an auction, its entry disappears into the ether with no means of retrieval; instead, you'll have to search by bidder for your own auctions (see Chapter 2) to get a complete listing of your bids. A better way to shorten these lists is to simply decrease the number of days back they go.

The Items I'm Watching list, also on the Bidding/Watching page, is a very handy tool, but it works somewhat differently from the others. It will remain empty until you choose to "watch" an auction: simply go to any auction (or fixed-price listing) page and click "Watch this item." A message then appears confirming that item is now being tracked in My eBay; click the link to view the updated list. The Watching list is easy to use and adequate if you never track more than a few items at a time.
Hack 25 Take Advantage of Bid Increments

A slight adjustment to your bidding strategy will help you save money and win more auctions.

Every auction has a minimum bid, a dollar amount shown just above the Place Bid button on the auction page, as shown in Figure 3-4. If the auction hasn't received any bids, the minimum bid is the same as the starting bid. Otherwise, the minimum bid is equal to the current price plus a bid increment.

Figure 3-4. The Bidding Section shows the current bid increment and minimum bid

Bid increments, at least in theory, prevent bidders from outbidding one another by a single cent, and are calculated as follows:

<table>
<thead>
<tr>
<th>Current price</th>
<th>Bid increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0.01 - $0.99</td>
<td>$0.05</td>
</tr>
<tr>
<td>$1.00 - $4.99</td>
<td>$0.25</td>
</tr>
<tr>
<td>$5.00 - $24.99</td>
<td>$0.50</td>
</tr>
<tr>
<td>$25.00 - $99.99</td>
<td>$1.00</td>
</tr>
<tr>
<td>$100.00 - $249.99</td>
<td>$2.50</td>
</tr>
</tbody>
</table>

For example, an auction currently at $68.45 will have a minimum bid of $69.45 ($1.00 more), so you wouldn't be able to bid $69.00 even though it's higher than the current price.

Bid increments also come into play when calculating the current price. If there's more than one bidder, the current price is equal to the second-highest bidder's bid plus the bid increment. So if someone bids $114 and someone else bids $157, the current price will be $116.50 ($114 + $2.50), and the minimum bid for future bidders will be $119 ($116.50 + $2.50).

As more bids are placed, the current price continues to rise, always equal to the second-highest bid plus the bid increment. But it gets more interesting when someone places a bid very close to the high bidder's maximum bid. The bid increment rule is compromised by another rule: eBay will never raise the current price above the highest bidder's maximum bid. Here's how this works:

- If someone bids $156.80 on this auction, it will raise the current bid to $157, even though it's only 20 cents above the second-highest bidder's maximum.
- If a subsequent bidder enters a bid of $157, the current price will be exactly $157. The original bidder will still be the high bidder, because earlier bids take precedence over later bids of the same amount.
- If the later bidder bids $157.01, the current price will be raised to $157.01 (one cent above the previous high bid), and the newcomer will become the high bidder.

This loophole effectively allows you to outbid another bidder by as little as a single cent. But why is this important, and how is this useful?

3.7.1 Outbidding the High Bidder

Bid amounts are always kept hidden until an auction closes. As described above, however, you can easily determine the second-highest bidder's maximum bid by subtracting the bid increment from the current price. Only the high bidder's maximum remains elusive.

Most bidders type whole, round numbers when bidding, primarily out of habit and sometimes out of laziness. You can take advantage of this by guessing a high bidder's maximum and adding a penny. For example, if an auction with a starting bid of $7.99 has only one bidder, the current price is $7.99. If that bidder is relatively new to eBay (having a feedback rating of, say, less than 30), that bidder most likely typed either $8 or $10 as a maximum bid. Although you couldn't bid $8.01, as the minimum bid would be $8.49, you could bid $10.01 and have a pretty good chance of outbidding the other bidder by a single cent. Contrast this to a bid of $15.00, which would result in a final price of $10.50 ($10 plus the 50-cent increment). You've just saved 49 cents.

More experienced bidders won't type whole numbers, but they will likely be just as predictable. If you want to outbid someone by a single cent, try searching for past auctions they've bid on (see Chapter 2); look at the bidding history of closed auctions they didn't win, and you'll see their exact bids. Look at two or three old auctions, and you'll likely find a pattern.

Understanding bid increments is also extremely useful if you bid and don't end up as the high bidder. If, after you bid, the current price ends up lower than your bid plus the bid increment (you bid $40 and the price rises to $40.17), then the high bidder's maximum bid is equal to the current price (in this case, $40.17). This means that all you need to do is place one more bid of at least $41.17 to put yourself in the lead. Combine this with sniping [Hack #22], and you've won the auction!

3.7.2 Take It One Step Further

You can take steps to prevent other bidders from outbidding you by one cent (and they will) while allowing you to more readily outbid others. Instead of bidding whole, round numbers, make a habit of bidding odd numbers, such as $10.07 or $11.39. That way, if someone bids $10.01 or $11.01, respectively, you'll still be the high bidder. Likewise, you'll also be more likely to outbid others who type bid amounts like $10.01.
Hack 26 Manipulating Buy-It-Now Auctions

Save money with the loopholes of the Buy-It-Now feature.

The Buy-It-Now feature that appears in some auctions allows a bidder to bypass the bidding process and end an auction early at some predetermined price. Whether or not this is a good deal for the buyer, however, depends on the Buy-It-Now price the seller has chosen.

The Buy-It-Now option remains visible on the auction page until the first bid is placed, after which it disappears. (The exception is reserve-price auctions, where the Buy-It-Now will be available as long as the reserve hasn't been met, regardless of the number of bids.) There are several ways to use this to your advantage.

### 3.8.1 Start with the Obvious

Some of the best deals I've gotten on eBay have been Buy-It-Now items, where the seller specified too low a Buy-It-Now price, and I snatched it before anyone else got a chance. If you see a good price, why wait? Just click Buy-It-Now and end the auction without bidding.

There may be a reason that an auction has a low Buy-It-Now price; make sure you read the auction description carefully before you commit. Buyers have the same obligation to complete Buy-It-Now transactions as those that end normally.

Sort your search results by Newly Listed, and the newest Buy-It-Now auctions will appear first. This gives you a good chance to catch early deals, as they're unlikely to last more than a few hours.

### 3.8.2 Undercut the Buy-It-Now Feature

Auctions with too high a Buy-It-Now price are just as common as those with a low Buy-It-Now price. But there will always be some yahoo who doesn't know any better, and will come along and buy these items anyway. If, however, you place a bid right away — say, the minimum amount — the Buy-It-Now option will disappear, and bidding will proceed normally. This will not only give you a chance to win the item for less than the Buy-It-Now amount, but will also give you more time to decide whether you really want the item. (This is an example of when it pays to bid early, a strategy contrary to that of [Hack #21].)

This works best on auctions with artificially low starting bids, because bidding is likely to exceed your first bid and you'll be under no obligation to buy. For example, a few weeks ago, I undercut an auction...
Hack 27 Retract Your Bid Without Retracting Your Bid

Back out of an auction before it's too late.

There are a lot of reasons why you might want to back out of an auction after bidding. Obviously, if you make a mistake and bid the wrong amount or bid on the wrong auction, you'll want to retract that bid before the auction ends and you're obligated to pay.

But there are other reasonable circumstances under which you may change your mind about an auction. Sellers can make changes to the description or photos, even after the item has received bids (see [Hack #50]), and such changes may affect your desire for an item or your ability to pay for it. Or, if you lose your job and find your daughter needs braces, your desperate need for that 42" plasma TV may become slightly less desperate.

eBay takes bidding very seriously, to the point of imposing restrictions as to when and under what circumstances you can retract a bid. This is understandable, considering the scams a small minority of eBay users have propagated; look up "buying offenses" in eBay's Help for an exhaustive list (and lots of ideas, too).

3.9.1 By the Book

The easiest way to retract a bid is to use the "Retract my bid" form. Simply enter the auction number, choose one of the prewritten excuses from the list, and click Retract Bid. (It doesn't really matter which reason you choose; the end result will be the same.) All your bids on the auction will be canceled, and the auction's current price will be adjusted accordingly.

Not surprisingly, you can't retract a bid after an auction ends under any circumstances. Keep this in mind any time you bid, and especially when you snipe (see [Hack #21]).

The problem is that any bid retractions will be shown on your feedback page for six months, and while it doesn't actually affect your feedback rating, excessive bid retractions may make you appear less trustworthy and certainly less serious. Furthermore, a pattern of bid retractions may arouse the suspicions of eBay's investigations department; at the extreme, your account may be suspended if eBay suspects abuse of their system.

This is also where eBay's restrictions come into play: during the last 12 hours of an auction, you are not allowed to retract any bid placed before the final 12 hours.[4] Furthermore, if you bid in those last 12 hours, you can only retract your bid within one hour of placing it. Note that because of this restriction,
Hack 28 Tools for Dealing with Fraud

Your last resort to get your money back.

eBay provides two tools to help buyers deal with suspected fraud by sellers, mostly to the end of retrieving any money sent. These should be used only as a last resort, if diplomatic efforts fail and if the buyer didn't use a payment method with built-in protection (see [Hack #29]). These tools can also be used by sellers who suspect fraud by buyers.

The first tool is the Fraud Alert form (crs.ebay.com/aw-cgi/ebayisapi.dll?crsstartpage), which is little more than a moderated discussion between buyer and seller. The two parties air their complaints in a private forum on eBay's site and, in some cases, resolve the dispute themselves; the prying eyes of the typically silent eBay moderator act as a stern parent separating two kids in the back seat.

If you wish to pursue a fraud investigation, you can also file a report with SquareTrade (www.squaretrade.com). SquareTrade is a separate company, but has a partnership with eBay and offers dispute resolution services at no charge. (See [Hack #6] for another service provided by SquareTrade.)

Note that eBay's buyer and seller protection services are available only to participants in officially completed auctions. This means that if you weren't the high bidder in an auction or if the reserve wasn't met, you won't have access to these services.

3.10.1 Sleuthing Tools at Your Disposal

An eBay user who knowingly commits fraud will undoubtedly take steps to hide his or her true identity, but there are a few things you can do to learn more about who you're dealing with:

- Start with the obvious: check the user's feedback profile and look for a possible pattern of behavior. Next, contact any other buyers and sellers with whom the user has completed a transaction. Use the buyer search and seller search to find relevant auctions for the last 30 days, or use the auction numbers in the user's feedback page to view auctions up to 3 months old.

- Use the Find Contact Info form (Search → Find Members → Contact Info) and enter the user's ID and the auction number, and eBay will email you the phone number and mailing address on file for that user. The user will also receive a notice that you've requested the
Hack 29 Send Payment Quickly and Safely

The best — and worst — ways to pay for an auction.

It's your money, and you can do anything you want with it. That said, I don't want to see any of you stuffing dollar coins up your nose or sending cash through postal mail.

Electronic payments have become the most popular method of paying for auctions on eBay, and for good reason—sending money online is by far the safest, quickest, and cheapest way to pay, for both buyers and sellers.

When choosing an auction to bid on or when deciding how to pay for an auction you've won, look for any payment method that can be funded by a credit card. Although some people are downright terrified of transmitting credit card numbers over the Internet, credit cards are undoubtedly the safest way to pay online. You can dispute any unauthorized charges with your credit card company with a simple phone call, which is much easier than trying to find out what happened to a check you mailed six weeks ago. Some cards even offer extended buyer-protection services such as replacement insurance.

Sellers choose which payment methods to accept, so make sure you can abide by the payment terms specified in an auction before you bid. If there is more than one of a particular item you want on eBay, look for the seller who accepts the type of payment you want to use.

Avoid auctions by sellers with overly restrictive payment terms. A seller who accepts only cash and money orders, for example, may have something to hide, or at least will be more of a hassle to deal with than a seller who accepts online payments. (Let this be a lesson to sellers, too: if you want more bids, give your customers more ways to pay.)

3.11.1 PayPal: The eBay Way

PayPal allows you to send a payment to almost anyone with an email address, regardless of whether or not the payment is for an eBay auction. Just go to www.paypal.com, log in, click Send Money, and type the amount to send and the email address of the recipient. See Signing Up with PayPal if you don't yet have a PayPal account.

Signing Up with PayPal
Hack 30 International Transactions Made Easier

Tools to help overcome the hurdles and gotchas associated with trading with members in other countries.

Everything gets a little more complicated when trading across international borders. Language barriers, currency confusion, payment hassles, and high shipping costs are all common problems. Here are some of the tools at your disposal to help simplify international transactions.

3.12.1 View Auctions on Your Native eBay

Although eBay has several international sites, all auctions are contained in the same global database. For example, if you're looking at an auction on the German eBay, like this one:

http://cgi.ebay.de/ws/eBayISAPI.dll?ViewItem&item=3128013702

You can simply change the domain from ebay.de to ebay.com, for example, and you'll see the auction details in more familiar terms:

http://cgi.ebay.com/ws/eBayISAPI.dll?ViewItem&item=3128013702

The currency used for the starting bid, current price, and minimum bid will all be automatically converted to your native currency. Additionally, the end time will be changed to your country's local time, and the payment and shipping terms will be translated into your native language. Almost every part of the auction page is changed — except for the auction description.

3.12.2 Enter the Babel Fish

If the auction description is not in your native language, you'll have to translate it manually. The easiest way is to copy and paste the description (or auction URL) into an online translator, such as the following sites (all free):

- AltaVista Babel Fish (babelfish.altavista.com)
- FreeTranslation (www.freetranslation.com)
- Dictionary.com Translator (dictionary.reference.com/translate)
Hack 31 Save Money on Shipping

Save the seller time, get your item sooner, and cough up less money for shipping.

I hate being ripped off, and one of the most common rip-offs on eBay is inflated shipping charges. The problem is that most sellers who overcharge for shipping don't even know they're doing it.

Sellers want to cover all their costs, so it's the buyer who ends up footing the bill for packing materials, shipping charges, insurance, and the bagel the seller ate while waiting in line at the post office. But even those who charge only for shipping charges may still be charging their buyers too much, simply because they don't know a cheaper or more efficient shipping method.

The problem is that most sellers don't care how much they spend on shipping because, in theory anyway, the buyer is the one paying for it.

If you don't know what method of shipping a seller is using, just ask. You have a right to know what you're paying for, and many sellers will be willing to use a cheaper (or faster) shipping option if you request it.

3.13.1 A Little Knowledge Can Be Dangerous

Fortunately, every buyer has access to the same tools sellers use to estimate shipping costs. The first thing to do when quoted a shipping charge that seems a tad high is to look it up for yourself.

The three largest couriers in the U.S. are FedEx (www.fedex.com), UPS (www.ups.com), and the United States Postal Service (www.usps.com), and all three have online shipping-cost calculators. (Most couriers in other countries have similar services; see [Hack #30].)

Typically, all you need for a shipping-cost quote are the origin and destination zip codes and the weight of the package.[8] The origin zip code can be found in the seller's address, usually included with any payment instructions; if not, just ask. The destination zip code is simply your zip code, which you already know (hopefully). If you don't know the weight of the item, just take a guess. Make sure to include extras like insurance and residential delivery surcharges when choosing your shipping options.

[8] Some shippers ask for the package dimensions, but these rarely affect the price quoted. If in doubt, just make an educated guess.
How to get your money back when an item isn't all it was made out to be.

In some ways, eBay is no different from any other store. Whether it's a brick-and-mortar shop down the street or an online superstore across the country, sometimes you don't get what you were expecting and you want your money back.

Getting your money back requires three things: knowing what your rights are, understanding what policies and requests are considered "reasonable," and most of all, knowing what tools you have at your disposal if the seller is less than cooperative.

Sellers: see [Hack #39] for easy ways to reduce the likelihood of returns, and [Hack #71] for tips on getting your money back.

3.14.1 Diplomacy Tactics

It's the seller who sets the return policy for any given auction, so before you write the seller and complain, you'll need to check the auction description and the seller's About Me page (if applicable) to see if the seller has outlined a policy on returns. For instance, the seller might accept returns only under certain circumstances, or might not accept returns at all. Other sellers will be more understanding, accepting returns within three days of receipt, or offering refunds on everything except shipping.

Next, see if the problem (your reason for wanting a refund) is stated in the auction. For example, if the seller wrote that the item is missing a wheel in the description, then said missing wheel is not a valid reason for return. Sellers should not be held responsible because a bidder didn't read the auction description.

Finally, contact the seller and let him know that you're not happy with the item you received. Your first email will set the tone for the entire conversation, so try to avoid sounding angry or unreasonable. Instead, be calm, understanding, and thoughtful. For example:

- "I received the item yesterday; thanks for the quick shipping. Unfortunately, its condition was somewhat worse than described in your auction. Would you be willing to accept a return?" This is friendly, even to the point of thanking the seller for something he did right. It also cuts to the chase and specifically outlines a valid reason for return. Also, it makes no demands, which will make the seller much more receptive to your request.
Chapter 4. Selling

- **Section 4.1. Hacks #33-54**
  - Hack 33. What's It Worth?
  - Hack 34. To Bundle or Not to Bundle
  - Hack 35. Reserve Judgment
  - Hack 36. The Strategy of Listing Upgrades
  - Hack 37. Putting Keywords in Your Auction
  - Hack 38. Track Your Exposure
  - Hack 39. Expectation Management
  - Hack 40. Formatting the Description with HTML
  - Hack 41. Customize Auction Page Backgrounds
  - Hack 42. Framing Your Auctions
  - Hack 43. Overriding eBay's Fonts and Styles
  - Hack 44. Annoy Them with Sound
  - Hack 45. Put a Shipping Cost Calculator in Your Auction
  - Hack 46. Allow Visitors to Search Through Your Auctions
  - Hack 47. List Your Other Auctions in the Description
  - Hack 48. Make Good Use of the About Me Page
  - Hack 49. Opting Out of Checkout
  - Hack 50. Make Changes to Running Auctions
  - Hack 51. Dynamic Text in Auction Descriptions
  - Hack 52. Let's Make a Deal
  - Hack 54. Keeping Out Deadbeat Bidders
4.1 Hacks #33-54

People will buy anything. The old adage "one person's trash is another's treasure" has never been more true than on eBay. And for this reason, you'll find that people will sell just about anything. From antique pottery to broken pieces of the Berlin Wall, from computers to cell phone batteries, from collectible dolls to human organs, you'll find a rich assortment of junk and jewels at the world's largest flea market.

Selling on eBay is a piece of cake. Just click the Sell button at the top of any eBay page and follow the prompts. When you're done, your auction will start, and other eBay users can bid on it.

The hard part, however, is the stuff eBay doesn't tell you, such as how to get more bids and more money for your items, how to get the most bang for your buck when using the extra-cost listing upgrades, how to hide search keywords in your auctions, how to make deals with bidders, and how to customize your auction descriptions with JavaScript, HTML, forms, and other goodies. The hacks in this chapter are designed to help you get more money for your items, communicate more effectively with your customers, and have more fun while you're at it.

See Chapter 5 for photo-related hacks, Chapter 6 for completing the transaction, and Chapter 7 for streamlining hacks to help you run a business on eBay.
Hack 33 What's It Worth?

Determine an item's current market value using eBay's Completed Items search and set your price accordingly.

On eBay, research is money. A seller who knows how much an item is worth will be able to choose the selling options more appropriately, and as a result, get more money for it. And a buyer who knows the worth of an item will more readily recognize a good deal, and as a result, spend less money. Fortunately, there are tools at your disposal to help determine an item's worth in about 20 seconds.

### 4.2.1 Investigate the Market

Any item on eBay is worth only what someone is willing to pay for it. Fortunately, for almost every item sold on eBay, an identical or similar item will have been sold within the last month or two. And given the public nature of eBay's past auctions, it's easy to find out the health of the current market for your item before you list it.

Start with a standard search (see Chapter 2), and locate any auctions for items similar to the one you're selling. Click "Completed items" in the Display box as shown in Figure 4-1, and then click "highest priced" to sort the listing by final price in descending order. Note that eBay's Completed Items search is a title-only search (descriptions of closed auctions aren't indexed), so you'll typically want to use simpler (broader) search queries than you'd use for active items.

**Figure 4-1.** A quick search through recently completed auctions, sorted by price, will give you a good idea of what your item is worth

Only the closing price of a successfully completed auction matters, so pay attention only to auctions that have received at least one bid. Even if the seller had a reserve that wasn't met (see [Hack #35]), the
Hack 34 To Bundle or Not to Bundle

A simple approach to choosing how and when to bundle your items for sale.

One of the most common mistakes sellers make on eBay is selling too many things together as a "lot." Sure, it's easier to list fewer auctions, but bundles are usually worth much less than the same items sold separately, and may even be less likely to sell.

One of my favorite eBay anecdotes involves a single auction for a large lot of model trains, for which I paid approximately $800. I then turned around and sold about half the collection, all told, for about $800. I estimated the value of the remaining items to be about $1000, all of which I effectively got for free. (This is similar, in concept, to arbitrage, but relies more on skill than on simply taking advantage of inefficiencies in the marketplace.)

Obviously, the original seller of the collection would've earned quite a bit more money had he listed each item separately. But how could he have known?

The most direct approach is to compare the expected value of a collection with the total expected values of the separate items, as described in [Hack #33]. But this can take a lot of time, and you'll be hard-pressed to find another auction with exactly the same items.

So instead, just ask yourself this question: How likely is it that any single bidder will want all of the items I'm selling?

Bidders who buy large collections or lots typically do so with the intention of reselling some or all of the items. Since they'd only do this if there were profit in it, it's unlikely that anyone would pay the full value of such a collection. However, if there's a good chance that a single person will want to keep all of the items you're selling, then you very well may get what they're worth.

Never bundle unrelated or incompatible items. For instance, say you'd like to sell two camera lenses, each for a different brand of camera. It should be obvious that they should be sold separately, but even experienced sellers sometimes try to sell odd things like these together. In this case, anyone who bids will likely be interested in only one of the lenses, and as a result won't bid higher than that single lens is worth.

Accessories can go either way. Sometimes, adding $50 worth of accessories to an item will increase the desirability of the item by at least that much, if not more. Other times, it won't make a lick of difference. Take, for example, a $300 handheld computer, sold along with a $40 memory card, $25 leather case, $10 screen protector, and $150 worth of software. Here, knowledge of the market will save you time researching the value of each item. Accessories like used leather cases (at least the cheaper ones), used screen protectors, and especially the software are all pretty much worthless when sold separately, but will probably raise the value of the handheld. Why? Because it is likely that any single bidder will actually want all of those things, and will pay more to avoid having to buy them separately. You might fetch a few more dollars for the memory card if it's sold separately, but it might also raise the value of the handheld by $25-$30. If you have several memory cards, include one with the handheld, and sell the rest separately.

Naturally, the market for your particular item will be different, but this should give you an idea of the methodology used to determine the practicality of bundling related items.

4.3.1 Leveraging Dutch Auctions

If you have a large quantity of an inexpensive item, you may be inclined to sell the entire lot in a single auction. But who is going to want 4,000 pairs of shoelaces, even if you do offer them all at the low, low price of only $200? Naturally, it also doesn't make sense to list them separately at 5 cents apiece, but there are other options.

Probably the best choice is a Dutch auction, but not necessarily the kind you might expect. The nature of a Dutch auction suggests that if you have 4,000 items, you enter a quantity of 4,000, wherein a single bid buys a single item. But then you'd be back where you started—handling up to 4,000 different customers at a nickel a piece.

Instead, try selling 400 bundles of 10 for $4.00 each. So a single bidder would be able to buy 10 pairs of shoelaces for $4.00, 20 pairs for $8.00, and so on. You'll have to build only one auction, you'll get eight times as much money per shoelace, and you'll be much more likely to get any money at all for your bizarre collection.
Hack 35 Reserve Judgment

Use a reserve-price auction for items with unknown value or limited appeal.

One of eBay's greatest strengths is the lengths to which its policies go to protect its millions of users, both buyers and sellers. One of the best known of these policies is the reserve price, which subsequently gets overused.

A reserve price is a dollar amount the seller specifies, below which he or she is under no obligation to sell. For example, you might want to sell a car for at least $15,000. But if you set the starting price at $15,000, you might not get as many bids as with a starting price of $100 (see [Hack #33]). A reserve effectively allows you to start the bidding at $100 while protecting yourself from the auction closing with too low of a bid. If a reserve is set at $15,000, and no bids exceeding that amount have been placed by the end of the auction, then neither the seller nor the high bidder is under any obligation to complete the transaction.

Bidding on a reserve-price auction proceeds just like a normal auction, with two exceptions. First, a notice stating whether or not the reserve price has been met is shown next to the current price at the top of the auction page. Second, if the reserve has not been met and a bidder enters a bid that exceeds the reserve, the current price is automatically raised to the reserve price.

The reserve is never made public, which is essential for it to work as intended. Keeping the reserve price secret allows the seller to decide whether to sell the item at the end of the auction at whatever price bidders have set.

The problem with a reserve price is that it can scare away bidders who feel that they have no chance of winning the auction, and as a result the final price will often be lower than if there were no reserve at all. For this reason, you should use a reserve price only under these circumstances:

- If you don't know the value of the item, a reserve still allows healthy bidding with minimal risk to the seller. However, in most cases you can determine the realistic market value of your item by using eBay's Completed Items search, as described in [Hack #33].
- For items of limited appeal for which you expect only one or two bidders, a reserve might help you get more money. For instance, consider an auction with a $1 starting bid and a $20 reserve, on which a single bidder enters a $25 proxy bid. Since eBay raises the current price to the reserve price when the reserve has been met or exceeded, the price will rise to $20. Without the reserve, the closing price would otherwise stay at $1. This approach might be useful if you're relisting an item that previously didn't sell with a high starting bid.
Hack 36 The Strategy of Listing Upgrades

Perform a simple cost/benefit analysis to determine which listing options to use.

An extra-cost listing upgrade pays for itself if it increases the auction's closing price by at least the cost of the upgrade. But no upgrade is a guarantee, and it can be difficult to predict which ones will be effective without first doing a little research.

For example, the Gallery option, which includes a tiny photo of your item in search results (shown in Figure 4-2), costs 25 cents. Presumably, a Gallery photo increases traffic to an auction, which can lead to more bids and a higher closing price. But it also takes time to prepare a proper Gallery image (see [Hack #64]), and while 25 cents doesn't sound like much, listing fees can add up fast. So, you may want to be selective with the Gallery and other listing upgrades you use.

Figure 4-2. The Gallery option is sometimes worth the cost and trouble if it ultimately raises the closing price

Table 4-1 lists the available listing upgrades, their costs, and recommended minimum prices for which they should be used. (Note that some of the fees are different for specialty items, such as autos and real estate.)

Table 4-1. Available extra-cost listing upgrades

<table>
<thead>
<tr>
<th>Listing Upgrade</th>
<th>Cost</th>
<th>Minimum price (recommended)</th>
<th>Affects search results</th>
<th>Affects listing page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 4-3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table 4-1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Hack 37 Putting Keywords in Your Auction

Hide keywords in your title and description to increase your exposure without violating eBay's keyword spamming rules.

The title is the single most important part of your auction, as it is the only basis for standard searches on eBay. You have 80 characters with which to simultaneously describe your item and include as many search keywords as possible, so don't waste them.

Say you're selling a camera, and you want to attract as many bidders as possible to your auction. The following approach should help you construct the best possible title.

Start by including the full manufacturer name, product name, and model number, like this:

Nikon F100

If you were to put only "Nikon" in the title, any searches for the model name ("F100" in this case) wouldn't bring up your item. Next, make sure to state what the item actually is:

Nikon F100 35mm Camera

One of the more common mistakes sellers make is not actually stating what the item is in the title or even the description. Think about it: without the word "camera" in the title, searches for "nikon camera" wouldn't bring up your item.

eBay goes to great lengths to help sellers describe their auctions. If you're not familiar with a certain category, check out eBay's seller's guide for the section. For instance, eBay's Art Seller's Guide (pages.ebay.com/artsellersguide) suggests that the word art is consistently one of the top five search terms.

Next, you'll want to compensate for common variations by including them right in the title:

Nikon F100 F-100 35mm Camera 35 mm

Note that I expanded out the model number to cover both "F100" and "F-100", as well as "35mm" and "35 mm" (with the space), all of which are different in eBay searches. Note, however, that I placed "35 mm" (with the space) after "camera", because I wanted to maintain the order of the words "35mm Camera" to accommodate phrase searches in quotes (see [Hack #9]). For the same reason, you wouldn't want to type something like "F100 Nikon".

Next, if the manufacturer is known by other names (or other spellings), include them as well:

Nikon F100 F-100 35mm Camera 35 mm Nikkor
Hack 38 Track Your Exposure

Make sure your listing is findable before it's too late.

You have at your disposal all the tools available to your bidders, which means that you should be able to locate your auctions in only a few seconds. If you can't, neither can they.

Furthermore, listing upgrades like Bold, Highlight, and Featured Plus (see [Hack #36]) can double or triple the cost of listing an auction on eBay, but until you can see the effect, it's hard to determine if your money has been well spent.

Start by doing a quick search, not only for the specific keywords in your title but for anything that your customers might type to find items like yours. If your item doesn't appear when it should, take a moment to add any necessary keywords (see [Hack #37]).

4.7.1 Where Is an Item?

eBay provides another handy tool, specifically used to locate a single item in eBay's various category listings. Go to Site Map → Where Is an Item, and enter the item number of the auction you wish to track.

Figure 4-5 shows the results, which list the category and the page number on which the item currently appears, as well as the results for the Ending Today, New Today, and Going, Going, Gone listings, if applicable.

Figure 4-5. Use the "Where is an item" tool to see where your item is listed
Hack 39 Expectation Management

A few carefully chosen words in your auction descriptions will help avoid unhappy buyers, returns, and negative feedback.

"If you lend someone $20 and never see that person again, it was probably worth it."

Most sellers would agree that an eBay transaction can be considered successful if the bidder pays promptly, leaves positive feedback, and then disappears. Naturally, this happens when the bidder is happy. Unhappy bidders, on the other hand, have complaints, want refunds, leave nasty feedback, and, all told, make themselves a general pain in the neck.

When a bidder is displeased, it's usually because of a failure by the seller long before the customer even places a bid on the item. It's the seller's job to describe the item so that the eventual buyer will be pleased with it, even if it means pointing out its flaws.

Think about it: every time you're happy or unhappy with a transaction, it's because the experience either met or failed to meet your expectations. The higher the expectations, the harder it is to meet them. The key is to strike a balance between making your product look good and setting reasonable expectations.

Consider the following when writing your auction description:

- If you would like to categorize an item as "like new," say it's in "mint condition" instead. The phrase "like new" means "indistinguishable from brand new." No matter how good it looks to you, the person who's just laid down $1,500 of their hard-earned money will expect more than you'll probably be able to deliver.

- If the item has been used, say so; don't expect your bidders to realize this simply by scrutinizing your blurry photos or noticing that you set a low starting bid.

- Mention all flaws, regardless of how insignificant. Whether or not the flaws are important is beside the point. Rather, it's the blunt honesty that will win the trust of your bidders, and ultimately get you more money for your items (and happier bidders to boot).

- If you're selling something belonging to someone else, say so. Otherwise, your bidders will expect you to have full knowledge of its history and will hold you accountable for any flaws you don't specifically mention up front. Anything you know about the item's history (such as previous owners, repairs, or accidents) should be mentioned in the description, along with the current

Although it may sound trite, honesty is indeed the best policy. By selling on eBay, you are joining a community. By dealing fairly and honestly, you will build a good reputation, attract more bidders, and contribute positively to that community. This will, in turn, improve your reputation and attract more bidders. Plus, you'll make lots of cash.
Hack 40 Formatting the Description with HTML

Use HTML tags to turn a drab block of text into an interesting, attractive, and effective sales tool.

As a seller on eBay, you're expected to wear a lot of hats: diplomat, market researcher, salesperson, and yes, even web designer. Since eBay auctions are web pages, your description area can be decorated with the same fonts, colors, images, links, and tables found on any other web site.

If you're already familiar with HTML, you'll probably want to skip this primer and just use it as a quick-reference. The rest of the hacks in this chapter contain more meaty HTML code.

4.9.1 Rapid HTML Primer

For many sellers, the introduction to HTML comes in the disappointment of seeing a carefully formatted description seemingly mutilated by eBay. For example, this text:

Antique steam shovel toy:
real working treads
working shovel, turn crank to raise
glossy red lacquer

in immaculate condition!

will look like this when viewed on an eBay auction page:
Antique steam shovel toy: real working treads working shovel, turn crank to raise glossy red lacquer in immaculate condition!

The fault lies not with eBay, but with the way web browsers interpret plain text. All spacing, alignment, and line breaks are effectively ignored in favor of the HTML code that is the basis of formatting in all web pages.

HyperText Markup Language (HTML) consists of plain text interspersed with markup tags. A tag is a special formatting keyword enclosed in pointy brackets (also known as carets and greater-than and less-than symbols). For instance, simply place the<br> tag in your text to insert a line break, or <p> to insert a paragraph break. For example:
real working treads<br>working shovel, turn crank to raise<br>glossy red lacquer

Tags that modify text actually require two parts: a tag to turn the formatting on and another to turn it off. For example, the <center> tag, used to center-justify text and images, requires a corresponding </center> tag later on to restore the default left justification. Other tags that work like this include<br>b</b>, <i>italics</i>, and the <table></table> structure, all described in the next sections.
Hack 41 Customize Auction Page Backgrounds

Make your item stand out with a little personalization of the auction page using JavaScript.

Although the description area occupies only a portion of the auction page, it's possible to include code with the ability to reach out and affect the entire page.

Why would you want to do this? Well, as the theory goes, a more distinct auction will get more attention from bidders. However, anyone who looks at your auction has already given you their attention, so the effect will not be earth-shattering. Still, a little tweaking may make your auction look nicer, or at least let you express your own personal style and have a little fun with your auctions.

Never build an auction such that it will be rendered inoperable if a bidder has disabled JavaScript support in his or her browser. For instance, if you place white text on a dark background but the background remains white due to the JavaScript code not working, then all you'll have is white text on a white background and a very frustrated bidder.

This code, when placed anywhere in your auction description, will change your auction's background color:

```html
<script language=javascript><!--
document.bgColor='blue';
--></script>
```

Valid colors include aqua, black, blue, fuchsia, green, gray, lime, maroon, navy, olive, purple, red, silver, teal, white, and yellow. For more control, you may wish to use RGB (red-green-blue) color coding instead, like this:

```html
document.bgColor='#C5D0EE';
```

The six-digit color code (here, C5D0EE) is comprised of three pairs of hexadecimal numbers, ranging from 00 (zero, no color) to FF (256, full color). Each pair represents the amounts of red, green, and blue to be used, respectively. For instance, #FF0000 is solid red (no green or blue components), and #FF00FF is purple (red and blue, but no green). Likewise, #000000 represents solid black and #FFFFFF represents solid white.

Convenient color tables can be found at [www.utexas.edu/learn/html/colors.html](http://www.utexas.edu/learn/html/colors.html). If you have Adobe Photoshop, you can mix colors in the Photoshop color picker, and the corresponding hex code will appear right next to the red, green, and blue values.
Hack 42 Framing Your Auctions

Use tables and carefully aligned images to place decorative frames around your auction descriptions.

A little extra decoration will give your customers that warm, fuzzy feeling they need to open their wallets and bid a little higher, or so the theory goes. At the very least, frames may help your auctions look a little more polished and inviting.

For a fee, eBay's Listing Designer will do this for you. But unless you want to look like a mindless automaton by using someone else's predesigned templates right out of the box, you'll want to take a few minutes to design your own.

4.11.1 The Table

It all starts with a single table, which positions the frame across the top, bottom, and sides, holding your content snugly inside. While you're designing the table, turn on the border so you can see more clearly what's going on.

```
<table style="width:100%" cellpadding=0 cellspacing=0 border=1>
<tr>
  <td width=25>top-left</td>
  <td>top-middle</td>
  <td width=25>top-right</td>
</tr>
<tr>
  <td width=25>left side</td>
  <td>
    Your content goes here...
  </td>
  <td width=25>right side</td>
</tr>
<tr>
  <td width=25>bottom-left</td>
  <td width=25>bottom-middle</td>
  <td width=25>bottom-right</td>
</tr>
</table>
```

The resulting table shown in Figure 4-6 is our placeholder for the eventual design. Note the width=25 parameters in the left-hand and right-hand columns, which can be changed to accommodate whatever images are eventually placed inside.
Hack 43 Overriding eBay's Fonts and Styles

Use Cascading Style Sheets to change the look of more than just the description.

The <font> tag, introduced in [Hack #40], allows you to set the font for any block of text. But it won't have any effect on text outside the <font></font> structure, which means you can never control the appearance of any text outside the description area (e.g., the rest of the auction page). Instead, you'll have to use Cascading Style Sheets (CSS) if you want to apply your styles to the entire page.

The following code, for instance, will turn all text on the page green:

```html
<style> [1]
BODY,FONT,TD,A { [2]
  font-size: 10pt !important;
  font-family: Verdana,Arial,Helvetica !important;
  color: green !important; [3]
}
</style>
```

Here's how it works. First, the <style> </style> structure [1] sets apart our CSS definitions, which will take effect regardless of where the code is placed on the page. Next, a single CSS definition [2] lists the HTML tags to modify with our new styles. In this case, we are applying our styles to all <body> text, as well as to any text inside <font></font> tags, <td></td> tags (used for tables), and <a></a> tags (used for links). If you don't want to modify link colors, for instance, just remove ,A from line [2].

The actual styles applied are listed between the curly braces { }, separated one per line for clarity. This includes the font size, the typeface, and, of course, our glorious green color [3]. The !important keywords ensure that our styles override any other styles defined elsewhere in the page, which is why even the section headers and the light gray text in the "Time left" section are overpowered by our choice.

If you feel that making all text the same color is a little drastic, you can customize it further:

```html
<style>
BODY,FONT,TD { [2]
  font-family: Verdana,Arial,Helvetica !important;
  color: blue !important;
}
A { [3]
  font-family: Verdana,Arial,Helvetica !important;
  color: orange !important;
}
</style>
```

This sets all ordinary text blue, except for links, which will appear orange (this will look pretty awful, by the way). Note the absence of font-size style, which will ensure that the original size of all text is preserved.

For a complete list of all the CSS styles you can use, you'll need dedicated CSS documentation such as Cascading Style Sheets: The Definitive Guide (O'Reilly), or the official W3C CSS specification (www.w3.org/Style/CSS/).

You can also use this technique to alter other aspects of the page. Don't like the blue shading section headers? Well, you can do something like this:

```html
<style>
TD { background-color: white !important; }
</style>
```

This may find this particular solution somewhat extreme, since it removes the shading used in every table on the page. But it will give you a taste of the power of CSS.

See [Hack #41] for further auction-page hacking.

4.12.1 Override Other Sellers' Hacks

You'll eventually encounter an auction that has been hacked up pretty well, possibly by a seller with even worse taste than you. Fortunately, you may still have some control over the pages you view with your own browser.

Have you ever opened a page with a text/background combination that rendered the page nearly impossible to read? Here's a quick fix: just press Ctrl-A to highlight all text on the page. This will make all text appear white on a dark blue background, which will likely be a significant improvement.

You can set your browser preferences to favor your own color choices over those made by web site designers, but this can be a pain to turn on and off as needed. Instead, you may wish to set up a user stylesheet, a set of carefully constructed preferences and rules that will trump any crazy code like the stuff at the beginning of this hack. User stylesheets are supported by Netscape 6.x/Mozilla 1.x and later, and Internet Explorer 5.x and later.

4.12.2 See Also

Probably the best source for information about user stylesheets is Eric Meyer's "CSS Anarchist's Cookbook" at www.oreillynet.com/pub/a/network/2000/07/21/magazine/css_anarchist.html. There, you'll find ways to "wreck" tables, disable banner ads, and render font coding pretty much useless, all worthwhile pursuits for the anarchist in each of us.
Hack 44 Annoy Them with Sound

Drive away your bidders by putting background music and sound effects in your auctions.

Although I despise sound in web pages, I feel compelled to show you how to do it properly so you don’t pick up any bad habits on the street.

The number-one rule to remember when including sound or music in web pages is to provide a means of turning it off. Otherwise, your bidders will eventually discover the workaround by themselves . . . and they probably won’t come back.

4.13.1 Some Call It Elevator Music

You can insert background music (in either .wav or .midi format) into your auction with this line of code:

```html
<bgsound src="http://www.ebayhacks.com/files/aah.wav" loop=1>
```

where the loop parameter specifies the number of times to play the sound. The problem is that the `<bgsound>` element has no controls: no way for your customers to turn off the sound or adjust the volume. In other words, a poor choice.

The more general-purpose `<embed>` tag can do everything `<bgsound>` does, but it also includes a controller box:

```html
<embed src="http://www.ebayhacks.com/files/aah.wav" hidden=false autostart=true loop=true />
```

The `loop=true` parameter can be replaced with `playcount=3` to play the sound a specified number of times and then stop. Go to [www.htmlcodetutorial.com](http://www.htmlcodetutorial.com) for further documentation on embedded objects.

4.13.2 When to Use Sound

Sound can be useful when text and photos just won’t do. For example, if you’re selling a music box, you may want to include a clip of the music it plays, especially if you don’t know the name of the song. Or, if you’re selling a product that modifies sound (such as a car exhaust silencer), your customers will appreciate being able to hear, first-hand, what it sounds like with — and without — your product. And obviously, if you’re selling music on CD, tape, record, or DVD, you may want to include a short clip to entice your bidders.

Even given these perfectly legitimate uses for sound in your auctions, it still makes sense to give your customers the option of turning it off.
Hack 45 Put a Shipping Cost Calculator in Your Auction

Use an HTML form and a little JavaScript to provide accurate shipping costs to your customers on the fly.

One of the advantages of understanding HTML is the ability to add functionality to your auction descriptions without having to rely on extra-cost services or — gasp — the intelligence of your bidders.

A shipping cost calculator, placed right in your auction description, will allow you to avoid setting a single, fixed shipping cost (which can scare away frugal bidders), and still avoid the burden of having to quote shipping costs to everyone who asks.

Probably the easiest way to provide self-service shipping cost information is to include your zip code and the weight of your item right in your auction description. Your bidders can then punch that information and their own zip code into a courier web site, such as ups.com or fedex.com, and get an accurate cost to ship, as well as any available shipping options (insurance, overnight, etc.). The problem is that it's easy for the bidder to make a mistake or choose the wrong shipping options, which can cause all sorts of problems.

Fortunately, there are many more streamlined solutions, ranging from services provided by eBay to custom HTML-based calculators.

4.14.1 eBay's Calculated Shipping

eBay offers sellers its own shipping calculator, a feature introduced in the middle of 2003. When listing your item, just choose the "calculated shipping" option. Specify your zip code, the weight and dimensions of your item, and a single shipping method, and eBay will allow your bidders to determine shipping costs on their own.

The calculated shipping feature, however, is rather limited. First, it uses software provided by Connect Ship, a UPS company, so only UPS and U.S. Postal Service rates are supported. Second, it works only for buyers and sellers in the continental United States. Finally, sellers can choose only a single shipping method when listing the item, so bidders will have no choice when using the tool (which can be good or bad, depending on your perspective).

The biggest advantage to Calculated Shipping is probably also its biggest drawback. For the bidder's and seller's convenience, the calculated shipping cost is automatically inserted into the bidder's invoice, which means that it will be used when the bidder completes the Checkout procedure. This means that
Hack 46 Allow Visitors to Search Through Your Auctions

Put an HTML search form in your auction description to make it easier for your customers to find other items you're selling.

The "View seller's other items" link on auction pages leaves a lot to be desired. Lacking the flexibility of standard search results or category listings, it simply lists your other running auctions with no convenient way for bidders to search through the titles, and no way at all for bidders to search your descriptions.[3] Since you'll get more money for items that are easier to find, a seller search box right in your description will help advertise your other auctions. Figure 4-10 shows a custom search-by-seller box preconfigured to show only your auctions.

[3] See [Hack #12] for a few tricks for bidders using this page. Sellers can also open an eBay Store [Hack #72] to add some functionality to their lists of running auctions at an added cost.

Figure 4-10. A search-by-seller box in your auctions helps promote your other items

To put this box in your auction, simply place the following code somewhere in your auction description:

```
<table cellpadding=0 cellspacing=0 border=0 width=150><tr>
  <td bgcolor="#ffcc00" rowspan=2 width=1%>
    <img src="http://pics.ebay.com/aw/pics/s.gif" width=2></td>
  <td height=2 bgcolor="#ffcc00" valign=top width=98%>
    <img src="http://pics.ebay.com/aw/pics/s.gif"></td>
  <td background="http://pics.ebay.com/aw/pics/listings/sliver_1x22.gif"
      rowspan=2 valign=top align=right width=1%>
    <img src="http://pics.ebay.com/aw/pics/listings/yellcurve_22x20.gif"
      width=22 height=21 align=top></td></tr>
<tr><td colspan=3 bgcolor="#ffcc00" width=1%>
  <font size=2 face="arial, helvetica, sans-serif">
    Search This Seller</font></td></tr></table>
```
Hack 47 List Your Other Auctions in the Description

Capitalize on a single auction’s popularity by using it to promote your other items.

As suggested in [Hack #46], it’s beneficial to make your other running auctions as accessible as possible so that your bidders will be more inclined to purchase multiple items from you.

The first thing you'll want to do is tell your customers that they can save money (in the form of shipping expenses) by purchasing multiple items from you at the same time. Probably the simplest and most effective way to do this is to place the following HTML code in your auction descriptions:

```html
<a href="http://cgi6.ebay.com/ws/eBayISAPI.dll?ViewSellersOtherItems&userid=my_user_id">Check out my other auctions</a> - bid on multiple items and save on shipping!
```

This link is effectively no different from the "View seller's other items" link that eBay provides, except that your message suggests to customers that they have something to gain by clicking through. And since you customize the link, you also have the advantage of being able to pre-sort the listing and even show more auctions on a single page; see [Hack #12] for details.

### 4.16.1 Specific Product Links

The next step up is to actually link to specific auctions in your description. This is most useful if you're selling an item and a bunch of related accessories separately. For example, an auction for a PDA might contain this HTML code:

```html
Note that I'm also selling a genuine leather case for this PDA <a href="http://cgi.ebay.com/ws/eBayISAPI.dll?ViewItem&item=3116521524">here</a> and a travel charger <a href="http://cgi.ebay.com/ws/eBayISAPI.dll?ViewItem&item=3116521523">here</a>. Bid on multiple items and save on shipping!
```

Then, in the auction description for the aforementioned travel charger, you might include something like this:

```html
Note that I'm also selling the PDA that uses this charger <a href="http://cgi.ebay.com/ws/eBayISAPI.dll?ViewItem&item=3113167823">here</a>. Bid on multiple items and save on shipping!
```

The resulting links, shown in Figure 4-11, are much more convenient and conspicuous than the simple list of auctions hidden behind the "View seller's other items" link. Your bidders will be able to quickly flip between your related auctions, and you'll probably get more bids as a result.

Figure 4-11. Place links to related auctions right in your auction descriptions to increase the likelihood that buyers will purchase multiple items from you.
Hack 48 Make Good Use of the About Me Page

Set up a static page on eBay for all the stuff that would otherwise clutter up your auction pages.

Many sellers make the mistake of including pages and pages of payment and shipping terms, only to supplement it with a single sentence about the item itself. No wonder bidders never read descriptions!

I hate clutter, whether it's on one of my own auctions or someone else's. I like to reserve the space in my auction descriptions for information about the item being sold, mostly because bidders have a limited attention span, and I, as a seller, have a limited amount of time to prepare my auctions.

eBay allows any user to build a static page right on the eBay web site — separate from their auctions — with whatever content he or she wants to make public. Although anyone can put together an About Me page by going to Site Map ➔ About Me, it's sellers who will benefit most from this feature.

Since the About Me page is separate from auctions, its content can be modified at any time, even after your auctions have received bids. See [Hack #50] and [Hack #51] for more information.

Although you can maintain your own web page on any off-eBay site, there are significant advantages to using the About Me feature. For one, the information on the page will appear more trustworthy to your bidders because it looks like part of the eBay site, complete with the eBay logo and menu bar. Second, a link to your About Me page will appear next to your user ID whenever your ID appears on eBay. And finally, you'll be able to insert dynamic, eBay-specific content in your page, as follows.

4.17.1 Just Say No to Templates

When you use the About Me feature for the first time, eBay presents a selection of different templates that you can choose from to frame your page. The next step involves filling in about a dozen fields with your personalized information (see Figure 4-13), such as a title, welcome message, something called "another paragraph," and some of your favorite links. You can also choose to display recent feedback and a list of your items for sale, right on the page.

Figure 4-13. The About Me setup page is the first thing you see when you build an About Me page, but it doesn't afford the flexibility of the optional HTML editor interface
Keep the personal touch in your transactions by disabling eBay's controversial Checkout feature.

The direct communication between buyers and sellers is one of the main reasons that eBay works as well as it does, and one of the things that makes eBay fun. In 2001, eBay took an unfortunate step toward circumventing that communication by introducing the Checkout feature, which angered and alienated (at least temporarily) many of its most loyal users.

But the biggest problem with Checkout is that it allows the winning bidder to complete the transaction without having to wait for the seller to send payment instructions. For example, a bidder in another country can pay for an auction for which the seller has specified a fixed shipping charge intended only for domestic shipments. The result is a frustrated seller and a confused bidder, not to mention a transaction that has to be redone.

Sellers should think twice before including their postal address in their auctions. In addition to privacy concerns, this would allow buyers to mail their payments without any input from sellers. This is especially troublesome because a payment sent via postal mail is much more difficult to rescind than an electronic payment like PayPal. And bidders who have to resend payments typically blame sellers for the hassle.

Initially, the Checkout feature was designed to funnel more users into eBay's now-defunct BillPoint auction payment system (and away from its rival, PayPal), as it allowed bidders to choose BillPoint as a payment option whether or not the seller was willing to accept BillPoint payments. Almost overnight, eBay had thousands of angry sellers threatening to leave eBay.

Well, it seems that fate is not without a sense of irony. Within six months, BillPoint was history, and eBay had acquired PayPal. But the Checkout problem remains, now simply funnelling bidders into PayPal instead (albeit only if the seller has chosen to accept PayPal).

Figure 4-14 shows what your customers see at the top of completed item pages when the Checkout feature is in full force.
Hack 50 Make Changes to Running Auctions

Keep your auctions looking and performing their best with post-listing revisions.

We all misspell words from time to time, but where auction titles and descriptions are concerned, innocent typos can adversely affect sales. eBay allows you to modify your auctions once they’ve been started, but certain revisions may not be allowed, depending on when you submit them and whether the item has received any bids.

For example, eBay understandably doesn’t let you change the description once someone has bid on your auction, but you can add to the description. Any supplemental text and photos are placed at the end of the description, accompanied by a date and timestamp, making it clear to your bidders exactly what you added and when. Additionally, since eBay doesn't allow bidders to retract their bids within the last 12 hours of an auction (see [Hack #27]), further revisions normally available to sellers are prohibited during that time. Table 4-4 shows possible revisions to a running auction; a checkmark indicates when each revision is allowed.

[4] Note that canceling bids, as described in [Hack #54], will not restore your ability to make changes to the auction description.

Table 4-4. When aspects of an auction can be changed

<table>
<thead>
<tr>
<th>Revision</th>
<th>Before 1st bid</th>
<th>After 1st bid</th>
<th>Last 12 Hours</th>
<th>Completed Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>✔️</td>
<td>✔️ (nonrefundable if removed)</td>
<td>✔️ (nonrefundable if removed)</td>
<td></td>
</tr>
<tr>
<td>Buy-It-Now</td>
<td>✔️</td>
<td>vehicles with a reserve price only</td>
<td>only using second-chance offer</td>
<td></td>
</tr>
<tr>
<td>Calculated shipping</td>
<td>✔️</td>
<td></td>
<td></td>
<td>change in invoice only</td>
</tr>
<tr>
<td>Cancel bids</td>
<td></td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Hack 51 Dynamic Text in Auction Descriptions

# Hack 51

Use inline frames to change the text in your auction descriptions, even after bids have been placed.

Once bids have been placed on an auction, eBay severely restricts the changes that the seller is allowed to make (see [Hack #50] for details). Probably the most prevalent restriction is the auction description itself, which can only be added to once the auction has received its first bid. Fortunately, you can use iframes (inline frames) to work around this.

Any text not hardcoded into your auction description will not be indexed by eBay Search, so you'll want to restrict dynamic text to material not specific to the item being sold (such as payment terms or information about your company).

An inline frame is like a web page within a web page. To try it, place the following code right in your auction description:

```
<iframe src="http://www.ebayhacks.com/myiframe.html"
    style="width:350;height=200;" align=left>
<a href="http://www.ebayhacks.com/myiframe.html" target=_blank>Click here</a> to view additional information about this auction.
</iframe>
```

The web page designated by the src parameter in the `<iframe>` tag will load in a window 350 pixels wide and 200 pixels high, as shown in Figure 4-18.

**Figure 4-18. Use an inline frame to place an external web page in your auction description that can be changed, even after the auction receives bids**
Hack 52 Let's Make a Deal

How to handle impatient bidders without losing customers and without getting kicked off eBay.

From time to time, bidders will contact you with special requests, such as those suggested in [Hack #26] and [Hack #27]. How you respond to such requests and how you decide to conduct business is entirely up to you, but you'll want to be careful about some of the steps you take. As a seller on eBay, you'll have to walk a fine line between protecting yourself from dishonest bidders, not upsetting your honest bidders, not violating eBay policy, and not wasting large amounts of your time.

See who you're dealing with by taking a moment to look at their feedback and investigate their history, a process explained in [Hack #53]. That way, you'll know whether you should trust the bidder or add the bidder to your Blocked Bidder list (see [Hack #54]).

For instance, an impatient bidder might want to use Buy-It-Now on one of your auctions, even though the item has received bids and the option has disappeared from the page. The following are a few different approaches to dealing with this type of request, each with its own advantages and disadvantages:

- Assuming you know the value of your item (see [Hack #33]), you should be able to look at the current bids — as well as the relative success of your competition — and predict how much you're ultimately going to get for your item. Your auction may indeed be on track to fetch a higher amount than your original Buy-It-Now price, in which case you'll want to politely tell the bidder that you prefer to let the auction run its course. Naturally, you'll run the risk of not getting as much as the bidder is offering, or, at the very least, driving the bidder away by making him wait.

- If you cancel all bids on an auction, the Buy-It-Now price will reappear, and the bidder in question can buy the item. Unfortunately, this approach is not without risks. First, you'll need to get the timing right; if the bidder isn't quick enough, someone else may place a bid and the Buy-It-Now price will once again disappear. But what's worse is the possible flight risk; if the bidder doesn't end up using Buy-It-Now, you've essentially canceled a bunch of honest bids on your item for no reason.

- You can also make an under-the-table deal with the bidder, agreeing to end the auction early for a certain dollar amount. But this, too, is fraught with peril. First, eBay may consider this to be a violation of their "fee avoidance" policy, and as a result may suspend your account. Second, since it is an off-eBay transaction, it won't be covered by eBay's fraud protection policies, and as a result you may lose the item.

- Probably the safest approach is to create a second listing, identical to the first. When it's ready, send the URL to the bidder and instruct him or her to use the Buy-It-Now option promptly (before anyone else bids). Only when that auction has closed successfully should you cancel bids on the original auction and end it early. This way, you and the bidder can complete the transaction officially and enjoy the protection of eBay's buying and selling policies. And if the bidder backs out, you can simply end the superfluous listing or modify it to accommodate a different item.

Although the preceding example is the most common request of this sort, it's not the only one you'll receive. Bidders often contact sellers to ask for alternative colors, versions, etc., as well as related items and accessories, and a cooperative seller can stand to make quite a bit of extra money. Just be careful about how much you reach out to bidders.

If you're selling shoes, for example, it's generally acceptable to mention that you have other sizes and colors, either in other auctions (see [Hack #47]) or for sale in your online store. But this is different from posting a "dummy" auction whose purpose is to simply direct customers to your off-eBay store. Bidders won't buy it, and eBay won't tolerate it.
Hack 53 Diplomacy 101: Answering Dumb Questions

Good and bad ways to handle communications with seemingly lazy or dim-witted bidders.

No matter what you do, you'll never get all your bidders to read your auction descriptions, shipping terms, or payment instructions as carefully as you'd like them to, if at all. As a result, you'll occasionally get a bidder who looks at an auction entitled "Antique Royal-Blue Vase," sees the large photo of a royal-blue vase, and then writes you to ask what color the vase is.

OK, it's not usually that bad, but sometimes it seems like it is. The first thing to remember is how easy it is to miss even the most obvious piece of information. Instead of antagonizing your bidder with the all-too-familiar, "It's blue, like it says in the description," try one of the following:

- "The vase is a deep royal blue that almost looks purple in low light. The glaze seems a little darker at the bottom." Not only does this answer the bidder's question respectfully, it presumes that the bidder was looking for more information than simply, "it's blue."

- "The vase is royal blue. The photo in the auction actually has a pretty good reproduction of the color, so please let me know if it doesn't come through." This not only (kindly) reminds the bidder that there is a photo, but it helps inspire trust that the photo is accurate, a fact the bidder may not have wanted to take for granted. It also suggests a legitimate reason for the bidder asking the question in the first place; namely, that the photo might not have loaded properly on the bidder's computer.

Instead of driving your bidders away, you'll be sending them the message, so to speak, that a transaction with you will be a pleasant one, that you're trustworthy, and that your item is as you've described it. See [Hack #20] for some of the tactics that your bidders might be using.

It may seem like a no-brainer, but when replying to a bidder's question it's important to use your email program's Reply feature so that the original message appears at the bottom of your response. This way, the bidder doesn't receive an email that simply says "Yes," with no further clue as to what question you're answering. Strangely, this simple bit of "netiquette" is basically ignored by even the most experienced sellers — don't be one of them.

Next, remember that for every bidder who writes you with a question, there will be 10 potential bidders who don't bother. Either they bid without asking, only to be disappointed later, or they move on and bid on someone else's auction instead. For this reason, it's best to be a little proactive. If a bidder asks a
Hack 54 Keeping Out Deadbeat Bidders

A little diplomacy will help keep out deadbeats and still allow healthy bidding on your auction.

"Good judgment comes from bad experience, and a lot of that comes from bad judgment."

One of the most frustrating aspects of selling on eBay is dealing with winning bidders who don't pay. Not only are non-paying bidders a waste of the seller's time and money, they end up ruining honest bidders' chances of winning the auction.

You can always tell a seller has been recently burned by a deadbeat from the harsh warnings in their auction descriptions:

- "Don't bid if you don't intend to pay!"
- "Serious bidders only."
- "If you have zero feedback, email before bidding or your bid will be canceled!"
- "A non-paying bidder will receive negative feedback, lots of threatening email, and a note to your mother."

The problem with all of these is that they typically do more harm than good. For example, you should never tell visitors not to bid on your item, regardless of your intentions. The tone is angry and threatening, and sends a message (even to honest bidders) that dealing with you will likely be a less than pleasant experience. Besides, your average deadbeat bidder probably won't read your description anyway.

Instead, start by thinking about why someone may not pay after winning an auction, and then find a diplomatic way to weed out such bidders.

In most cases, it will be new eBay users — with a feedback rating of less than 10 or so — who end up bidding and not paying, a fact due largely to their inexperience rather than any kind of malice. For instance, new bidders will often wait until after they've bid to read the auction description and payment terms (if they read them at all). Or, a bidder might bid and later discover that he or she no longer needs or wants your item. And since inexperienced eBay users typically don't know how to retract bids or communicate with sellers, nor do they understand that they can simply resell something they don't want, they simply disappear, hoping that the problem will go away if they ignore a seller's emails.
Chapter 5. Working with Photos

- Section 5.1. Hacks #55-64
- Hack 55. How to Keep Your Item from Looking Pathetic
- Hack 56. Mastering Close-Up Photography
- Hack 57. Doctoring Photos
- Hack 58. Protect Your Copyright
- Hack 59. Host Your Own Photos
- Hack 60. Make Clickable Thumbnails
- Hack 61. Construct an Interactive Photo Album
- Hack 62. Show a 360-Degree View of Your Item
- Hack 63. Create a Photo Collage
- Hack 64. Create a Good Gallery Photo
5.1 Hacks #55-64

There are no two ways about it: a photo can make or break an auction.

Attractive, clear, well-composed photos will excite your customers and get you more money for your items. Poor photos, however, will make your item — and therefore your auction — less desirable. And having no photo is tantamount to auction suicide. None of this should surprise you. But there's a lot to think about when it comes to taking photos, transferring them to your computer, preparing the files, and putting them in your auctions.

See [Hack #55] and [Hack #56] for tips on taking good auction photos.

5.1.1 Getting Photos into Your Computer

Probably the biggest hurdle that most sellers face is getting photos into their computers. In most cases, this involves an investment, not only of money for equipment, but of time taking photos and preparing them properly. If you do it right, though, the investment will more than pay for itself in a very short time.

The first step involves taking the photos, as explained in [Hack #55]. Naturally, this requires a camera, and in this department you have several options:

Digital camera

Easily the best choice for taking auction photos, a digital camera allows you to see your results immediately and get your photos online quickly.

Better digital cameras have better optics and take higher-resolution photos (more megapixels); the one you choose depends on your budget and your needs. But since the largest auction photos are typically no bigger than 800 x 600, which translates to only about 0.5 megapixels, the camera's resolution will not be that important. If you're shopping for a camera specifically for shooting auction photos, look for one with a good macro (close-up) lens.

All digital cameras come with cables for transferring images to your computer. Often, however, a digital film reader will be quicker and more convenient. Look for a USB-based memory card reader that accepts all major memory card formats, including CompactFlash, SecureDigital, Memory Stick, Memory Stick Pro, SmartMedia, and xD Picture cards.

If a digital camera seems expensive, consider that the extra money you'll get for your items by having good photos will more than pay for a digital camera (which you can buy used on eBay!).

Video-conferencing camera
Hack 55 How to Keep Your Item from Looking Pathetic

A simple approach to taking great photos of your items.

Simply put, good photos will get you more bids and more money. An attractive, clear, well-composed photo will excite customers and inspire trust in your bidders that you're selling what you say you're selling.

On the other hand, if your photos are blurry, poorly lit, too small, or too cluttered with junk, your bidders will not be nearly as impressed. Not surprisingly, bad photos will make your item look pathetic, and as a result your auction will get fewer bids and less money (if it sells at all).

5.2.1 Composition

Start with a neutral background, like an empty table or section of the floor. A little texture (like wood or fabric) can be nice, but don't overdo it. Avoid carpet, which can make your item look dirty and shabby. And nobody is going to want something that is seen sitting in the dirt.

A shiny, reflective base, like a mirror or the top of a silver file cabinet, will make smaller items look like they're in a professional showroom. A close-up shot with only a little depth of field, as explained in [Hack #56], will throw any unwanted background reflections out of focus.

Your item will be lost in the photo if it's in front of a busy pattern or other high-contrast background. Remove all unnecessary clutter from the photo; it should be crystal-clear to your customers exactly what they're bidding on.

Shoot from an angle to illustrate that you're selling a three-dimensional object. An object photographed slightly askew will look much better than if it's perfectly centered and aligned with the edges of the photo. Figure 5-1 shows the same object shot at two different angles, one of which looks much better than the other.

Figure 5-1. Photograph your items from an angle to make them look more attractive
Hack 56 Mastering Close-Up Photography

Control the depth of field to get a perfect close-up every time.

Nothing helps more than close-up photos to compensate for the fact that bidders can’t see your item in person. A good close-up photo will show detail (a really good close-up will show the texture of the paint), and will also allow you to adequately explain any flaws or damage. Different ways of shooting close-up photos will yield different results.

Understanding depth of field is the key to shooting good close-ups. Depth of field is the distance between the closest object in focus and the furthest object in focus, as illustrated in Figure 5-4.

Figure 5-4. Depth of field is the width of the plane in which your subject will be in focus

Several things affect the depth of field:

- **Distance from the object**

The further the distance between the camera and the object, the closer your lens will be focused to infinity, and the wider the depth of field will become. Bring the camera closer to the object to narrow the depth of field.
Hack 57 Doctoring Photos

Techniques and tools for fixing up your photos after they've been taken.

There's more to image preparation than simple crops and rotations. When presentation really matters, you may want to take a few extra minutes to make your auction photos look perfect.

Be careful not to doctor the photo so much that it misrepresents the item being sold. Try to strike a balance between making your photos look professional and setting a reasonable expectation with your bidders; see [Hack #39] for details.

The following tools are available in most of the more capable image editors, but their names and usage may vary slightly:

*Clone Tool*

Use the clone tool to copy one part of an image to another part, useful for removing dust and unwanted reflections.

Start by choosing an area to clone. In Photoshop, click while holding the Alt key. In Paint Shop Pro, click while holding Shift. Then, start drawing on a different part of the image. The horizontal and vertical distance will be held constant, so if you move a half-inch to the left, you'll be cloning the area a half-inch to the left of the spot you originally selected. **Figure 5-6** shows an image doctored with the clone tool.

**Figure 5-6. Use the clone tool to touch up small areas of your images; here, the table edge and a few scratches were removed with cloning**

*Skew, Distort, and Perspective Tools*

Photoshop supports a variety of linear distortion tools, useful for fine-tuning the perspective of your item. Start by selecting a portion of your image (or the entire image), and then go to Edit ➔ Transform ➔ Perspective. Drag any of the eight handles with your mouse to distort the selection, and click any tool in the toolbox to commit (or reject) the change. The Skew and Distort tools work the same way, but the distortions they permit vary slightly.
Hack 58 Protect Your Copyright

Prevent other sellers from stealing your photos.

Taking a good-quality photo of each and every item being sold can be extraordinarily time consuming, not to mention practically impossible for items still in their boxes or not in the seller's immediate possession. As a result, many sellers resort to hijacking other sellers' photos for use in their own auctions.

The problem is that photo theft can be extremely damaging, and not so much because of mere copyright law (although it does apply).

A big part of any auction's desirability is its uniqueness. The more uncommon an item appears to bidders, the more valuable it becomes. When bidders see the same exact photo in two different auctions, not only are the implied scarcity and value of the item severely weakened, but the integrity of both sellers becomes suspect. And unless it's painfully obvious, most bidders won't distinguish between the thief and the seller whose photos were pilfered; a single theft of an image will hurt both sellers.

5.5.1 Protecting Your Image

My inspiration for this solution was a hot-dog vendor in my college town. On a shelf next to the broiler sat an old black-and-white television set, with the words "Stolen from Top Dog" written in permanent marker on its side.

The idea is to mark your photos so that they're unusable by other sellers, but in a way that doesn't adversely affect your own auctions. This is accomplished quite simply with a bit of text superimposed right on your photos.

The text should be carefully placed so that it doesn't obscure the subject but also can't be easily removed by the thief (such as with the clone tool in [Hack #57]). Often the easiest way to do this is with large, translucent text right over the center of the image, as in Figure 5-7.

**Figure 5-7. Tagging your photos with your eBay user ID is an effective deterrent against image theft**
Hack 59 Host Your Own Photos

Bypass eBay's photo restrictions by hosting auction photos on your own server.

Any photos that appear in your auctions must be stored on a web server somewhere; which one you use is up to you. When you use eBay's Picture Services, you're instructing eBay to store your photos on their own dedicated picture server and link them to your auction automatically. While this is the easiest and most convenient way to host photos, it's also fraught with limitations.

Hosting photos off-eBay has tons of advantages over using eBay's Picture Services (ePS). For instance, you can:

- Include as many photos as you like in any auction at no additional charge.
- Include photos of any size with no "supersize" fees. With ePS, photos are limited to 400 x 300, or, for an additional fee, 800 x 600 (supersize).

Large photos are more striking and show much more detail than small ones, and will end up getting you more bids. The problem with eBay's supersize photos is that they appear only when bidders click the Supersize Picture links beneath the thumbnails. If you host your own photos, you can put the large versions right in the auction (as many as you like), so your bidders don't have to click to see them. This is especially helpful if you choose to create a photo collage [Hack #63].

- Control the quality (compression) settings of your JPG photos. ePS has a tendency to over-compress photos, which reduces detail and increases fuzziness.
- Use very long or very wide images that don't conform to the standard 4:3 aspect ratio. These would otherwise be shrunk beyond recognition to conform to eBay's 400 x 300 size limit.
- Make changes to photos while an auction is running, even after it has received bids. You'll also have control over how long the images remain in your auctions after they've closed.
- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
```

Hack #40 For more

Where

- Place your photos directly in the text of your auction descriptions or use a more creative photo presentation, such as

```
[Image 61x703 to 70x730]
Hack 60 Make Clickable Thumbnails

Use thumbnails for more professional-looking auction photos that load more quickly.

If you're hosting your auction photos [Hack #59], you have the freedom to include as many images as you like at no additional charge. But you're also responsible for inserting those photos into your auctions and presenting them in a way that is efficient and appropriate.

An average eBay auction page is about 40 kilobytes in size, not including any photos you might include. (There's also about 50 KB of JavaScript code and 15 KB of eBay images, but these will be quickly cached and ultimately loaded only once.) The size of an average, medium-sized JPG file is about 50-60 KB, which more than doubles the amount of data your bidders will have to load to view your auction.

Thumbnail photos are much smaller than their full-size equivalents, both in physical dimensions and in the amount of data that must be transferred. This means that by replacing several full-size photos with thumbnails, your auction will not only appear tidier but will load faster as well.

5.7.1 Preparing the Images

Start by duplicating each of your image files. In Windows, for example, highlight all the images you wish to duplicate, drag them with the right mouse button to another part of the same folder window, and select Copy Here.

Next, rename your thumbnails appropriately. For example, if one of your images is named front.jpg, name the thumbnail image something like front.small.jpg or front_thumb.jpg. Remember to follow the naming conventions outlined in [Hack #59].

An easy way to rename large groups of files quickly is to use Power Rename, a component of Creative Element Power Tools, available at www.creativelement.com/powertools. If you're using Windows XP, you can use Microsoft's Image Resizer utility, freely available at www.creativelement.com/powertools. Among other things, Power Rename allows you to do search-and-replace operations on groups of filenames, even creating duplicates.
Hack 61 Construct an Interactive Photo Album

Use JavaScript to save money and get a better photo album to boot.

eBay provides a "photo album" feature, which allows your bidders to view multiple photos right in the auction by clicking thumbnails. However, this feature is available only if you're using eBay's Picture Services to host your photos, which means you're paying extra for rather limited photos.

If you're hosting your auction photos, as described in [Hack #59], all you need is a little JavaScript to accomplish the same thing. See [Hack #60] for another approach, as well as some background information on preparing the thumbnail images used in this hack.

5.8.1 The Hack

Simply place this code in your auction description:

```html
<table cellpadding=10 cellspacing=0 border=1>
<tr><td>
  <img src="view1.jpg" border=0 name="view">     
</td></tr>
<tr><td align=center>
  <img src="view1s.jpg" border=1     
    onClick="document.images['view'].src='view1.jpg';">
  <img src="view2s.jpg" border=1     
    onClick="document.images['view'].src='view2.jpg';">
</td></tr>
</table>
```

This creates a simple, two-cell table, shown in Figure 5-10. The upper cell contains the first of several images, and the lower cell contains the thumbnails for all images.

**Figure 5-10. This simple photo album gives photos hosted off eBay a classy presentation**
Hack 62 Show a 360-Degree View of Your Item

With a few photos of your item and a little JavaScript code, you can wow your customers with that showroom feel.

One of JavaScript's greatest strengths is its ability to manipulate images on a web page, allowing you to turn an otherwise static auction page into an interactive selling tool. In addition to being much cooler than eBay's built-in slide show feature, it's completely free and limited only by the amount of time you want to spend preparing your images.

5.9.1 Taking the Photos

The most challenging part of creating an interactive 360-degree view of your item is taking the photos, which really isn't all that difficult. The goal is to take photos of all sides of an item so that when they're viewed consecutively, like frames in a movie, it looks like the object is spinning. In most cases, you won't need more than four or five images. Having more frames will produce a smoother effect, but will take longer to load.

There are two basic approaches to taking the photos:

Stationary camera

To produce a "spinning" effect, simply mount your camera on a tripod and point it at your item. Take a photo, rotate the item 90 degrees, take another photo, rotate it again, and so on. For a smoother effect, place your item on a turntable or lazy susan, commonly available at hardware and houseware stores.

Stationary object

If you're photographing a large item, like a car or piece of furniture, or if you simply want that "walkaround" effect, then you can literally walk around your item and photograph it from each angle. For the best effect, use a tripod to keep the height and angle consistent, and use a ruler or measuring tape to maintain a consistent distance from the object.

Either way you do it, you'll want your photos to be as evenly spaced as possible. If you're taking only four frames, each photo should be 90 degrees apart (72 degrees for five frames, 60 degrees for six frames, 45 degrees for eight frames, and so on). Figure 5-11 shows four sides of an object photographed with a stationary camera.

Figure 5-11. Four sides of the object photographed with a stationary camera will give you a "spinning" effect
Hack 63 Create a Photo Collage

Combine multiple photos into a single image for convenience.

When you choose to [Hack #59], eBay allows you to specify only a single image URL to appear beneath your auction description. If you have any additional photos, you'll have to include them directly in the description with HTML, using any of several different methods described elsewhere in this chapter. But you also have the option of combining all your photos into a single image file, thus completely eliminating the need to use thumbnails or a photo album to organize multiple pictures.

A single collage of your photos is easy to build, and ultimately requires less work to insert into your auctions. It also gives you fuller control over the presentation of your photos, allowing you to easily emphasize the most important pictures.

You don't have to host your own photos to take advantage of this hack. However, if you use eBay's Picture Services to host your photos, you'll be limited to their cramped 400 x 300 standard size, which is really too small for a photo collage. And while the "supersize" option would indeed remedy this, it will end up costing more than hosting multiple photos separately.

To build a collage, start with the most prominent photo of your item, properly cropped and resized, as explained at the beginning of this chapter. Then, use your image editor to increase the canvas size to accommodate additional photos. Most users are more accustomed to scrolling web pages up and down, rather than side to side, so you'll usually want to orient your photos vertically rather than horizontally. For example, if you're combining three 600 x 450 photos, make the canvas at least 700 x 1400.

Next, place your additional images on the newly enlarged canvas. In most image editors, you can do this via copy-and-paste. First, open one of the images you want to place in the new canvas, select the entire image area (Ctrl-A), and copy the image to the clipboard (Ctrl-C). Then, paste the image into your new canvas (Ctrl-V) and use the mouse to position it. (See the next section for some shortcuts for Photoshop users.)

Figure 5-13 shows a completed photo collage. Here, a black background was used to make the collage a bit more striking. You can use white if you want the photos to blend in more smoothly with the surrounding auction. You may want to avoid brightly colored backgrounds, however, as they can be hard on the eyes.

Figure 5-13. A photo collage combines several photos into a single image file, producing a rather striking effect.
Hack 64 Create a Good Gallery Photo

Prepare your gallery photos to use the postage stamp-sized area to its fullest potential.

The Gallery upgrade, described in [Hack #36], places a photo next to your item in search results and category listings. All that's required (aside from the small fee) is that you provide a Gallery photo.

When your listing goes live, eBay automatically processes the photo by performing the following tasks:

- The image file is converted to the JPG file format.
- The photo is resized so that the larger dimension is 96 pixels.
- The photo is padded with whitespace to make it a square 96 x 96 pixels.
- The image file is hosted on eBay's server, making it accessible at:
  - where 3135403486 is the item number.

The closer your photo is to the final size of 96 x 96, the less of a hatchet job eBay's servers will have to do, and the better your gallery photo will look.

The best auction photo (described in [Hack #55]) will not necessarily be the best gallery photo, so you'll most likely want to prepare two different images.

For starters, your gallery photo must be square and without any superfluous background or borders. Figure 5-14 shows a few examples of gallery photos, both good and bad.

Figure 5-14. Gallery photo examples; the bad ones are shown on the first row, with their good counterparts shown immediately beneath them on the second row.
Chapter 6. Completing Transactions

- Section 6.1. Hacks #65-71
- Hack 65. Keep Track of Items You’ve Sold
- Hack 66. Sending Payment Instructions
- Hack 67. Protect Yourself While Accepting Payments
- Hack 68. Cheap, Fast Shipping Without Waiting in Line
- Hack 69. Selling and Shipping Internationally
- Hack 70. Damage Control Before and After You Ship
- Hack 71. Dealing with Stragglers, Deadbeats, and Returns

6.1 Hacks #65-71

When an auction ends, it's the seller's job to guide their customers through the rest of the transaction. The hacks in this chapter cover the seller's various tasks after the auction has ended.

Simple transactions typically involve one or more emails to the high bidder (as described in [Hack #66]), accepting payment (as described in [Hack #67]), and shipping (as described in [Hack #68]).
Hack 65 Keep Track of Items You've Sold

Use a simple spreadsheet to record the details of all your closed auctions.

eBay is not your keeper. They won't pick up your room, they won't do your homework, and they won't keep permanent records of your completed auctions.

If you sell on eBay, you'll need to keep some semblance of records of all the items you've sold. You'll need to keep track of who your high bidders are, whether or not they've paid, and whether or not you've shipped. It's very easy to do, and all that's required is a spreadsheet or database (suitable applications include Microsoft Excel and Microsoft Access, respectively, both included with Microsoft Office). If you're not sure which one to use, see Spreadsheet or Database?

Spreadsheet or Database?

Both spreadsheets and databases represent data in a table, a convenient format for keeping track of your auctions. But each type of application has strengths and weaknesses, so you should choose the one that best reflects your needs.

First, if it's too difficult to keep records, then you won't do it. So make sure to choose an application with which you're familiar and comfortable. If you use Excel every day but fear databases, then that comfort level trumps the rest of the considerations that follow (at least for the time being).

A spreadsheet requires minimal setup; just type the column headers explained here across the top, and then start entering the details of your auctions. Spreadsheets are flexible in that they impose few limits on the structure or type of data you enter. For instance, you can drag-and-drop rows to rearrange them, placing multiple auctions won by the same bidder together.

A database is more rigid, enforcing strict rules on the types of information you can place in the various fields. But that rigidity affords certain perks that just aren't available with a spreadsheet. For instance, you can run queries on a database to view sales trends, total spent on eBay fees, and so on, or run reports to make mailing labels. And databases can be much more easily linked to applications (see Chapter 8), making them more scalable. Setup is a little more involved, but if you're comfortable using a database, it's probably the better choice.
Hack 66 Sending Payment Instructions

How to communicate essential information to your bidders and avoid misunderstandings.

When an auction ends, it is your responsibility as the seller to guide your bidders through the rest of the transaction. Although eBay, by default, will send a notification email to bidders when they've won an auction, you should never rely solely on that email—or your auction description, for that matter—to communicate all the information your bidders need to know to send payment.

Instead, send a payment-instructions email to your customers, making sure to include all of the following:

- Thank the customer for bidding on and purchasing your item. Include the title and item number of the auction (or auctions) your customer has purchased.

- Tell the customer how much shipping will cost (even if it’s already specified in the auction) and explain exactly which shipping method you’ll be using. (Your customers have a right to know what they’re paying for.)

You can get the winning bidder's location (and zip code if they're in the U.S.) on the Bid History page, allowing you to determine the shipping cost before waiting for the bidder to send his or her street address.

- Calculate the total, including shipping, tax, and any handling fees, and clearly tell your customer how much he or she is supposed to pay. Don’t make your customers do any math, because they’ll most likely get it wrong. In most cases, you’ll have all the tools you need to calculate a customer's total before you send the email.

- If your customer has purchased more than one item from you and you're willing to ship them together, add these up as well, and make it clear that you're doing so.

- Carefully explain the types of payment you accept, even if it’s noted elsewhere. It's important to be clear on this point; otherwise, your bidders will most likely send you something you can't accept. See [Hack #67] for considerations.

- Instruct your customer to email you if he or she has any questions. (As much as you probably don't need to be bothered with lots of stupid questions, the last thing you want is for your customers to leave negative feedback instead of writing you first.)
Hack 67 Protect Yourself While Accepting Payments

Reduce your odds of getting burned by setting firm policies about the types of payments you accept.

Just as bidders must be cautious when sending money, as described in [Hack #29], sellers must be careful about the payments they receive. A little common sense is all that's required to avoid fraudulent payments, payments that can be reversed, and payments that require excessive fees to process.

Fortunately, it's the seller who sets the rules, at least when it comes to payment terms. Before you start selling, and especially before you send payment instructions to your customers, you'll need to develop a strict policy regarding the types of payments you'll accept.

- PayPal. PayPal goes further than just about any other payment service to protect its sellers from fraudulent payments (such as those made with a stolen credit card). But in order to qualify for PayPal's Seller Protection Policy, you'll need to do each and every one of the following:
  - Have a Premier or Business account, not a Personal account, as described in [Hack #29].
  - Verify your account, which involves nothing more than linking an ordinary bank account with your PayPal account and "confirming" it by having PayPal make two small deposits into it (which you get to keep).
  - Ship only to a customer's confirmed street address, as described in Shipping to Confirmed Addresses. You can see whether or not a buyer used a confirmed address in the transaction details, found at www.paypal.com and in the payment notification email.

Shipping to Confirmed Addresses

Probably the stickiest of all the requirements of PayPal's Seller Protection Policy involves confirmed addresses. The problem is one of diplomacy more than anything else.

Many PayPal members don't have confirmed addresses, don't know how to confirm their addresses, and don't know why they need to. What makes it worse is that PayPal doesn't do an adequate job of explaining confirmed addresses to their members, so it's often left to sellers to educate their customers.
Hack 68 Cheap, Fast Shipping Without Waiting in Line

Generate prepaid shipping labels online to save money and time.

"Three things in life are certain: death, taxes, and long lines at the post office."

You know the drill. Take your package down to the post office. Stand in line. Stand in line some more. Then, watch while your package is weighed, listen to your shipping options, and pick whichever one is cheapest. Go home, and do it all again next week. But the worst part is that it's completely unnecessary.

Most major couriers — and nearly all couriers in the United States — offer online shipping services. Here's how it typically works:

1. Go to your courier's web site and sign up for an account; at this time, you'll enter your mailing address and, optionally, payment information. You'll need to do this only once. See the next section for courier-specific tips.

   Before you're ready to ship, you can get a shipping cost quote from any courier web site. Do this before sending a total to the high bidder (see [Hack #66]), and you'll never underestimate shipping costs again.

2. Enter your recipient's address into a form, as well as the weight and dimensions of the package. (To avoid typos, make sure to use copy-and-paste rather than typing your customer's address by hand.) The return address is filled in automatically. Figure 6-3 shows the FedEx Ship Manager; note that the return address, which isn't shown, is filled in automatically.

   Figure 6-3. The FedEx Ship Manager lets you print out a prepaid shipping label in about a minute
Hack 69 Selling and Shipping Internationally

A few extra tools and tips to make shipping to customers in other countries go more smoothly.

"Nothing so liberalizes a man and expands the kindly instincts that nature put in him as travel and contact with many kinds of people."

—Mark Twain, 1867

With some practice, your international shipments will be nearly as easy as domestic ones. But it takes a little experience to know how to accept payments from customers in other countries, how to ship to other countries, and how to avoid fraud from deadbeats in other countries. Fortunately, the payoff is substantial: expanding your business to include bidders all around the world, while not without its risks, will make trading on eBay more interesting, more challenging, and more profitable.

6.6.1 Accepting International Payments

When you send payment instructions to customers in other countries, there are a few considerations you'll need to make in addition to those outlined in [Hack #66].

First, always keep the language barrier in mind. If your bidder's native language is different from yours, keep your sentences short and avoid slang. Bidders in other countries expect you to write in your own language, but they will usually not have perfect command of it. If you find that the bidder is having a hard time understanding you, you can always try including a translation of your instructions, as described in [Hack #30]. Just make sure it's placed alongside your original text in the email, so the bidder gets the complete picture.

Second, be patient. International transactions take longer, partly because of the delays caused by time zone differences and language barriers, and partly because sending payments internationally can be difficult and time consuming.

Finally, be extremely clear about the types of payments you can accept and the types you cannot. Here are some considerations when accepting payments from other countries:

- PayPal. Buyers in nearly 50 countries around the world have access to PayPal, but only those in United States can confirm their addresses. This means that if you accept a payment from a non-U.S. customer, it won't be covered by PayPal's Seller Protection policy, explained in [Hack #67].
Hack 70 Damage Control Before and After You Ship

How to handle problems discovered by either you or the customer.

"A diplomat is a person who can tell you to go to hell in such a way that you actually look forward to the trip."

—Caskie Stinnett, 1960

So you're packing up an item to ship to a customer, and you suddenly discover a scratch, scrape, hole, discoloration, or missing part that you hadn't noticed and hadn't mentioned in the auction description. Sure, you can pack it up, ship it, and hope the bidder never notices. But he will, and you know it.

The best approach involves a quick preemptive email to the bidder, like one of the following:

•

• "I just noticed a nick on the back of the item while I was packing it. Let me know if you no longer want it, and I'll refund your money. Otherwise, I'll ship right away." Give your customer a way out. In most cases, if the problem is minor, the customer will still want the item. Not only will this note make you appear honest, but your customer will have a more realistic expectation about the condition of the item, and less of a reason to return it when it finally arrives.

•

• "While packing up your item, I discovered a flaw I hadn't noticed when writing up the auction description. I've attached a photo. If you still want it, I'd be happy to send it to you along with a partial refund. Or, if you're no longer interested, I'll refund your payment in full." The photo gives the customer additional information with which he can make an informed decision, and, again, helps set a more reasonable expectation. And the partial refund is an excellent compromise that will both sweeten the deal for the customer and save you the trouble and expense of having to relist the item.

•

• "I was called out of town for a few days, and I had to leave before I got a chance to ship your package. I shipped your package this morning and upgraded it to second-day air for no extra charge. I'm sorry for the delay; please let me know when the package arrives." Damage control isn't just for physical damage; it's for dealing with snags in any part of the transaction. Not only should you contact customers before they receive a late package, you should make some concession to help compensate for the delay. For instance, a free shipping upgrade will cost you very little, but will go a long way toward making your customer happy with the product when it finally does arrive.

•

• "I was getting ready to pack your item, but I couldn't find some of the parts that were listed in the auction description. I apologize for the inconvenience, and have refunded your payment."
Hack 71 Dealing with Stragglers, Deadbeats, and Returns

Filing non-paying bidder alerts and credit requests in the event of a failed transaction.

Although sellers are responsible for paying all fees associated with an auction, eBay is not unreasonable about refunding those fees when it comes to returns, deadbeat bidders, and other extenuating circumstances.

Regardless of the terms of a failed transaction, every seller can complete the following two-step process to recover any final-value fees associated with an auction. Unfortunately, listing fees are nonrefundable, but they are never very large.

6.8.1 Non-Paying Bidder Alert

If a bidder never pays, if a bidder returns an item, or if you and the bidder settle a transaction for less than the final bid price, the first (and sometimes only) step is to file a Non-Paying Bidder Alert.

Start by going to Site Map → Request Final Value Fee Credit → Non-Paying Bidder Alert (cgi3.ebay.com/aw-cgi/eBayISAPI.dll?NPBComplaintForm), and enter the eBay item number as instructed.

You'll be presented with a list of reasons. The reason you choose here will have a very real effect on the way eBay handles the rest of the process. There are effectively three different scenarios:

- 1. Urge the bidder to pay. If you choose any of the following options, an email will be sent to the bidder reminding him of his obligation to pay. This will also enable you to subsequently use the Final Value Fee Credit Request Form, discussed in the next section. The options are:
  - High bidder didn't contact you.
  - High bidder didn't pay.
  - High bidder didn't respond to payment reminders.
Chapter 7. Running a Business on eBay

- Section 7.1. Hacks #72-81
- Hack 72. eBay Stores
- Hack 73. Streamlining Listings
- Hack 74. Streamlining Communications
- Hack 75. Streamlining Checkout and Payment
- Hack 76. Obtaining Sales Records
- Hack 77. Make Money by Linking to eBay
- Hack 78. List Your Auctions on Another Site
- Hack 79. Accept PayPal Payments from Your Own Site
- Hack 81. Keep Tabs on the eBay Community
7.1 Hacks #72-81

No two people or companies do business in exactly the same way, but there is always common ground when it comes to saving money and time. This chapter illustrates some of the tools — available both for free and at extra cost — that sellers have at their disposal for increasing automation in their businesses, and shows how these tools can be hacked to better suit your needs.

7.1.1 A Word About PowerSellers

eBay recognizes sellers who meet certain sales quotas as "PowerSellers" and awards them a few extra perks, most relating to enhanced technical and customer support. Whether or not they're the "pillars of our community" as eBay claims (pages.ebay.com/services/buyandsell/powersellers.html) is a matter left to the pundits. But for many sellers running businesses on eBay, the PowerSellers program is a benchmark worth achieving.

Give it some thought before placing the PowerSeller logo in your auctions as eBay suggests. Although the program as a whole can be valuable to sellers, the logo itself can send a message to bidders that you're a big, faceless organization, and they'll be lucky if they receive any personal attention from you at all. The personal touch, after all, is what attracts many bidders to eBay.

It's worth noting that the hacks in this chapter are suitable for all sellers, whether they're Titanium-level PowerSellers moving $150,000 worth of merchandise every month, or hobbyists trading a few low-cost items every couple of weeks.
Hack 72 eBay Stores

Open an eBay Store to build a more aggressive presence on eBay and on the Web.

For sellers who want their presence on eBay to be more than just a collection of running auctions, eBay allows you to open a Storefront, complete with the following perks:

- Longer-lasting items. You’ll be able to create fixed-price listings that last 30, 60, 90, or even 120 days. These listings don’t show up in standard eBay search results, but are shown to buyers who enter your store through any of your eBay listings.

Your standard eBay auctions will show up alongside your eBay Stores listings as long as they started after you opened your storefront.

- Lower listing fees. eBay Stores items cost only 5 cents for each 30 days they appear in your store.

- Search for your store. A search box appears at the top of your personal category listings, allowing customers to search through only your listings. See [Hack #46].

- Create your own categories. Include up to 11 custom categories in your store. Although these categories aren't associated with eBay's standard auction categories, they allow you to easily organize the listings in your own store. For instance, if you're selling photographic equipment, you can have a Lenses category and a Film category, making it easy for a customer who has just purchased a camera from you to pick up a few accessories to go along with it.

- Listing management tools. Use eBay's Merchandising Manager and Store Seller Reporting to generate monthly reports on your Sales and Marketplace data, helping you stay on top of your competition.

- Build a stable presence on eBay. An official storefront will help make your business look more reputable to customers. See [Hack #7] for further information.

Aside from the expected listing and final-value fees, eBay Stores require an extra-cost monthly subscription. You can get the details and sign up at stores.ebay.com.
Hack 73 Streamlining Listings

Use eBay Turbo Lister to upload more listings in less time.

The Sell Your Item form introduced in Chapter 4 is a simple but limited auction listing tool, adequate only for creating a few new listings at a time. It's hopelessly cumbersome for anyone needing to upload a large number of listings or otherwise automate the listing process.

eBay's own Turbo Lister application is what they call a "bulk listing tool," but in many ways it is simply a more convenient way to create eBay auctions. Turbo Lister, available at pages.ebay.com/turbo_list, is completely free to download and use, and operates on any Windows machine (Mac and Unix are not supported).

Although Turbo Lister provides all the same listing options available at www.eBay.com, it sometimes takes a little while (often a few weeks) for eBay to update the software with new features and categories. To make sure Turbo Lister is always up to date, go to Tools → Options → Advanced Options, and turn on the "Automatically download updates when I start the program" option.

### 7.3.1 Setting Up Turbo Lister

One of Turbo Lister's biggest strengths is that it effectively eliminates the need to enter the same information again and again. Before you use Turbo Lister, take a moment to specify default values by going to Tools → Options, as shown in Figure 7-1.

Figure 7-1. Use Turbo Lister's Options & Preferences box to set the defaults for your auctions
Hack 74 Streamlining Communications

Use templates to send prewritten emails to your bidders.

As a seller, it is your responsibility to guide your bidders, helping them send payments and complete your transactions. You are the teacher as well as the seller, and — unfortunately — you'll get blamed when something goes wrong.

The email you send to your winning bidders after an auction has ended, as discussed in [Hack #66], must communicate several different pieces of information, including the total amount to pay, the methods of payment you accept, and how to actually send payment. As a busy seller, you'll want to do everything you can to simplify this task so that notifying dozens or even hundreds of bidders takes no more time than notifying a single one. Here are three different approaches that offer three different levels of automation.

7.4.1 The Simple Approach

As stated at the beginning of this chapter, sellers have different needs and different capabilities. The simplest way to streamline repetitive emails is to use the Stationery feature of your email program (instructions for Eudora and Outlook follow).

- Eudora ([www.eudora.com](http://www.eudora.com)). To start, go to Tools ➔ Stationery. Right-click an empty area of the Stationery window, and select New. Type the subject line and body text that you'd like to send to an average bidder, and close the Untitled window when you're done. Eudora will prompt you for a filename in which to save the stationery; thereafter, your stationery will appear in the Stationery window. Simply double-click your stationery to send it to a new customer.

  Your email should be readable by as many bidders as possible. For this reason, avoid using special fonts, colors, and especially pictures in your stationery.

- Outlook or Outlook Express ([www.microsoft.com](http://www.microsoft.com)). Go to Message ➔ New Message. Type the subject line and body text that you'd like to send to an average bidder, and then go to File ➔ Save as Stationery when you're done. To send a message with your stationery, go to Message ➔ New Message Using ➔ Select Stationery, find your newly created stationery in the folder, and then click OK.

7.4.2 The Hacker's Approach
Hack 75 Streamlining Checkout and Payment

Use an off-eBay checkout system to integrate payments with shipping and accounting.

In the old days, any seller who wanted to accept credit cards had to get a credit card merchant account. Now, payment services like PayPal, BidPay, and C2IT have made merchant accounts largely unnecessary for everyone but the largest sellers.

But if there's any single truth when it comes to accepting payments on eBay, it's this: the more types of payment you accept, the more bids you'll get.

If you decide to use an off-eBay checkout system, you may wish to disable eBay's own checkout, as described in [Hack #49]. Otherwise, your bidders may skip your preferred checkout in haste, and instead simply use the method with which they're most accustomed.

But there are still reasons to get a merchant account. For instance, sellers who do a lot of business may be able to get a better discount rate as a credit card merchant than they could through PayPal, which essentially means that they'll get to keep a larger percentage of the payments they receive. And anyone who sells merchandise outside of eBay will not want to limit their transactions only to PayPal.

Getting a Merchant Account

This is one thing that eBay won't do for you, and one thing that requires more than spending five minutes filling out a form on some web site. The best way to start is by contacting your bank and asking them to recommend a merchant account provider with which they're affiliated.

A representative will then talk to you and request lots of information about you and your business to help them establish your identity. You'll discuss payment plans and discount rates; don't be afraid to ask questions. When all is said and done, you'll be given a terminal or other means of entering credit card information, and you'll be ready to accept credit card payments.

Be warned—setting up a merchant account is not cheap, and is not for the faint of heart.
Hack 76 Obtaining Sales Records

Extract detailed accounting data from My eBay, or do it automatically with eBay's Selling Manager.

Sellers pay the bills at eBay. Fees are assessed for listings and upgrades (see [Hack #36]), and eBay gets a percentage of the final value of each successfully completed auction.

Any eBay user can check his or her account by going to My eBay → Accounts → Account Status. The fees are broken down individually and cross-referenced by item number. So to see exactly how much a particular auction cost you, just search for the item number, add up the corresponding amounts shown in the Debit column, and subtract any corresponding entries in the Credit column.

A more convenient approach is to use a spreadsheet to organize the data. First, go back and turn off Pagination and choose the appropriate date range. Click Submit and save the resulting page to an HTML file (File → Save As in your browser).

If you want to remove the images and search box from the page, open the HTML file in a text editor and do a few search-and-replace operations before importing it into Excel. Replace every occurrence of <img with <ximg, and every occurrence of <input with <xinput. Save the file when you're done.

Open the page in a web-capable spreadsheet like Microsoft Excel. Highlight all the rows above the table (about 30 rows), and remove them (Edit → Delete). Do the same for all cells below the table. Finally, sort the listing by item number. Select the entire sheet (Ctrl-A), go to Data → Sort, choose "Item" in the first box, and then click OK.

It's not pretty, but it does the job in less than two minutes, and it's free.

7.6.1 Step Up to Selling Manager

For a monthly fee, you can have access to eBay's Selling Manager tool. Among other things, Selling Manager keeps an archive of past sales for up to four months, allowing you to download a sales history in a more convenient CSV (comma-separated value) format than the spreadsheet hack discussed earlier. CSV files can be easily imported into any spreadsheet, database, or accounting program.

Selling Manager simply appears as a tab in My eBay, replacing the Selling tab discussed in [Hack #65]. See Figure 7-5.
Hack 77 Make Money by Linking to eBay

Earn affiliate kickbacks without even selling anything on eBay.

Like many e-commerce sites, eBay offers an affiliate program, wherein they pay you money for each new eBay member who signs up through the links on your site. If you're promoting your eBay auctions off-site, as described in [Hack #78], you can make it even more lucrative by making all the links affiliate links.

Start by signing up at pages.ebay.com/affiliate. You'll find a few different affiliate programs, each with different requirements and benefits (there's even one just for [Hack #72]). But the "Commission Junction" link is probably the most applicable, as it offers kickbacks for new user registrations as well as individual bids. There's no fee to apply.

7.7.1 Creating Links with Commission Junction

eBay is one of many affiliate sites partnered with Commission Junction, a fact that will become all too clear when you first try to create links. You'll have to dig a bit just to find eBay on the site. The quickest way is to go to Get Links By Relationship My Advertisers, and you'll see a list of sites with whom you've signed up. (If you join Commission Junction through eBay, you'll be automatically signed up as an eBay affiliate.)

You may see references to cryptic terms like "EPC," followed by dollar amounts that look like fees. EPC is marketing lingo for "Average Earnings Per One Hundred Clicks" and translates to the money they expect you to earn through your affiliate links.

Click View Links to show the assortment of links and banners you can use (there were 152 at the time of this writing). The listing can be sorted by clicking the column headers; click "7 Day EPC," for instance, to show the links that, statistically, are supposed to earn the most money.

7.7.2 Hacking the Links

But as we learned in How to Lie with Statistics by Darrell Huff, "There is terror in numbers." Instead of using the links that Commission Junction tells you to use, you might want to use the links that will further your specific interests and have the least impact on your site. One of the most useful is Link ID 7169491, "Customizable eBay Destination," which lets you link to any specific page at eBay. For a shortcut to the page used to create this link, just go to pages.ebay.com/affiliate/cjflexiblelink.html, shown in Figure 7-6.
Hack 78 List Your Auctions on Another Site

Use the eBay Editor Kit and Merchant Kit to promote your auctions off-eBay.

Once you've signed up with one of eBay's affiliate programs, as described in [Hack #77], you can use either of eBay's two tools for creating lists of auctions on your own site. Not only will this help promote your auctions and increase traffic to specific items, but you'll make money for each new user who signs up and for each bid that is placed as a result of your links.

7.8.1 The Editor Kit

The Editor Kit couldn't be slicker. Just go to cgi3.ebay.com/ws/eBayISAPI.dll?EKCreate and fill out the fields, as shown in Figure 7-7.

Figure 7-7. Use the Editor Kit to create a custom search results listing for use on your own site

Select Commission Junction in the Provider box and enter your CJ ID in the Tracking ID field. The rest of the fields should be self-explanatory, and the only one that is required is the Search Term. If you want to limit the search to your own auctions, type your eBay user ID in the “Show items of the following sellers” box.

When you're done, click Preview to show the JavaScript code and the resulting search box, shown in Figure 7-8.

Figure 7-8. The code produced by the Editor Kit will create this dynamic listing on your site

The big drawback to the Editor Kit is that it only shows results of a keyword search; you can't leave the Search Term field blank in order to show all your auctions. Instead, you can use either eBay Stores [Hack #72] or the Merchant Kit, next, to promote your overall business on eBay.

7.8.2 The Merchant Kit

Like the Editor Kit, the Merchant Kit creates simple JavaScript snippets, but centers around category listings rather than search results.

Start by going to pages.ebay.com/api/merchantkit.html, and simply use the Merchant Kit, shown in Figure 7-9, to create your code.

Figure 7-9. The Merchant Kit has only a few options, but the code it creates is not limited by search terms

The code is little more than a URL that can be easily tweaked without having to return to the Merchant Kit. The resulting box, shown in Figure 7-10, lists all your auctions, optionally filtered by category.

Figure 7-10. Use the Merchant Kit to produce dynamic listings of all your auctions on any site
Hack 79 Accept PayPal Payments from Your Own Site

Integrate PayPal into your web site with a simple HTML form.

PayPal is more than a standalone auction payment service—it's an engine that you can use to power transactions on or off eBay. Any site that sells products can accept PayPal payments, and can do so without forcing customers to type an email address and an amount into their browser windows.

Somewhat like an API, PayPal provides an HTTP interface to their payment system that works just like the Pay Now button at the top of completed eBay auctions. This allows you, as the seller, to specify an amount, a product name, and any other bits of information you'd like to associate with the payment.

Any seller can accept PayPal payments through their HTTP interface; no special agreement or settings are necessary, other than a basic PayPal account. There are two ways to integrate PayPal into your site.

7.9.1 Just a Link

The simpler of the two methods involves nothing more than a link placed on your site. For instance, this URL:

https://www.paypal.com/xclick/business=paybot@ebayhacks.com&item_name=wicket&amount=58.00&no_note=1

specifies the email address (paybot@ebayhacks.com), the product name (wicket), and the amount ($58.00). If you want to link the URL to an image (like the PayPal logo), use this code:

<a href="https://www.paypal.com/xclick/business=paybot@ebayhacks.com&item_name=wicket&amount=58.00&no_note=1"><img src="https://www.paypal.com/images/x-click-but01.gif" border=0></a>

Other Pay Now button images are available at PayPal. When your customers click the link, they will see a window like the one in Figure 7-11.

Figure 7-11. The PayPal checkout counter shows your product and the price
Hack 80 Process PayPal Payments Automatically

Use Instant Payment Notification to fulfill orders without human intervention.

When a bidder pays for an auction with PayPal or completes an order from your online store (see [Hack #79]), PayPal notifies you with a single email. Since the last thing any busy seller wants to do is deal with a bunch of emails, PayPal offers the free Instant Payment Notification (IPN) feature.

7.10.1 Setting Up IPN

The premise is pretty simple: as soon as a payment is received, PayPal contacts your server and submits all the details of the transaction to your script. Your script then processes and stores the data in whatever way you see fit.

To start using IPN, all you need to do is enable the feature and specify the URL of your script. Log into PayPal and go to My Account → Profile → Instant Payment Notification Preferences. Click Edit to change the current settings.

7.10.2 The Script

The following Perl script[1] does everything required to accept IPN notifications; all you need to do is modify the $workdir variable to reflect a valid path on your server.


This script requires the LWP::UserAgent Perl module by Alan E. Derhaag, available at search.cpan.org/perldoc?LWP::UserAgent, necessary to facilitate communication with the PayPal server. See [Hack #17] for installation instructions.

#!/usr/bin/perl
$workdir = "/usr/local/home";

read (STDIN, $query, $ENV{'CONTENT_LENGTH'});    \[1\]
$query .= "&cmd=_notify-validate";          \[2\]

use LWP::UserAgent;
$ua = new LWP::UserAgent;
$req = new HTTP::Request 'POST','http://www.paypal.com/cgi-bin/webscr';
$req->content_type('application/x-www-form-urlencoded');
$req->content($query);
$res = $ua->request($req);    \[3\]
Hack 81 Keep Tabs on the eBay Community

Use the Forums, Announcement boards, and New Feature Previews to keep up with the eBay community.

eBay is constantly revising their website, policies, features, and associated fees; as a seller on eBay, you have a vested interest in how these changes shape your business. Since even the most minor changes can have an impact (positive or negative), you should stay connected to the eBay community to ensure that you're aware of potential problems and prepared for upcoming changes.

- General Announcements Board.
  - [http://www2.ebay.com/aw/marketing.shtml](http://www2.ebay.com/aw/marketing.shtml)
  - Go to Site Map ➔ News & Announcements for previews of new features, new category announcements, policy changes, and updates to eBay's various tools and services.

- System Announcements Board.
  - [http://www2.ebay.com/aw/announce.shtml](http://www2.ebay.com/aw/announce.shtml)
  - Go to Site Map ➔ News & Announcements ➔ System when something on eBay stops working, to see if there's an explanation here. Scheduled maintenance and unscheduled outages are also documented on this page.

- Calendar.
  - [http://pages.ebay.com/community/events/](http://pages.ebay.com/community/events/)
  - Go to Site Map ➔ Calendar for a listing of this month's workshops, tradeshows, "Share your Wares" events, Street Faires, eBay Live conferences, and eBay University seminars.

- eBay Community Newsletter.
  - Go to Site Map ➔ News & Announcements ➔ Newsletter to read "The Chatter," a monthly e-zine produced by eBay staff members, complete with articles, announcements, and even a Member Spotlight.

- Discussion Forums
  - Go to Site Map ➔ Discussion, Help and Chat ➔ Discussion Boards to discuss nearly all aspects of eBay with other members. Among the roughly 70 specialized forums are "Checkout," "Search," "International Trading," and my favorite, "Soapbox."
  - Use the boards to ask questions, offer help to other eBay users, and voice your opinions (and objections) regarding eBay policies, changes, and trends. For instance, when eBay's controversial Checkout feature was introduced (see Hack #49), eBay's then-new Checkout forum was crammed with thousands of complaints from members (including several makeshift "petitions" started by particularly outraged sellers).

  - Forums are comprised of threads, each of which starts as a single message. Any member can start a new thread or add to an existing thread. When new threads are created or old threads are updated with new additions, they're moved to the top of the list.
  - Some people post to their own threads to move them to the top in the hopes of invigorating them, which is why you may occasionally see a post with nothing more than "Bump" in the message body.

  - When eBay staff members post to a forum (and they do), their names are shown in a pink-colored stripe, which is why you may occasionally see references to "Pinks" by some of the forum regulars.

- API Forums.
  - This is a special section of the forums for those working with the eBay API, discussed in Chapter 8.
Chapter 8. The eBay API

- Section 8.1. Hacks #82-100
- Hack 82. Climbing Out of the Sandbox
- Hack 83. API Searches
- Hack 84. Retrieve Details About an Auction
- Hack 85. Automatically Keep Track of Auctions You've Won
- Hack 86. Track Items in Your Watching List
- Hack 87. Automatically Keep Track of Auctions You've Sold
- Hack 88. Submit an Auction Listing
- Hack 89. Automate Auction Revisions
- Hack 90. Spellcheck All Your Auctions
- Hack 91. Negative Feedback Bidder Alert
- Hack 92. Automatically Relist Unsuccessful Auctions
- Hack 93. Send Automatic Emails to High Bidders
- Hack 94. Generate a Custom Gallery
- Hack 95. Leaving Feedback
- Hack 96. Negative Feedback Notification
- Hack 97. Automatic Reciprocal Feedback
- Hack 98. Queue API Calls
- Hack 99. Cache Auction Data to Improve API Efficiency
- Hack 100. Working Without the eBay API

[Team LiB]
8.1 Hacks #82-100

eBay is more than just a web site. It's a platform upon which you can build your own applications and with which you can extend your business.

The eBay API (Application Programming Interface) is a set of functions you can integrate with your applications to communicate directly with eBay. Use the API to retrieve details about an auction, perform searches, list a seller's current items, and even create new auction listings. Think of the API as a "back door" of sorts, a way for developers to interact with the eBay engine and auction database without using the standard web interface.

The possibilities of such a system are limitless. Businesses can use the eBay API to link their inventory and sales databases with auctions, cutting out most of the labor that would otherwise be involved in selling large numbers of items. Developers can use the API to construct auction management applications for themselves, their companies, or even for commercial sale. And, of course, individual buyers and sellers on eBay can use the API to do a little friendly hacking, as described throughout the rest of this chapter.

8.1.1 How the eBay API Works

The underlying process of placing a call to the API is conceptually quite simple. First, your program sends an XML string to eBay with the name of the API call and any additional required fields. Here's an example XML request for the GetSearchResults function:

```xml
<?xml version='1.0' encoding='iso-8859-1'?>
<request>
  <RequestUserId>my_user_id</RequestUserId>
  <RequestPassword>my_password</RequestPassword>
  <ErrorLevel>1</ErrorLevel>
  <DetailLevel>0</DetailLevel>
  <Verb>GetSearchResults</Verb>
  <SiteId>0</SiteId>
  <Query><![CDATA[*abbey road*]]></Query>
</request>
```

eBay then responds with more XML, from which your application extracts the desired data. The components of the input and output XML will vary with the particular function and the needs of the application, but the overall methodology is the same regardless of the API call being used.

Every single XML request sent to eBay must contain three developer-specific keys, DevID, AppID, and CertID, all of which are provided to you when you join eBay's Developers Program.

8.1.2 Getting Started

Before you can start using the eBay API, you'll need to sign up at developer.ebay.com. There are four different license types (or "tiers"):
Dealing with certification and going "live."

eBay is understandably protective about any access it permits through its API. To that end, they provide the Sandbox, a "dummy" eBay site with which you can test your programs to your heart's content.

The Sandbox is located at cgi.sandbox.ebay.com/, and looks (and acts) just like eBay.com. Although it's nearly fully functional (some features don't work at all), its auction and user databases are completely separate from the main eBay site.

The idea is that you can create user accounts, list items, bid, and even check out, all without incurring the fees and API call limits that would otherwise prevent you from freely testing your application or scripts.

Although the Sandbox is not bug-free and is often a few months behind eBay.com when it comes to new features and interface changes, it's stable where it counts. It's accepted as fact that any code that works in the Sandbox will work on the live eBay.com site.

### 8.2.1 Certification

Before your application goes "live," meaning that it can be used on what eBay calls the "production servers" (not just the Sandbox), you must complete certification.

Now, the fact that certification is a required step and costs money ($100 for Individual-tier developers) may make it seem more like a barrier than a service. However, eBay's reasoning is that it ultimately benefits developers as much as it benefits eBay.

- For developers working under the Individual license, the certification fee is the only tangible cost of entry to going live.

First and foremost, certification involves testing your script or application to ensure that it operates efficiently and causes minimal impact on the performance of eBay.com. Certification also permits developers to display the eBay Certified Developer Logo in their applications; while this may not mean so much to individual developers (it is not even available under the Individual license), it is absolutely vital for those creating commercial applications to gain the confidence of their customers.

Here's how certification works:
Hack 83 API Searches

Perform reliable searches with GetSearchResults.

In [Hack #17], a Perl script is used to perform an automated eBay search and then email new listings as they're discovered. Although the script serves a valuable function, it has the notable handicap of relying entirely on "scraping" (via the WWW::Search::eBay module) to retrieve its search results.

Scraping involves parsing standard web pages in order to retrieve the desired data. As you might expect, any changes to eBay's search pages, even minor ones, will break the script until the WWW::Search::eBay module on which it relies is updated to work with the new version.

The API, on the other hand, provides an officially supported interface to eBay's search engine, which means that scripts based on the API will be much more robust and nearly invulnerable to changes in eBay's search pages.

8.3.1 A Simple Search

Here's a simple Perl script, search.pl, that performs a search and displays the results.

```perl
#!/usr/bin/perl
require 'ebay.pl';

use Getopt::Std;
getopt('d');
$keywords = shift @ARGV or die "Usage: $0 [-d] keywords";

PAGE: [1]
while (1) {
  my $rsp = call_api({ Verb => 'GetSearchResults', [2]
  DetailLevel => 0,
  Query => $keywords,
  SearchInDescription => $opt_d ? 1 : 0,
  Skip => $page_number * 100,
});
  if ($rsp->{Errors}) {
    print_error($rsp);
    last PAGE;
  }
  foreach @{$rsp->{Search}{Items}{Item}} { [3]
    my %i = %$_;
    ($price, $time, $title, $id) = @i{qw/CurrentPrice EndTime Title Id/}; [4]
    print "($id) $title [\$$price, ends $time]\n";
  }
  last PAGE unless $rsp->{Search}{HasMoreItems}; [5]
  $page_number++;
}
```

Given that searches can return hundreds or even thousands of results, the GetSearchResults API call (line [2]) divides the results into pages, not unlike the search pages at eBay.com. The loop, which begins on line [3], iterates through the result set for the current page, line [4], retrieving one listing at a time and printing it out. If there are no more matching search results, the loop is exited by the `last PAGE` statement on line [5].
Hack 84 Retrieve Details About an Auction

Use the GetItem API call to get listing details.

The GetItem API call is used to retrieve all the details of a listing, including the title, description, starting price, category, and about 180 other individual bits of information.

Here's a simple script that, when provided with the item number, returns the title, seller ID, amount of time left, number of bids, and the current price.

```perl
#!/usr/bin/perl
require 'ebay.pl';

$item_id = shift @ARGV or die "Usage: $0 itemnumber";

my $rsp = call_api({ Verb => 'GetItem',     
    DetailLevel => 0,     
    Id => $item_id     
});

if ($rsp->{Errors}) {
    print_error($rsp)
} else {
    my %i = %{$rsp->{Item}[0]};
    my ($price, $currency, $bids, $time_left, $seller, $title) = @i{qw/CurrentPrice CurrencyId BidCount TimeLeft Seller Title/};

    $d = $time_left->{Days};
    $h = $time_left->{Hours};
    $m = $time_left->{Minutes};
    $s = $time_left->{Seconds};
    $seller_id = $seller->{User}{UserId};
    $seller_fb = $seller->{User}{Feedback}{Score};

    print "Item #$item_id: $title\n";
    print "For sale by $seller_id ($seller_fb)\n";
    print "Currently at $currency$price, $bids bids\n";

    if ($d > 0) { print "$d days, $h hours left.\n"; }
    elsif ($h > 0) { print "$h hours, $m minutes left.\n"; }
    elsif ($s > 0) { print "$m minutes, $s seconds left.\n"; }
    else { print "auction ended.\n"; }
}
```

This script is fairly straightforward. The GetItem API call is submitted on line [1], and the desired fields are extracted on line [2]. Naturally, you can specify any of the 180+ field names specified in the API documentation (look up GetItem Return Values in the index), as long as the variables on the left side of the equals sign on line [2] match up with the field names on the right.

Note that some variables are hashes (which eBay calls container nodes), from which relevant data must be extracted. For instance, in the documentation you'll see entries for TimeLeft as well as TimeLeft.Days, TimeLeft.Hours, TimeLeft.Minutes, and TimeLeft.Seconds. In Perl, these elements of hashes are accessed with the -> arrow (infix dereference) operator, as shown on line [3].
Hack 85 Automatically Keep Track of Auctions You've Won

Maintain a permanent record of everything you've ever purchased.

Since eBay keeps auctions on site only for about 90 days and lists them in My eBay for only 30 days, all bidders should maintain permanent, off-site records of the items they've purchased.

As long as you keep all email you've received, as described in the Preface of this book, you'll always have records of the item numbers, titles, seller IDs and email addresses, and closing prices of the items you've won. But this data is stored in a less-than-convenient format, and the descriptions aren't stored at all.

Here's a script that will automatically retrieve and store details for every auction you've won:

```perl
#!/usr/bin/perl
require 'ebay.pl';
	
$today = &formatdate(time);     [1]
$yesterday = &formatdate(time - 86400);     [2]

my $rsp = call_api({
    Verb => 'GetBidderList',     [3]
    DetailLevel => 32,
    UserId => $user_id,
    SiteId => $site_id,
    EndTimeFrom => $yesterday,
    EndTimeTo => $today,
});

if ($rsp->{Errors}) {
    print_error($rsp);
} else {
    foreach (@{$rsp->{BidderList}{Item}}) {
        my %i = %$_;
        ($highbidder, $title, $id) = @i{qw/HighBidderUserId Title Id/};     [4]

        if (! -e "$localdir/$id") && ($highbidder eq $user_id) {     [5]
            my $rsp = call_api({
                Verb => 'GetItem',     [6]
                DetailLevel => 2,
                Id => $id
            });
        }
        else {
            if ($rsp->{Errors}) {
                print_error($rsp);
            } else {
                my %i = %{$rsp->{Item}[0]};
                my ($price, $currency, $seller, $title, $description) =     [7]
                    @i{qw/CurrentPrice CurrencyId Seller Title Description/};

                open (OUTFILE,">$localdir/$id") ;     [8]
                print OUTFILE "[$id]\n";
                print OUTFILE "title=$title\n";
                print OUTFILE "seller="."$seller->{User}{UserId}."\n";
                print OUTFILE "price=$currency$price\n";
            }
        }
    }
}
```

The GetBidderList API verb, called on line [3], returns a maximum of 200 items, but doesn't support paging like GetSearchResults (see [Hack #83]). This means that we need to be a little creative. So instead of trying to grab as many listings as possible, we grab only the auctions that have ended in a certain interval, say, a day. (If you bid infrequently, you can change this to a week or even a month, and help keep down your API calls). So, we set the EndTimeTo and EndTimeFrom fields to today's and yesterday's dates, respectively. The formatdate subroutine is used on lines [1] and [2] to convert the Perl dates to something eBay understands.

Next, the script runs through the list of auctions you've bid on and retrieves the high bidder, title, and item number for each. (We don't actually use the title here, but it's nice to have.)

On line [5], a check is performed to see if the auction has been recorded previously and if you're indeed the high bidder. Note that since we're using a DetailLevel of 32 (specified on line [3]), we get back an "abbreviated results set" from which, as the documentation explains, the user ID of the high bidder is retrieved with the HighBidderUserId tag. We could also use a DetailLevel of 0, but we'd have to deal with the HighBidder hash (see [Hack #84] for more information on container nodes). Refer to the API documentation for the somewhat confusing circumstances surrounding the DetailLevel tag with regards to GetBidderList.

Finally, the auction details for each item are retrieved with GetItem (line [6] and then line [7]). Note that the DetailLevel for this call is set to 2 to retrieve the descriptions as well, as described in [Hack #84].

The $description variable contains the raw description, including any HTML code. See [Hack #90] for details on extracting plain text from HTML code.

Line [8] then saves the retrieved data into a file, named for the item number of the listing. Naturally, you can retrieve and store as many or as few fields as you like and store them in whatever format is convenient, such as a database, comma-delimited (CSV) text file, or the generic format used here. See [Hack #17] for information on scheduling the script to run at regular intervals. Since the script retrieves only auctions that have ended in the last 24 hours, this script should be run once a day, every day. If you want to run it less (or more) often, just change the EndTimeTo and EndTimeFrom fields accordingly.
Hack 86 Track Items in Your Watching List

Link an off-eBay auction tracker with eBay's Items I'm Watching list.

eBay provides the Items I'm Watching list (in My eBay → Bidding/Watching) to help you keep track of auctions on which you haven't yet bid. A corresponding API call, GetWatchList, allows you to access the contents of that list.

But the Items I'm Watching list is rather limited and can be replaced with a custom tracking list, as described in [Hack #24]. Although the hack works, there are two simple ways to use the eBay API to make the script more robust and efficient:

- Retrieve the title and end date with the GetItem API call instead of using the flakier method of extracting them from the auction page title.
- Supplement the tracking list with any auctions in the Items I'm Watching list.

The following is a revised auction tracking script with both of these improvements.

This script requires all the Perl modules specified in [Hack #24], as well as Time::Local, by Tom Christiansen, Graham Barr, and Dave Rolsky (search.cpan.org/perldoc?Time::Local), used to convert dates retrieved from the API from GMT to local time.

#!/usr/bin/perl
require 'ebay.pl';
use Time::ParseDate;
use Time::Local;
use POSIX qw(strftime);
require("cgi-lib.pl");
&ReadParse;
$selfurl = "http://www.ebayhacks.com/exec/track.pl";
(localfile = "ebaylist.txt");
$timeout = 0;
@formatting="color=#EE0000 STYLE=font-weight:bold",
"color=#000000 STYLE=font-weight:bold", "color=#000000";
$i = 0;
$exists = 0;
$numlevels = 2;
# *** read stored list ***
open (INFILE,$localdir/$localfile);
Hack 87 Automatically Keep Track of Auctions You've Sold

Retrieve and store completed auction data without typing.

As explained in [Hack #65], it's vital for every seller to keep permanent, off-site records of every single auction he or she has sold.

This script, when run every day at the same time (as described in [Hack #17]), does it all:

```perl
#!/usr/bin/perl
require 'ebay.pl';
$today = &formatdate(time);
$yesterday = &formatdate(time - 86400);
my $page_number = 1;
PAGE:
while (1) {
    my $rsp = call_api({
        Verb => 'GetSellerList',
        DetailLevel => 8,
        UserId => $user_id,
        EndTimeFrom => $yesterday,
        EndTimeTo => $today,
        PageNumber => $page_number
    });
    if ($rsp->{Errors}) {
        print_error($rsp);
        last PAGE;
    }
    foreach (@{$rsp->{SellerList}{Item}}) {
        my %i = %$_;
        ($id, $enddate, $title, $currency, $price, $highbidder) = @i{qw/Id EndTime Title CurrencyId CurrentPrice HighBidder/};
        if (! -e "$localdir/$id") {
            open (OUTFILE,">$localdir/$id") or die "Can't open file: $!";
            print OUTFILE "[Details]\n";
            print OUTFILE "enddate=$enddate\n";
            print OUTFILE "itemnumber=$id\n";
            print OUTFILE "title=$title\n";
            print OUTFILE "price=$currency$price\n";
            print OUTFILE "bidder=".$highbidder->{User}{UserId}."\n";
            close (OUTFILE);
        }
    }
    last PAGE unless $rsp->{SellerList}{HasMoreItems};
    $page_number++;
}
```

This script works similarly to the one in [Hack #85], but it retrieves a list of auctions by seller that have ended between the specified dates. Here are a few important things to note about this script:
Hack 88 Submit an Auction Listing

Use AddItem to start new listings and make scheduling easier.

eBay's Turbo Lister, introduced in [Hack #73], is an API-based tool used to submit new listings to eBay. It provides a complete interface with which the user can create and modify listings, as well as a database engine that stores them. (Factoid: 35% of eBay listings are reportedly submitted with the API, including those uploaded with Turbo Lister.)

All the work is done by the AddItem API call, illustrated by this extremely simple script:

```perl
#!/usr/bin/perl
require 'ebay.pl';
$category    = shift @ARGV;
$title        = shift @ARGV;
$description = shift @ARGV;
$minimum_bid = shift @ARGV;
defined($minimum_bid)
or die "Usage: $0 category title description minimumbid"

$country = 'us';
$location = 'My home town';
$duration = 7;
$quantity = 1;
$currency = 1;

my $rsp = call_api({ Verb => 'AddItem',     [1]   DetailLevel => 0,   SiteId => $site_id,   Category => $category,   CheckoutDetailsSpecified => 0,   Country => $country,   Currency => $currency,   Description => $description,   Duration => $duration,   Location => $location,   MinimumBid => $minimum_bid,   PaymentOther => 1,   Quantity => $quantity,   Region => 0,   Title => $title, });

if ($rsp->{Errors}) {
    print_error($rsp)
} else {
    print "New listing created: #$rsp->{Item}[0]{Id}\n";     [2]
    print "Ends $rsp->{Item}[0]{EndTime}\n";
}
```

The simplest way to use this script is to call it from the command line, like this:

```
additem.pl 7276 'Little Red Steam Shovel' 'My description...' 5.00
```

However, it will probably make more sense to call it from another script or program, especially since you'll likely want more of a description than simply "My description . . . " and more options than the four required by this sample script.

Although AddItem calls do not count against your daily (or monthly) API call allotment, the listing fees normally associated with starting new auctions still apply. The same goes for the RelistItem call, discussed in [Hack #92].

8.8.1 Hacking the Hack

Of the more than 120 individual input fields supported by the AddItem call, only 11 are required: Category, CheckoutDetailsSpecified, Country, Currency, Description, Duration, Location, MinimumBid, Quantity, Region, and Title. But when submitting a live listing, you'll most likely want to include as many options as possible, everything from the shipping charges to the extra-cost listing upgrades. Refer to the API documentation for a complete listing, and place any additional fields alongside the others on line [1].

As discussed in [Hack #99], it's important to save as much retrieved information as possible so that you can reduce the number of subsequent API calls needed. If you submit listings only with the AddItem API call (never through eBay.com), you should record the item numbers it returns ($rsp->{Item}[0]{Id}) for further use. This would reduce (or eliminate) your need for the GetSellerList API call — used in so many of the hacks in this chapter — at least when it comes to retrieving a listing of your own auctions.

8.8.2 See Also

The eBay API SDK comes with the eBay Sample Selling Application, a Microsoft Visual Studio .NET-based listing creation tool similar to Turbo Lister. Those interested in creating a similar tool will want to poke around in the included C source code.
Hack 89 Automate Auction Revisions

Simplify the task of revising several auctions at once with the ReviseItem API call.

Once an auction has started, you can normally change most aspects of the listing using the procedure outlined in [Hack #50]. But it's also possible to submit a revision using the API.

8.9.1 ReviseItem

Let's start with a simple script, reviseitem.pl, that will let you change any aspect of an active listing:

```
#!/usr/bin/perl
require 'ebay.pl';
my $item_id = shift @ARGV;
my %ARGS = @ARGV;
my @options = qw/AdditionalShippingCosts AmEx AutoPay BoldTitle
BuyItNowPrice CashOnPickupAccepted Category Category2 CCAccepted
CheckoutDetailsSpecified CheckoutInstructions COD Counter Description
Discover Duration Escrow EscrowBySeller Featured Gallery GalleryFeatured
GalleryURL GiftExpressShipping GiftWrap Highlight InsuranceOption
InsuranceFee LayoutId Location MinimumBid MoneyXferAccepted
MoneyXferAcceptedinCheckout MOCashiers PackageHandlingCosts
PaymentOther PaymentOtherOnline PaymentSeeDescription PayPalAccepted
PayPalEmailAddress PersonalCheck PhotoCount PhotoDisplayType PictureURL
PrivateQuantity Range ReservePrice SalesTaxPercent SalesTaxState
SellerPays ShipFromZipCode ShippingHandlingCosts ShippingInTax
ShippingIrregular ShippingOption ShippingPackage ShippingService
ShippingType ShipToAfrica ShipToAsia ShipToCaribbean ShipToEurope
ShipToLatinAmerica ShipToMiddleEast ShipToNorthAmerica ShipToOceania
ShipToSouthAmerica SuperFeatured ThemeId Title VisaMaster WeightMinor
WeightMajor WeightUnit/;

my $args = ( Verb => 'ReviseItem',
    DetailLevel => 0,
    SiteId => $site_id,
    ItemId => $item_id);
    foreach (@options) {
        $args{$_} = $ARGS{$_} if defined $ARGS{$_};
    }

my $rsp = call_api($args);
if ($rsp->{Errors}) {
    print_error($rsp)
} else {
    print "Revised item #$rsp->{Item}[0]{Id}\n";
}
```

To use the script from the command line, include only the item number and the fields you want to change. For example, to change the title, type:

```
reviseitem.pl 4500205202 Title "This is My New Title"
```

(Notice the single quotes used around text with spaces.) To change the starting bid to $8.50, type:

```
reviseitem.pl 4500205202 MinimumBid 8.50
```

(Notice the single quotes used around text with spaces.) To change the starting bid to $8.50, type:
Hack 90 Spellcheck All Your Auctions

Ensure that your titles and descriptions are spelled correctly.

The success of any auction is largely due to how readily it can be found in eBay searches. As described in Chapter 2, eBay searches show only exact matches (with very few exceptions), which means, among other things, that spelling most definitely counts.

Neither eBay's Sell Your Item form nor Turbo Lister supports spellchecking of any kind. So it's left to sellers to scrutinize their titles and auction descriptions, and to obnoxious bidders to point out any mistakes. Once again, the API comes to the rescue.

8.10.1 The Script

The following script requires the following modules and programs:

<table>
<thead>
<tr>
<th>Module/program name</th>
<th>Available at</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML::FormatText (by Sean M. Burke)</td>
<td>search.cpan.org/perldoc?HTML::FormatText</td>
</tr>
<tr>
<td>HTML::TreeBuilder (by Sean M. Burke)</td>
<td>search.cpan.org/perldoc?HTML::TreeBuilder</td>
</tr>
<tr>
<td>HTML::Entities (by Gisle Aas)</td>
<td>search.cpan.org/perldoc?HTML::Entities</td>
</tr>
<tr>
<td>Lingua::Ispell (by John Porter)</td>
<td>search.cpan.org/perldoc?Lingua::Ispell</td>
</tr>
<tr>
<td>ispell program (by Geoff Kuenning)</td>
<td>fmg-www.cs.ucla.edu/geoff/ispell.html</td>
</tr>
</tbody>
</table>

#!/usr/bin/perl
require 'ebay.pl';
require HTML::TreeBuilder;
require HTML::FormatText;
use Lingua::Ispell qw( spellcheck );
Lingua::Ispell::allow_compounds(1);
Hack 91 Negative Feedback Bidder Alert

Have a script automatically notify you if an eBay member with negative feedback has bid on one of your auctions.

One of the best ways to keep deadbeat bidders away is to monitor your auctions and look for potential troublemakers, namely those with negative feedback ratings. (For information on deadbeat bidders, canceling bids, and blocking bidders, see [Hack #54].)

This script scans through your currently running auctions and notifies you via email whenever a high bidder has a feedback rating of less than zero.

```perl
#!/usr/bin/perl
require 'ebay.pl';
$today = &formatdate(time);
$tendays = &formatdate(time + 864000);
my $page_number = 1;
PAGE:
while (1) {
  my $rsp = call_api({ Verb => 'GetSellerList',
                        DetailLevel => 8,
                        UserId => $user_id,
                        EndTimeFrom => $today,
                        EndTimeTo => $tendays,
                        PageNumber => $page_number
                      });
  last PAGE unless $rsp->{SellerList}{HasMoreItems};
  $page_number++;
  if ($rsp->{Errors}) {
    print_error($rsp);
    last PAGE;
  }
  foreach (@{$rsp->{SellerList}{Item}}) {
    my %i = %$_;
    ($id, $bidder) = @i{qw/Id HighBidder/};
    if ($bidder->{User}{Feedback}{Score} < 0) {
      open(MAIL, "|/usr/sbin/sendmail -t");
      print MAIL "To: $selleremail\n";
      print MAIL "From: $selleremail\n";
      print MAIL "Subject: Negative Feedback Bidder Alert\n";
      print MAIL "A bidder with negative feedback has placed a bid on one of your auctions:\n";
      print MAIL "$itemurl$id\n";
      close(MAIL);
    }
  }
}
```

This script is similar to the one in [Hack #87], with the notable exception that listings are retrieved for auctions ending any time in the next 10 days. This is an easy way to filter out completed auctions, and illustrates how to use the input fields (such as EndTimeFrom and EndTimeTo) to your advantage.

See the discussion of GetSellerEvents in the API documentation for a way to retrieve only those listings that have undergone price changes in the past 48 hours, typically as the result of bids placed.

To use this script, make sure to modify the $selleremail variable to reflect your own email address. Note that if we had issued a separate GetItem API call for each auction (or even just one of the auctions), as is necessary in some of the other scripts in this chapter (like [Hack #90]), we could have retrieved the seller’s email address automatically.

See [Hack #96] for a script that notifies you when a user has left a negative or neutral feedback comment for you.
Hack 92 Automatically Relist Unsuccessful Auctions

Save time by automatically relisting auctions that have received no bids or have a reserve that wasn't met.

Most of the time, when an auction ends without receiving any bids or with a reserve that wasn't met, sellers end up relisting the item. But this can be rather laborious, especially if you have more than a few auctions to relist.

The following script will relist for you, and when run on a regular basis, say, every day, you'll never have to manually relist an auction again.

```perl
#!/usr/bin/perl
require 'ebay.pl';

$localfile = "autorelist.txt";  
$today = &formatdate(time);
$yesterday = &formatdate(time - 86400);

my $page_number = 1;
while (1) {
    my $rsp = call_api({ Verb => 'GetSellerList',
        DetailLevel => 8,
        UserId => $user_id,
        EndTimeFrom => $yesterday,
        EndTimeTo => $today,
        PageNumber => $page_number
    });
    if ($rsp->{Errors}) {
        print_error($rsp);
        last PAGE;
    }
    foreach (@{$rsp->{SellerList}{Item}}) {
        my %i = %$_;
        ($id, $bidder) = @i{qw/Id HighBidder/};
        if ($bidder->{User}{Email} !~ "@") {     
            open (INFILE,"$localdir/$localfile")  
                if ($line eq "$id\n") { goto SKIP; }  
            close (INFILE);
            my $rsp = call_api({Verb => 'RelistItem',
                DetailLevel => 0,
                SiteId => $site_id,
                ItemId => $id
            });
            if ($rsp->{Errors}) {
                print_error($rsp)
            } else {
                print "Relisted item $id as #$rsp->{Item}[0]{Id}\n";
                open (OUTFILE,">$localdir/$localfile")
                print OUTFILE "$id\n";
                close (OUTFILE);
            }
        }
    }
    SKIP:
    last PAGE unless $rsp->{SellerList}{HasMoreItems};
    $page_number++;
}
```

This script starts by listing all your auctions that have ended in the last 24 hours, similarly to [Hack #87](#). For information on scheduling this script to run at regular intervals, see [Hack #17](#). If you decide to have the script run less frequently, say, once a week, make sure to increase the window of dates according to which auctions are retrieved.

The script determines that an auction ended unsuccessfully if the high bidder's email address is not specified, or, more specifically, that the email address field does not contain an @ sign (line [2]). For auctions that have received no bids, the HighBidder.User.Email field will be empty, or, if the reserve wasn't met, it will be set to "Invalid Request."

Then, the script checks to see if the auction has been previously relisted (line [3]); if it hasn't, the script proceeds to relist the auction (line [4]). If the relist operation is successful, a confirmation is shown and the auction number is recorded (line [5]) into the filename specified on line [1]. (Note that there's no need to use the VerifyAddItem API call to confirm a successful relist, since the script already checks for errors.)

8.12.1 Hacking the Hack

If you don't want to automatically relist each and every unsuccessful auction, you can set restrictions. For example, you may not wish to relist any item under five dollars or any item that has already been relisted three times.

One thing you can do to improve the success of your relisted auctions is to lower the starting bid and/or reserve price. Now, if you don't explicitly specify the value of a particular option for the relisted auction, the script will simply use the value from the original auction. But, for example, if you specify a new starting bid or reserve price (perhaps 15% lower than the previous values) on line [4], those values will be used for the new auction. Most of the input arguments available for the AddItem API call (discussed in [Hack #88](#)) can be used in RelistItem as well; see the API documentation for details.
Hack 93 Send Automatic Emails to High Bidders

Send payment instructions to your customers automatically.

Here's a simple script that will scan all your auctions that have ended in the last 24 hours and send a payment-instructions email to each high bidder.

```perl
#!/usr/bin/perl
require 'ebay.pl';
$template = "template.txt";
$today = &formatdate(time);
yesterday = &formatdate(time - 864000);
my $page_number = 1;
PAGE:
while (1) {
    my $rsp = call_api({ Verb => 'GetSellerList',
        DetailLevel => 8,
        UserId => $user_id,
        EndTimeFrom => $yesterday,
        EndTimeTo => $today,
        PageNumber => $page_number
    });
    if ($rsp->{Errors}) {
        print_error($rsp);
        last PAGE;
    }
    foreach (@{$rsp->{SellerList}{Item}}) {
        my %i = %$_;
        ($id, $title, $currency, $price, $highbidder, $checkout) = @i{qw/Id Title CurrencyId CurrentPrice HighBidder Checkout/};
        $bidderemail = $highbidder->{User}{Email};
        if ($bidderemail =~ "@") {
            $shipping = $checkout->{Details}{ShippingHandlingCosts};
            $total = $price + $shipping;

            open(MAIL, "|/usr/sbin/sendmail -t");
            print MAIL "To: $bidderemail\n";
            print MAIL "From: $selleremail\n";
            print MAIL "Reply-To: $selleremail\n";
            print MAIL "Subject: $title\n";
            open (COVER, "$localdir/$template");
            while ( $line = <COVER> ) {
                if ($line eq "<insert title here>\n") { print MAIL $title; }
                elsif ($line eq "<insert item here>\n") { print MAIL $id; }
                elsif ($line eq "<insert shipping here>\n") { print MAIL $currency . sprintf("%0.2f", $shipping); }
                elsif ($line eq "<insert total here>\n") { print MAIL $currency . sprintf("%0.2f", $total); }
                else { print MAIL $line; }
            }
            close(COVER);
            close(MAIL);
        }
    }
    last PAGE unless $rsp->{SellerList}{HasMoreItems};
    my $page_number++;
}

The amount charged for shipping is taken from the Checkout.Details.ShippingHandlingCosts field, which is suitable if you've specified fixed shipping costs. If you're using eBay's Calculated Shipping feature, as described in [Hack #45], then you'll need to use the GetShippingRates function. Simply pass it these fields (all children of Checkout.Details), and it will give you the same information your winning bidder sees:

Note also that this script will need to be modified in order to accommodate Dutch auctions. Use the GetHighBidders API call to retrieve multiple high bidders and the quantities they purchased for any single Dutch auction. Naturally, you'll need to supplement the shipping cost calculations to account for any per-item shipping expenses.

8.13.1 AuctionEndOfAuction Notifications

The script in this hack retrieves the list of completed auctions for the last 24 hours, just like most of the other scripts in this chapter that use GetSellerList. (Refer to [Hack #85] for details on scheduling and running the script at regular intervals.)

There is another approach, however. If you sign up to receive notifications, such as AuctionEndOfAuction, CheckoutBuyerRequestsTotal, AuctionCheckoutComplete, and FixedPriceEndOfTransaction, eBay's server will send the appropriate information to you as soon as the event is triggered, and you can then do your post-auction processing on an auction-by-auction basis.

Unfortunately, notifications are not available to developers with the free Individual license (discussed at the beginning of this chapter), but if you're operating under a Basic, Professional, or Enterprise license, you can sign up to receive notifications at developer.ebay.com. Look up "Getting Started with eBay Platform Notifications" in the API documentation for details.
Hack 94 Generate a Custom Gallery

Insert a list of your running auctions, with photos, into your auction descriptions.

One of the ways to advertise your other auctions in any given auction description is to use a gallery — a scrolling viewport with thumbnail photos of all your running auctions — as described in [Hack #47]. Aside from the commercial versions, there's a way to create a custom gallery using the eBay API.

First, include this code in your description:

```html
<iframe src="http://www.ebayhacks.com/cgi-bin/gallery.pl"
       style="width:100%;margin:0;border:0;">
</iframe>
```

The URL referenced in this iframe (see [Hack #51]) should point to your own server and `cgi-bin` directory. See the Using CGI Scripts sidebar if you're not sure how to do this.

Using CGI Scripts

Every web server has a dedicated folder (directory) in which scripts or programs are placed. Instead of displaying the contents of the scripts, as would happen with ordinary HTML files, the web server software runs the scripts and displays their output instead. This special script directory is typically called `cgi-bin`, wherein CGI stands for "common gateway interface." Refer to your web server software's documentation for details on setting up a `cgi-bin` directory, or contact your administrator (ISP) if you're renting space on someone else's web server.

Now, copying the Perl scripts discussed throughout this book into your `cgi-bin` directory is easy enough; the hard part can be making them work.

Provided that the scripts are in the correct location, all you need to do on Unix systems is to make them executable, like this:

```
chmod +x gallery.pl
```

where `gallery.pl` is the filename of the script.

On Windows systems, each Perl script must have a filename that ends with `.pl`. Then, you'll need to associate the `.pl` filename extension with your Perl interpreter. In most cases, this will be done for you when you install Perl.
Hack 95 Leaving Feedback

Use the LeaveFeedback API call to more easily leave feedback.

The eBay API includes extensive support both for leaving feedback for other users and for retrieving comments from your own feedback profile.

Here’s a sample script used to leave feedback for another user with whom you’ve had a transaction (save it as leavefeedback.pl):

```perl
#!/usr/bin/perl
require 'ebay.pl';
$item_id = shift @ARGV;
$target_user = shift @ARGV;
$comment_type = shift @ARGV;
$comment = shift @ARGV;

defined($comment) && $comment_type =~ m:^(positive|negative|neutral)$:
or die "Usage: $0 item user positive/negative/neutral comment";

my $rsp = call_api({ Verb => 'LeaveFeedback',
    DetailLevel => 0,
    ItemId => $item_id,
    TargetUser => $target_user,
    CommentType => $comment_type,
    Comment => $comment });

if ($rsp->{Errors}) {
    print_error($rsp)
} else {
    print "Status: $rsp->{LeaveFeedback}{Status}";
}
```

You can leave feedback with this script by calling it from the command line, like this:

```
leavefeedback.pl item other_user positive 'Smooth transaction'
```

where item is the item number of the transaction and other_user is the user ID of the user for whom you're leaving feedback.

The LeaveFeedback API call follows the same rules as does eBay.com, namely that you can leave feedback only for a user with whom you're involved in a transaction. When testing this feature in the Sandbox (see [Hack #82]), you'll need to set up two users and a handful of auctions. If the seller has a feedback rating of less than 10, however, you won't be able to use the Buy-It-Now feature. Instead, start an ordinary auction, bid on it with the other user ID, and then end the auction early.
Hack 96 Negative Feedback Notification

Have a script notify you whenever you've received negative feedback.

Given the importance of feedback, especially to sellers, it's a good idea to routinely check your feedback profile for complaints or comments that should be addressed, as discussed in [Hack #4]. But doing this every day, especially for sellers who receive dozens or even hundreds of feedback comments every week, can be a chore.

This script routinely scans your feedback profile and notifies you of any new negative or neutral feedback you've received.

```perl
#!/usr/bin/perl
require 'ebay.pl';

$localfile = "feedbackalert.txt";
%roles = ('S', 'seller', 'B', 'buyer');

my $rsp = call_api({ Verb => 'GetFeedback',       
    DetailLevel => 1,
    UserId => $user_id,
    SiteId => $site_id,
    StartingPage => $page_number,
    ItemsPerPage => 1 });
$totalcomments = $rsp->{Feedback}{FeedbackDetailItemTotal};

$oldtotal = 0;
if (-e "$localdir/$localfile") {
    open (INFILE,"$localdir/$localfile");
    $oldtotal = <INFILE>;     
    close (INFILE); };
$newcomments = $totalcomments - $oldtotal;     
if ($newcomments == 0) { exit; }
if ($newcomments > 200) {
    $num_pages = int($newcomments / 200) + 1;
    $page_size = 200;
} else {
    $num_pages = 1;
    $page_size = $newcomments;
}

for (my $page_number = 1; $page_number <= $num_pages; $page_number++) {
    my $rsp = call_api({ Verb => 'GetFeedback',       
        DetailLevel => 1,
        UserId => $user_id,
        SiteId => $site_id,
        StartingPage => $page_number,
        ItemsPerPage => 1 });

    open (INFILE,"$localdir/$localfile");
    while ( $line = <INFILE> ) {
        if ($line eq "$id
") { next;
        }
    close (INFILE);
    open(MAIL, "|/usr/sbin/sendmail -t");
    print MAIL "To: $selleremail
     
    From: $selleremail
     
    Subject: Negative Feedback Alert
     
    A "$roles{"$role"}. $from, has left this feedback:
     
    "$text"
     
    regarding this transaction:
     
    $itemurl$item
    close(MAIL);     
}

open (OUTFILE,">$localdir/$localfile")
    print OUTFILE $totalcomments;

What may seem like an unnecessary extra call at the beginning of the script (line [1]) is actually quite necessary to achieve compliance with eBay's Production Access Rules. This call retrieves a single comment entirely for the purpose of determining the total number of feedback comments in the profile, $totalcomments.

The number of new comments ($newcomments, line [3]) is calculated by subtracting the previous total ($oldtotal, line [2]) from the current total. Then, all new comments are retrieved with the second GetFeedback API call on line [4].

All this needs to be done because GetFeedback doesn't support the EndTimeFrom or EndTimeTo arguments (possibly signifying the dates that feedback comments were left) that are supported by most of the other API calls discussed in this chapter. Paradoxically, adding an extra call (line [1]) prevents the script from issuing too many calls later on. Since the script doesn't need to download the entire feedback profile every time, you also don't need to cache feedback, as eBay suggests.

The script then iterates through the profile and sends an email every time a new negative or neutral feedback comment is encountered. Finally, the script records the new total (line [7]).

To automate this script, schedule it to run regularly (every day, every week, etc.), as described in [Hack #17].

See [Hack #91] for a script to notify you when a user with a negative feedback rating bids on one of your auctions.
Hack 97 Automatic Reciprocal Feedback

Leave automatic feedback for any customer who has left positive feedback for you.

As much as you should respond quickly to any complaints lodged against you in your feedback profile, you'll also want to leave positive reciprocal feedback for each and every positive comment you receive from buyers, as suggested by [Hack #5]. As you might expect, this is also something that can be done with the eBay API.

But let's add a little spice to the mix. Instead of leaving the same feedback comment every time, let's have the script choose a random comment. Start by creating a plain-text file with a handful of positive comments, one on each line:

- Lightning-fast payment. Reliable buyer. Thanks for your business!
- Quick to pay, friendly emails. This eBayer makes selling a pleasure!
- Very fast payment, good communication. All-around excellent customer!

Save the file as *prefabpraise.txt* and place it in the directory specified in your *config.pl* file (discussed at the beginning of this chapter).

Next, take the script from [Hack #96] and replace the code between line [5] and line [6] with this code:

```perl
if ($type eq "Praise") {
    open (INFILE, "$localdir/prefabpraise.txt");
    @line = <INFILE>;
    close (INFILE);
    chomp @line;
    $lines = @line;
    $choice = int rand ($lines);
    system './leavefeedback.pl', $item, $from, 'positive', $choice;
}
```

Or, if you want a single script to leave positive reciprocal feedback and notify you of negative feedback, just place this code before line [5].

Note that this script requires the *leavefeedback.pl* script from [Hack #95].
Hack 98 Queue API Calls

How to work around eBay's API call limit.

Developers working under the Individual license, explained at the beginning of this chapter, have a strict limit as to the number of eBay calls they are allowed to make each day.

Provided that your application uses the API efficiently, as described in [Hack #99], this shouldn't pose a problem. And as the theory goes, anyone needing more than 50 API calls per day is probably running a business on eBay and can justify one of the higher developer tiers.

Consider the following scenario. As a seller, you might have 55 separate auctions ending on a single day. If you use the script in [Hack #87], you can retrieve sufficient data for all your recently closed auctions with only a single GetSellerList call. But if you use the script in [Hack #90], you'll need a minimum of 56 calls: one to retrieve the list of auctions, and 55 more to retrieve the individual auction descriptions. All you need is to run this single script just once to exceed your API quota for the day.

If you feel that exceeding your quota is a possibility, you can take some extra steps to ensure both that your software understands this limit, and that if your software reaches the limit, it can queue additional API calls and complete its work the next day.

The first step is to begin recording your API call usage. Probably the best way to do this is by adding a counter to the call_api subroutine in the `ebay.pl` script listed at the beginning of this chapter. The counter code might look something like this:

```perl
open (INFILE, "$localdir/apiquota.txt");
my %count = map { split(/,/, $_) } <INFILE>;     [1]
close (INFILE);
chomp %count;
my ($today, $dummy) = split(/ /, &formatdate(time));
$count{$today}++;
[2]
open (OUTFILE, ">$localdir/apiquota.txt");
while ($date, $count = each %count) {
  print OUTFILE "$date,$count\n";
[3]
}
close (OUTFILE);
if ( $count{$today} > 50 ) {     [4]
  .
  # queue this API call for later processing
  .
  return undef;
  exit;
}
```

Here's how it works. The script retrieves the counts (line [1]) for all recorded days from the `apiquota.txt` file (located in the directory specified by `$localdir` in your `config.pl` script). It then adds 1 to today's count (line [2]) and writes the updated data back to the file (line [3]). Finally, if today's count is above 50 (line [4]), it runs some code you provide (sorry, I'm not going to do all the work for you!) to queue the next API call. You could, for example, set up a temporary cron job, as described in [Hack #17], to run another script that resubmits queued API calls.

If nothing else, this nifty snippet of code records accounting data for your API usage. After a few days of using the API, your `apiquota.txt` file will look something like this:

```
2005-07-11,3
2005-07-12,11
2005-07-13,0
2005-07-14,60
2005-07-15,4
```

This shows that on July 14, 2005, 60 calls were made, while only 4 calls were made the next day. (Note that since the data is manipulated as a hash by this script, the records won't necessarily be recorded in order in the file.)
Hack 99 Cache Auction Data to Improve API Efficiency

Reduce the number of API calls your program makes and work within your daily API allotment.

One of the requirements of certification, as described in [Hack #82], is that your application or script does not make more calls or retrieve more data than is absolutely necessary. This is typically accomplished in any of three ways:

- Restricting the result set to a specific date range, as described in [Hack #85].
- Download only new entries by comparing the current total of entries with the total you recorded the last time the call was used, as described in [Hack #96].
- Caching retrieved data so that it doesn't have to be retrieved again, as described in this hack.

Which data you cache and how you do it depends on the type of data you're working with.

8.19.1 Caching Input

Probably the most useful place to start is by recording the item numbers of all auctions you're currently selling. Assuming you're using GetItem to upload your listings to eBay (see [Hack #88]), you can simply save the resulting item number in a file, like this:

```
open (OUTFILE, ">$localdir/auctionlist.txt");
print OUTFILE "$rsp->{Item}[0]{Id},\$rsp->{ Item}[0]{EndTime}\n";
close (OUTFILE);
```

Eventually, the file will look like this:

```
4500207651, 2005-07-15 20:43:32
4500207783, 2005-07-16 08:14:18
4500208002, 2005-07-18 19:00:31
```

with each line containing one item number and one end date, separated by a comma. Then, instead of using the GetSellerList API call found in many hacks in this chapter, you can simply load the list, like this:

```
open (INFILE, "$localdir/auctionlist.txt");
my %items = map { split('/,,,' ,$_) } <INFILE>;
close (INFILE);
chomp %items;
```

which will create a hash of item numbers and end times. To fill an array with all the item numbers, use the keys function:

```
@itemnumbers = keys %items;
```
Programming eBay outside the confines of the eBay API.

Consider the API to be a gift from the gods at eBay. At least in theory, the existence of the API puts an end to the need for scrapers, parsers, and other kludges.

For example, the script in [Hack #24] retrieves auction information by parsing the title of the auction page. While this works most of the time, it is susceptible to failure from even the smallest changes. Now, consider the alternative script in [Hack #86], which accomplishes the same task with more robust API calls. The API version will continue to work even if eBay dramatically changes the formatting of their auction pages (which, in fact, they did on July 7, 2003).

But the API comes at a cost. Quite a bit of setup is required (not to mention certification) before you can use the API, and it often ends up being somewhat slower than some simple parsers.

So here are some extra, non-API tools you can use to supplement (or take the place of) your API-based code.

Note that all of these come with the standard "don't do this" clause. Not only are these types of tools unreliable by their very nature, but they also violate eBay policies.

- WWW::Search::eBay. This Perl module, written by Glenn Wood and available at search.cpan.org/perldoc?WWW::Search::eBay, scrapes eBay search pages and returns the results. See [Hack #17] for a working example. Note that updated versions can also be found at alumni.caltech.edu/~glenwood SOFTWARE/.

- php eBay List. This PHP script, available at www.aeoninteractive.net, parses your About Me page to obtain a list of your currently running auctions, which you can then list on your own site. See [Hack #78] for the official way to do this (and make money to boot).

- grep. This little Perl function (also a program found on any Unix system) allows you to search text or a file for a particular string of characters. If you download any page from eBay.com using lwp-download, you can build your own scraper with grep in just a few lines of code.
Colophon

Our look is the result of reader comments, our own experimentation, and feedback from distribution channels. Distinctive covers complement our distinctive approach to technical topics, breathing personality and life into potentially dry subjects.

The tool on the cover of eBay Hacks is a corkscrew. The exact time origin of the corkscrew is not really known, but corkscrews descended from bulletscrews (also called gun worms)—a tool used for cleaning jammed bullets or unspent powder out of musket barrels, which shared a similar spiral tip. By the 17th century, the corkscrew was fairly common, as cork stoppers were now well-established throughout Europe, not only for wine, but for beer, medicine, and cosmetics.

Corkscrews come in a variety of styles, including direct-pull (the simplest), assisted-pull, single-lever, double- (or wing-) lever, and torsional. The corkscrew pictured on the cover is most likely an assisted-pull corkscrew; the most common ones in use today are single- or double-lever.

Emily Quill was the production editor and copyeditor for eBay Hacks. Sarah Sherman, Matt Hutchinson, and Claire Cloutier provided quality control. Jamie Peppard, Mary Agner, Phil Dangler, and James Quill provided production assistance. Julie Hawks wrote the index.

Emma Colby designed the cover of this book, based on a series design by Edie Freedman. The cover image is a photograph taken from the Stockbyte Work Tools CD. Emma Colby produced the cover layout with QuarkXPress 4.1 using Adobe's Helvetica Neue and ITC Garamond fonts.

David Futato designed the interior layout. This book was converted by Joe Wizda, Andrew Savikas, and Julie Hawks to FrameMaker 5.5.6 with a format conversion tool created by Erik Ray, Jason McIntosh, Neil Walls, and Mike Sierra that uses Perl and XML technologies. The text font is Linotype Birka; the heading font is Adobe Helvetica Neue Condensed; and the code font is LucasFont's TheSans Mono Condensed. The illustrations that appear in the book were produced by Robert Romano and Jessamyn Read using Macromedia FreeHand 9 and Adobe Photoshop 6. This colophon was written by David Futato.

The online edition of this book was created by the Safari production group (John Chodacki, Becki Maisch, and Madeleine Newell) using a set of Frame-to-XML conversion and cleanup tools written and maintained by Erik Ray, Benn Salter, John Chodacki, and Jeff Liggett.
SYMBOL A B C D E F G H I J K L M N O P Q R S T U V W Y Z

& (ampersand)
<eBayFeedback size=n> tag
<eBayItemList> tag
<eBayMemberSince> tag
<eBayTime> tag
<eBayUserID> tag
<i> tags
10-Day Listings (listing upgrade)

analysis of
About Me page
   referencing
templates
account
   taking over another seller's
AddItem API call
addresses, shipping to confirmed
Adobe Photoshop
advanced search syntax
   excluding unwanted results
affiliate programs
AltaVista Babel Fish
ampersand (&)
AND searches
Andale 2nd
   Checkout
   Gallery
   Reports
   Research tool
Announcements Boards
API  [See eBay API]
API calls
   recoding usage
   special requirements
API Forums
API Technical Documentation
application certification requirements
Ask Seller a Question link
auction numbers and search URLs
auctions
   completed  [See completed auctions]
Dutch
   international
last 10 seconds
list on another site
making changes to running
tracking
   viewing seller's other items
   when changes are allowed
AuctionWatch
Auctiva eBud
audio controller
Auto Levels tool (image editing)

[ Team LiB ]
Babel Fish
backgrounds, page
backing out of bids  [See retracting bids]
bank account transfer
Barr, Graham
Bid Checkup feature (eSnipe)
Bid Groups tab (eSnipe)
bid increments
bidders
   contacting
deadbeat  [See deadbeat bidders]
   experienced
   histories
   impatient
   new
   outbidding highest
   seeing other auctions bid on
bidding
   early, reasons for
   how to  [See also bid increments] 2nd
   late   [See sniping]
   outbidding highest bidder
   proxy  [See proxy bidding]
   wars
       versus sniping
   whole numbers
Bidding/Watching page
   better tool
BidPay   2nd
bids
   canceling
   minimum
   retracting
   small opening
   starting
BillPoint auction payment system
Blocked Bidders List   2nd
BMP files
Bold feature (listing upgrade)
   analysis of
Bookmarks feature (eBay Toolbar)
boomspeed.com
Brenner, Steven E.
browsers, Links bar
bundle, selling items as
business checks
business, running a
Buy-It-Now feature   2nd   3rd   4th
   analysis of
C2IT
- caching auction data
- Calculated Shipping option
- calculators [See shipping cost calculators]
- Calendar
- cameras
- canceling bids
- cashier's checks
- categories
  - foreign
  - searching 2nd
- certification requirements (API)
- cgi-lib.pl Perl library
- changing running auctions
  - when allowed
- checkout
  - providers
  - streamlining
- Checkout feature, disabling
- checkout.pl script
- checks (money)
- Christiansen, Tom
- Click-N-Ship
- clone tool (image editing)
- closing price of a successfully completed auction
- collections [See also bundle]
  - photographing
  - color backgrounds
  - comments [See feedback, comments]
- Commission Junction
- communications, streamlining
- complaints [See also negative feedback]
  - reasons for receiving
- completed auctions
  - listings
  - sending payment instructions
  - tracking sold items
- Completed Items search
- config.pl script
- Confirm Bid button
- Confirm Your Bid window
- confirmed addresses
- Connect Ship
- content, stealing
- copyright, photos
- counters
- couriers [See shipping, methods]
- Creative Element Power Tools 2nd
- credit cards
- 2nd
damage control
deadbeat bidders
dealing with
deepth of field (photography)
Derhaag, Alan E.
descriptions
dynamic text in
formatting with HTML
listing other auctions in
search form in
things to avoid
things to consider when writing
writing effective
Dictionary.com Translator
digital cameras
disappointments
Discussion Forums
dishonest sellers
Distort tool (image editing)
drop shadow tool (image editing)
dumb questions, answering
Dutch auctions 2nd
dynamic text
in descriptions
versus static text
eaph.com
easypichost.com
eBay API
  automatic reciprocal feedback
  bidder with negative feedback alert
  caching auction data
  generating custom gallery
  getting started
  how it works
  leaving feedback
  license types
  non-API tools
  notifying when negative feedback is received
  relisting unsuccessful auctions
  retrieving auction details
  revising auction listing
  Sandbox
  searches
  sending emails to high bidders
  spellcheck
  submitting auction listing
  tracking completed auctions
  tracking purchases
  tracking watched items
  working around limits
eBay API SDK (Software Development Kit)
eBay community
eBay Community Newsletter
eBay Invoice
eBay policies
eBay Seller’s Assistant Pro
eBay seller's guides
eBay sites
eBay Stores 2nd
  how customers find you
eBay Toolbar
ebay.pl script
Editor Kit
electronic payments [See payments, electronic]
email
  example of high bidder notification
  investigating suspicious
  not getting through
  payment instructions
  prewritten
  sending to high bidder
  templates
empty-restaurant syndrome
EMS (Express Mail)
EPC
[SYMBOL]
failed transactions
favorite searches
Featured (listing upgrade)
    analysis of
    Featured in Category
    Featured in Gallery
    Featured in Search (Stores)
    Featured on Home Page
Featured Plus
FedEx (Federal Express) 2nd shipping internationally
fee avoidance policy
feedback
    automatic reciprocal
    comments
        prefabricated
    follow up
    international users
    leaving
        eBay API
        multiple auctions
    negative  [See negative feedback]
    neutral   [See neutral feedback]
    positive  [See positive feedback]
    profiles, reviewing
    rating
    removing unwanted
    replies and followups
    searching
        system, purpose of
        who goes first
        withholding
Fetch for the Mac
film cameras
filters, spam
Final Value Fee Credit Request
fixed-price listings
fonts, overriding
foreign eBay sites
foreign language translation
forums
frames
    inline
    page
fraud
    dealing with
    suspecting
Fraud Alert form
freepicturehosting.com
FreeTranslation
FTP program
galleries [See also Andale Gallery]
custom generating with eBay API

Gallery feature 2nd upgrade

General Announcements Board
GetBidderList API verb
GetFeedback API call
GetHighBidders API call
GetItem API call 2nd special requirements
GetPrivateProfileString API call
GetSellerEvents API call
GetSellerList API call alternative special requirements
GetWatchList API call
GIF files
Gift Services
 analysis of
The Gimp
Google, using to investigate fraud
graphical web page editors
grep
HighBidderUserId tag
Highlight feature (listing upgrade)
analysis of
histories, seller and bidder
hosting services
hosting your own photos
HTML
  formatting description
  images
  quick reference
  stylesheets
  tables
tags that affect
  fonts and appearance
  spacing and alignment
HTML-Kit

[ Team LiB ]
IDs
  verification
image editors  2nd
image formats
images  [See also photos]  2nd
cropping
Gallery
naming files
preparing
renaming large groups of
thieves
thumbnail  [See thumbnail images]
information, selling
inkfrog.com
inline frames
Instant Payment Notification  [See IPN]
international
  auctions
  language translation
  making sure seller will ship to you
  paying and shipping
  viewing on native eBay
postal money order
selling and shipping
transactions
user feedback
invoice
iPhoto
ipix.com
IPN (Instant Payment Notification)
  Manual
IrfanView
Items I Didn't Win list
  default
Items I'm Bidding On list
Items I'm Watching list
Items I've Won list
  default

[ Team LiB ]
LeaveFeedback API call
lighting (photos)
links
  in descriptions
  linking to eBay
  logging into eBay using
Links toolbar
  customizing
List in Two Categories
  analysis of
Listing Designer feature
  analysis of
listing fees
listings
  completed auction
  making sure items are findable
  reporting suspicious
  revising with eBay API
  streamlining
  submitting with eBay API
  upgrades
    list of
      specials on
localization
lockout function (JavaScript)
logging in using a link
lots [See bundle, selling items as]
LWP::UserAgent Perl module

[Team LiB]

[Team LiB]
market, investigating
merchandise, problems with [See also returns] 2nd
merchant accounts
Merchant Kit
Microsoft Office HTML Filter
minimum bid
Mister Lister
money [See also payments] 2nd
saving on packing materials
money orders
international postal
MS Paint
multiple auctions
leaving feedback for
listings [See listings, streamlining]
Multiple Sellers search
My eBay Bidding/Watching tab
My Favorite Categories page
My Favorite Searches list
creating
My Favorite Sellers page

[ Team LiB ]

[ Team LiB ]
negative feedback
alert, eBay API
avoiding
new users and
notifying when negative feedback is received
retaliation  [See retaliation for negative feedback]
nested tables
Netscape/Mozilla Composer
neutral feedback
new users
negative feedback
newsletter
non-API tools
Non-Paying Bidder Alert  2nd
norightclick function (JavaScript)
notification of being high bidder
NSLookup program

[Team LiB ]
packing materials, money saving tips

pages
  backgrounds
  frames
  viewing hard-to-read

Paint
  Paint Shop Pro

passwords

paying too much

Payment Instructions box

payments  [See also PayPal]
  BidPay
  C2IT
  credit cards
  electronic
  options
  sending
  sending instructions
  setting firm policies

PayPal
  accepting payments on your own site
    more robust approach
  checkout counter
  disabling
  Instant Payment Notification Manual
  international bidders
  processing payments automatically
  refunds
  Seller Protection Policy
  shopping cart
    signing up
  total payment calculations
    Winning Buyer Notification

perceived value

Perl modules, installing

personal checks

Perspective tools (image editing)

photo album feature

Photo Editor

photos  [See also images]
  360-degree view
  adding to auctions
  blurry or doctored
  close-up
  collage
  collections
  composition
  copyright
  doctoring
  Gallery
questions, answering dumb quotation marks in searches

rare items
refunds
relisting items
eBay API
reporting an auction
reputation of member [See feedback]
researching an item's value
reserve price
scaring away bidders
Reserve Price (listing upgrade)
retaliation for negative feedback
risk of
Retract my bid form
retracting bids
returning merchandise
dealing with
policies
Revise your item link
ReviseItem API call
right-click, disabling
robot (search)
creating
script
running
Rolsky, Dave
running auctions, making changes to
SafeHarbor 2nd sales records, obtaining
Sandbox (eBay API)
Scheduled Listings (listing upgrade)
  analysis of
scope in eBay searches
scraping eBay search results
search box, simple
search form in auction description
search robot
  creating
  script
search.pl script
searches
  eBay API
  favorite [See favorite searches]
  saving
  scope
  wildcards
searching
  advanced [See advanced search syntax]
  by seller
  categories [See categories, searching]
  feedback
  removing unwanted results
  seller specific auctions
secure payments
secure server connections
Sell button
Seller's Assistant Pro
sellers
  About Me page [See About Me page]
  contacting
    answering dumb questions
    bid retractions
    problems with merchandise
    to change shipping method
    to sell early
    voiding your obligation
  contacting winners
  determining disposition of
  dishonest
  histories
  in other countries [See international auctions]
  inexperienced
  international, making sure seller will ship to you
  new
  obtaining sales records
  other items
  posting...
tables
  framing pages
  nested
templates, email
thumbnail images
  putting in auctions
Thurn, Martin
TIFF files
Time::Local
Time::ParseDate Perl module
timegm function (Time::Local)
titles
  things to avoid
  writing effective
toolbar
  eBay Toolbar
    Bookmarks feature
Links
  customizing
  putting eSnipe on your
tracking
  auctions
  completed auctions
  eBay API
  items, sold
purchases
  eBay API
  watched items, eBay API
tracking tool script
transactions
  completing
  failed
  soliciting off-eBay
trust, building
  Turbo Lister
    listing creation tool
    uploading listings
United Parcel Service  [See UPS]
United States Postal Service  [See USPS]
unwanted search results
UPS (United Parcel Service)  2nd
shipping internationally

URLs
parameters
tweaking during search
USPS (United States Postal Service)  2nd  3rd
shipping internationally

value
knowing item's
perceived
Vendio
Checkout
Sales Manager
Stores
VicMan's Photo Editor
video-conferencing cameras
villagephotos.com
Watch This Item link
alternative
Where Is an Item tool
Whois tool
wildcard searches
WS_FTP for Windows
WWW::Search::eBay Perl module 2nd 3rd
WYSIWYG auction description editor

Yahoo Stores

Zonalyzer calculator